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Case management overview

IBM® Case Manager simplifies the job of designing and building a case
management system and provides a graphical user interface for case workers to
easily manage cases. With IBM Case Manager, you design a case management
solution that is based on closely related cases and then deploy that solution into a
production environment. Case workers can then complete work items associated
with cases.

For example, if you want to design a solution for resolving credit card disputes,
IBM Case Manager provides tools to quickly design and create a solution that case
workers can then use to process cases in that solution.

IBM Case Manager unifies information, processes, and people by providing you
with the following key functionality:
v An active-content infrastructure that manages the persisted case object model

and enables content-based events for case activities. For example, the addition of
a document or a field change triggers a case task.

v Enterprise content management integration that includes complete document
lifecycle capabilities including versioning, security, and records management.

v True content management functionality that enables you to store document
metadata that you can later modify and search on.

v A process map that manages the logic for the execution of a task.
v An out of the box user interface that is built in a flexible and easily customizable

widgets-based environment that you can also extend to create a role-based client
experience that provides case workers with the information they need to work
on cases.

v Template-based solutions that you can easily modify and reuse.
v Rich analytics provided by IBM Watson™ Explorer Analytical Components, Case

Analyzer, and IBM Case Monitor Dashboard that provide you with several ways
to track and measure performance that is associated with cases and workloads
so that you can optimize your cases.

The following users install, maintain, design, and use the case management
system: a business analyst, a case worker, and an information technology (IT)
administrator.

IT administrator
The IT administrator is responsible for installing, configuring, and
maintaining the case management environment. The IT administrator also
deploys solutions into a production environment.

Business analyst
The business analyst designs the case management solution, including the
user interface layout.

Case worker
The case worker uses the solution to achieve the business objectives by
processing work items that are associated with their role.

“System requirements” on page 10
Related concepts:
“IBM Case Manager architecture overview” on page 13
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Related information:
 

Advanced case management and BPM: Better together
 

Take a tour

Case management solution concepts
Solutions consist of case types, tasks, steps, and other components. A solution is an
application that case workers use to process cases.

Solution

Case type

Task

Step

Document class Role

External process

Solutions
A solution consists of one or more related case types that provide the
documents, data, business processing, and routing to the case workers. For
example, a solution for a human resources department might include a
case type for new hires, a case type for retirement, and a case type for
employee termination.

Case types
Case types define the tasks, the necessary document types to support the
task, the task steps, and the roles that must complete those steps to solve a
business problem. The case type also includes properties that are displayed
to case workers in views in the Case Manager Client. Case types make up
a solution. A case is an instance of a case type.

Document classes
Document classes help you to organize and classify the documents that
belong to a case. You can provide additional information about the
documents by assigning properties to the document class. For example, a
document class might be a job application form.

The document class maps to a document class in the Content Platform
Engine, or to an item type in IBM Content Manager.

Rules A case type can contain rules. A rule determines the actions to take if
particular conditions are met in a case. After you create business rules for
your case type, you can use the business rules in a task to determine
process routing or to update case properties.
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Views A case type can contain views. A view specifies the properties that are
displayed to a case worker for a case type. For each case type, you can
specify the properties that are displayed for the case summary and the
properties that are searchable. In addition, you can specify the one or more
views for the properties that are displayed in the Properties widgets that
case workers use to complete cases and work items.

Tasks A case contains tasks. A task has one or more steps that must be completed
to complete the task. For example, a task might be to review new hire
applications. A case is not complete until all tasks that are marked as
required during solution design, as well as all tasks that have been started,
are completed or manually disabled. Each task has roles that are associated
with it.

Steps Steps are the actions in a process that must be completed for a task. For
example, a step might be to review a job application form. Use the Case
Manager Builder Step Designer to create and edit steps, assign the steps to
roles or workgroups, and connect steps. You can also use Process Designer
to add primary queues, add more in-baskets, and define custom roles. Or,
you can use the Integration Designer from IBM Business Process Manager
instead of the Step Designer, if you are integrating with IBM Business
Process Manager. Case workers see steps as work items in the Case
Manager Client.

Roles A role represents a specific business function. For example, a role might be
an Applicant or Supervisor. You assign users to roles. You use roles to
access a particular task.

You define roles for the entire solution. You then associate roles with tasks.
You assign users and groups to roles in the Case Manager Client to specify
which users can access a particular task or step. Because you define roles
for the solution, you can reuse those roles across all case types when you
design the solution. When you create tasks or steps, you can assign roles to
the task or step from roles that are already defined for the solution, or you
can create a new role for the solution.

Pages A page contains the widgets that users of the solution application use to
complete an activity. A page consists of a layout, widget configurations,
and the flow of events between widgets.

Case Manager Builder includes a set of pages that you can use in your
solution. You can customize these pages to meet the requirements of your
solution. You can use these pages as templates to create additional pages to
provide customized views for different roles, case types, and tasks.

In-baskets
Each solution has a personal in-basket that contains steps (work items in the
Case Manager Client) for tasks that are assigned to a specific user. The
personal in-basket differs from the role in-basket. The role in-basket
contains work items that are assigned to a role, but not to a specific
person. Work items in a role in-basket can be accepted by any user to work
on. For example, you might have a personal in-basket named My Tasks
that displays only the tasks assigned to you in the Case Manager Client.
But, you can switch to the Supervisor Tasks in-basket to see any task
assigned to that role. Anyone that is assigned to that role can work on
those tasks.

Case management overview 3



Scenario: Financial services credit card dispute resolution
IBM Case Manager can provide card-issuing banks with a case management
solution for credit card dispute resolution. IBM Case Manager provides a
comprehensive view of the case for the case workers, improves case worker
efficiency, and reduces the chance for errors as the case is being processed.

Problem

Banks that issue credit cards are seeing a significant increase in dispute cases. In
addition, regulatory reform and an increased focus on customer satisfaction put
more pressure on banks to handle each case as efficiently as possible. The banks
require a solution that enables them to process each incoming dispute and decide
whether to forward it to the credit card company for chargeback.

Credit card companies have strict requirements for how cases can be submitted.
The bank solution must provide accurate and appropriate information to the credit
card company to ensure efficient processing.

Solution

A business analyst at the bank, Anna, studies the requirements of the credit card
company's dispute process. She determines the types of information that the credit
card company requires to process a dispute. Anna uses the IBM Case Manager
tools to quickly design and create a solution that helps the bank representatives
capture all of the required information in a case and attach additional records and
documents to the case. Anna determines what roles must be involved in processing
dispute and fraud cases, and she assigns permissions to different groups based on
those roles.

Scenario

Jane, a credit card customer of the bank, buys a table from an online merchant for
$400. The table is not delivered within three weeks as the merchant promised. Jane
sends email and calls the merchant. However, no one responds. Because she used
her credit card for the transaction, Jane calls the bank for help.

Jane enters her account information by using the automated phone system. As a
result, her call is routed to Nicole, a senior customer service representative. When
Jane explains the situation, Nicole opens a case to track the dispute. She finds the
purchase transaction for the table from Jane's account and adds the record to the
new case. Nicole forwards the call and the case to a dispute agent, Frank.

During his conversation with Jane, Frank enters data into the case by using a form
that captures details about the transaction, the merchant, and the customer. When
Jane says that she can provide a copy of the receipt and delivery agreement, Frank
creates a task in the case to follow up on requesting the document. Frank tells Jane
that he will investigate further, and adds Jane's preferred contact method to the
case. When the call ends, a recording of the call is automatically added to the case
as a document.

Frank uses Case Manager Client as an interface. This interface is customized to
Frank's job as a case worker. The interface provides a comprehensive view of the
case, the tools to review details of the case, and the ability to take actions based on
his findings. After some research, Frank discovers that the merchant has gone out
of business. He adds a comment to the case about this discovery. Frank is notified
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that the online receipt and delivery agreement have arrived from Jane. These
documents automatically get added to the case and are available for Frank to
review.

Frank decides to process a chargeback against the merchant. He starts a task that
gathers the relevant details of the case, formulates the chargeback request,
validates that the information is correct and complete, and forwards it to the credit
card company. Frank also creates a task in the case for his supervisor Richard to
review the case and determine whether any action must be taken based on the fact
that the merchant is no longer in business.

Frank's supervisor Richard reviews the case. He notices Frank's comment that the
merchant has gone out of business. He uses the IBM Case Manager case analytics
tool to search for cases against the merchant to determine whether other customers
are affected. He also analyzes recent transactions involving the merchant to
determine the bank's level of exposure.

Based on this analysis, Richard decides to set up a subteam to handle any disputes
involving this merchant. He sends a change request to Anna, the business analyst,
to modify the solution to incorporate this new team. From his Case Manager Client
environment, Richard requests that a letter be sent to affected customers to inform
them of their dispute rights. Richard also sends an alert to his team of advisors to
inform them of the situation. He then completes his review of the case.

Anna receives Richard's change request. To satisfy the new requirement, Anna
designs a new role for the subteam in the solution and adds a new rule. When
customers call with disputes that involve this merchant, the new rule routes the
disputes to the new team. By using the IBM Case Manager tools, Anna can
implement the changes in a few minutes. She can then easily test the solution
changes before deploying them to the production system.

Because the credit card company implemented an efficient case management
process, Jane's and other customer's requests can be more quickly resolved.

Scenario: Automobile insurance claims
IBM Case Manager provides a sample solution for creating and managing
automobile insurance claims. With the case management system, you can associate
the data about the claim and the submitter with the supporting documentation as
it is submitted. The business analyst can quickly process any required changes to
the automobile claim solution. By configuring a solution in IBM Case Manager,
you can ensure that claims are processed completely and accurately.

Problem

Automobile insurance claims can involve input and supporting documentation
from many sources, including the claim submitter, the repair shop, the police, and
other official sources of information about vehicle value or road conditions. In
addition, different analysts are often required to evaluate and add information to
an insurance claim during processing. All documentation and claim information
must be available and easily accessible to enable adjustors to properly evaluate and
resolve the claim.

Individual claims can vary greatly. This variability can require case workers to start
discretionary processes, to involve new roles, and to change how and when tasks
are completed as the claim is routed through the organization.
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Solution

Javier, a business analyst at the automobile insurance company, is working on
making the automobile claims process more consistent. Javier uses Case Manager
Builder to design a solution with tasks that involve multiple steps. He creates roles
for each step in the claims process, and assigns permission to the roles for the
groups of employees who perform the tasks at each stage in the process.

The solution that Javier designs combines the following elements:
v Claim properties, such as policy number and accident details
v Roles, such as claims adjustor or fraud investigator
v Case types, such as general claims, claims with injury, or major loss claims.

In addition, Case Manager Builder enables Javier to create a flexible solution. He
can quickly change roles, processing, or add tasks when they are needed. He can
also use business rules to automatically update claim properties, such as to
calculate a new premium after a claim is filed.

Scenario

Carly is driving on a roadway when her car strikes a large object. Although she is
not hurt, her car is too damaged to drive. The police arrive, and a tow truck is
dispatched. When Carly calls her insurance company, customer service
representative Chris opens a case for her claim. He uses a First Notice of Loss
(FNOL) form to record the information. When he enters her home phone number,
many of the form fields are automatically populated with her data that is retrieved
from the system.

Chris asks about her location, and tells her to have the tow truck driver take her
damaged car to a specific nearby repair shop. The case information is forwarded to
the car repair shop. Chris tells Carly how to use a PDF form that is available on
the insurance company's website to provide details about the accident. He gives
her the case number that was generated when he opened her case. She will include
the case number on the form.

Chris recalls a memorandum about recent fraudulent claims involving collisions
with roadway debris. He creates a discretionary task to involve a fraud
investigator in the claim.

Later, Carly downloads the PDF form from the insurance company's website and
enters the accident details and the case number. She mails the form back to the
insurance company. Javier is using IBM Datacap to automatically scan and index
the form into the case. Because this action is set as a precondition on Chris's task
to review the claim, he is notified when the form is added to the case. Also, on the
company website, Carly uses her case number to access a tool for uploading
photographs of her damaged car.

John, the agent at the car repair shop, receives notification about the case. He
creates a task to provide an estimate for repairs. John makes sure that the $4500
estimate for repair does not exceed the value of the car and submits the estimate to
the insurance company. He uses Carly's contact information to let her know that
the estimate was submitted.

The case is routed to Lisa, an adjustor. She reviews the case and the supporting
documents, including the police report and the photographs of the damage. The
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estimate is below the threshold for investigation, and the fraud investigator has set
the flag for possible fraud to false. Lisa approves the claim.

After the claim is approved, a task is triggered to automatically calculate the new
premium for Carly. The new premium is calculated according to a business rule
that evaluates whether the accident was caused by negligence, the number and
severity of any other claims that Carly filed during the last few years, and the type
of policy.

After the case is closed, the insurance company receives a report from the police
that a freight company was charged with dropping the object that caused Carly's
accident. Lisa reopens Carly's case. She contacts Javier, who adds a new role to the
system called recovery expert. The recovery expert creates new tasks to attempt to
reclaim the cost of the repairs from the freight company.

Because of the flexibility of this case management system, case workers can resolve
problems more quickly and efficiently, and customers can close their claims more
easily.

Case Manager Builder
The Case Manager Builder is a web-based tool for business analysts to design and
develop a solution and the artifacts that make up cases in that solution. Optionally,
business analysts can use a wizard in Case Manager Builder to guide them
through creating a solution, or they can create the solution components manually
and in any order. After the solution is initially defined, multiple business analysts
can collaborate and contribute to the solution creation and refinement. For
example, while one business analyst designs case types, case properties, and tasks
with corresponding workflows for case workers to process, another can define
business rules for automated decision making.

Case Manager Client
The Case Manager Client is a web-based application for case workers to complete
their work for each case. Before the Case Manager Client is deployed into
production so that case workers can access it, business analysts can modify the
application to customize it.

The Case Manager Client is a widgets application with a set of pages that are
configured to work together, enabling case workers to manage cases and process
work items. A business analyst designs the views and in-baskets for the Case
Manager Client in the Case Manager Builder. Business analysts can use the
provided pages and widgets, or they can further customize the Case Manager
Client by adding additional pages or widgets.

IBM Case Manager configuration tool
The IBM Case Manager configuration tool is used to configure Case Manager
Builder, Case Manager Client, and integration points with other optional
components. Based on the values that you specify, the configuration tool configures
the environment and deploys the applications.
Related concepts:
“Planning your development and production environments” on page 22
“Planning for IBM Case Manager installation” on page 28

Case management overview 7



IBM Case Manager administration client
The IBM Case Manager administration client is a web-based application that is
used to administer your case management system. Administrators can access
wizards to work with solutions, manage project areas, configure security and
auditing, and migrate case management components from one environment to
another.
Related tasks:
Setting up project areas
 

Setting up target environments
 

Preparing a database for the case history store
Related information:
 

Configuring security by using the IBM Case Manager administration client
wizard
 

Importing IBM Case Manager assets

Case health analysis
IBM Case Manager monitors case health by analyzing the due dates for quick
tasks, deadlines for work items, and duration of case stages. IBM Case Manager
then displays health indicators so that a case worker can quickly see if a case is in
good health. If the case is not in good health, the case worker can view details as
to why.

Enabling case health analysis

In the IBM Case Manager configuration tool, run the Configure the Case
Management Object Stores task for the target object stores in your V5.3.3
environment to enable case health analysis. To view the case health indicators for
existing solutions in Case Manager Client, you must configure the Case Toolbar
widget and the Case List widget.

How is case health determined?

For a case that has stages, Case Manager Client first calculates the expected time
frame for case completion based on the aggregate duration of the stages. Case
Manager Client then compares the time that is already spent on the case to the
expected duration. If the case cannot be completed within the expected time frame,
the case health is always set to poor.

If the case can be completed within the expected time frame, Case Manager Client
continues the health analysis as shown in the following diagram:

8 Planning, Installation, and Upgrade Guide

http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.3.3/com.ibm.casemgmt.design.doc/acmdt044.htm
http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.3.3/com.ibm.casemgmt.design.doc/acmdt037.htm
http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.3.3/com.ibm.casemgmt.design.doc/acmdc001.htm
http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.3.3/com.ibm.casemgmt.design.doc/acmdc001.htm
http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.3.3/com.ibm.casemgmt.design.doc/acmdc052.htm


1
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3

Determine if any quick task, work item, or case stage is

overdue. If one is, set case health indicator to warning 

and continue analysis.

Compare the number of overdue items with historical 

statistics for the cases of the same type. If there is a

large negative deviation from the norm, set case health

indicator to poor.

Combine the information to provide case workers with an

overall indication of health and the reasons behind the 

health assessment.

For historical case health analysis, IBM Case Manager requires that the aggregate
data for a case type includes statistical data from a large number of completed
cases. IBM Case Manager does not perform the historical analysis until enough
historical data is available.
Related information:
 

Case List widget
 

Case Toolbar widget

What's new in IBM Case Manager, V5.3.3
IBM Case Manager, V5.3.3 provides new features and other enhancements.

IBM Case Manager is now available as part of IBM Business
Automation Workflow

IBM Case Manager is now available as part of IBM Business Automation
Workflow. This offering combines case management and process management to
unite information, process, and users, thus giving you a 360-degree view of your
organization's work. In addition to process management and case management,
IBM Business Automation Workflow uses advanced analytics, business rules, and
collaboration to drive more successful, optimized business outcomes.

If you do not want to move up to IBM Business Automation Workflow, IBM Case
Manager is still available as a stand-alone product for upgrades.

Viewing an IBM Business Process Manager (BPM) process from
Case Manager Builder

When you create a case task based an existing process, you can now get to that
process in IBM Process Designer. After you create a task from an existing process,
you can click the Open Web Process Designer icon to edit the process in Process
Designer.

To change an existing process or add a new process, you must open the process
from IBM Process Center, update or create the process, create a snapshot, and
make that snapshot the default. To view any new processes in Add Task dialog
box, click Refresh on the Select Process page.
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Access to the IBM Business Process Manager Work Dashboard
from Case Manager Client

You can now easily access the IBM Process Portal Work dashboard from Case
Manager Client by adding the IBM Business Automation Workflow plug-in to your
IBM Content Navigator desktop. You can then view your Work dashboard tasks in
a desktop, claim the tasks, and work on them just as you do in Process Portal.

When the IBM Business Automation Workflow plug-in and IBM BPM V8.6.0
CF2018.03 are installed, the Workflow > Launch Process action is added to the
Action menu and pop-up menu in the Browse view, which you can configure to
display in your IBM Case Manager desktop. You can use this action to launch an
IBM BPM process from a document. You can also add the Launch Process action
to the menu in the Documents view for the Case Information widget.

Business object properties now included in a case package PDF
file

The values for a property that is defined as type Business Object are now listed in
the case package PDF file along with the other case properties.

Enhanced font formatting options in Properties View Designer

Properties View Designer provides enhanced formatting options that you can use
for labels and property values in a view. In addition to selecting the font size, you
can now specify the font color.

Fixes that are included in this version

For a list of the fixes that are included in this version, see Fixes that are included
in IBM Case Manager, Version 5.3.3.

System requirements
Use the Software Product Compatibility Reports page to generate a report for
supported operating systems, related software, hypervisors, hardware
requirements, and detailed system requirements, including component-level details.
You can also get support information related to product translations and product
end of service.

Go to the page at Software Product Compatibility Reports to create a high-level
report for operating systems, related software, hypervisors, and supported
translations for IBM Case Manager. You can also create an in-depth report to get
detailed IBM Case Manager system requirements, hardware requirements, and end
of service information. You can search for IBM Case Manager in all of the report
types and reports are generated based on your query values.

The following report types are the most commonly generated reports from
software product compatibility reports:

Detailed system requirements
When you select your product version for the detailed system
requirements report, you can set a report filter for Operating system
platforms, Product components, and Capabilities, including prerequisites
and support software. After you view the report, you can save it as a URL
to generate anytime or download it as a PDF.
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Hardware requirements
When you select your product version for the hardware requirements
report, you can set a report filter by the Operating system families option.
Set the operating system filter by selecting some or all of the operating
systems that are supported by your product. After you view the report,
you can save it as a URL to generate anytime or download it as a PDF.

Translations
You can search for the list of available translations by a specific product or
for a list of products that are translated into a specific language. For
example, when you select Translations available for a specific product
and enter the product and version, you can see a list of the available
translations for that product version. After you view the report, you can
save it as a URL to generate anytime or download it as a PDF.

End of service
The end of service report shows the service window of the products that
you specify over an eight-year span. For example, you can find out when
your product is scheduled to go out of service.
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Planning your case management system

You must plan your environment and business needs before you install IBM Case
Manager. For example, you must prepare your environment by installing
prerequisite software and configuring users and groups. Your business analyst
must identify the items and processes that apply to your business cases that you
want to automate and manage.

About this task

Thorough planning of your IBM Case Manager requirements and usage parameters
can make the installation, configuration, and use of your application more efficient
and effective.

IBM Case Manager architecture overview
You can install IBM Case Manager on either a single system that FileNet® P8 is
also installed on or in a distributed environment where IBM Case Manager is on a
separate system than FileNet P8.

IBM Case Manager is deployed in an application server, and uses FileNet P8 to
access and store content and solution assets. The IBM Case Manager
administration client and Case Manager Client work in the IBM Content Navigator
user interface (UI) framework. The lightweight directory access protocol (LDAP) is
used for user access and authorization.

Typically, the business analyst designs, builds, and tests a solutions in the
development environment. When the solution is ready to be deployed to
production, the solution is migrated to the production environment, which should
be in a separate FileNet P8 domain.

You use the IBM Case Manager administration client to migrate your solutions
from domain to domain. If your solutions contain non-case management assets,
you must use FileNet Deployment Manager and other tools to move the additional
assets.

The Case Manager Client serves as the user interface that case workers use to
complete cases for the solution.

Users access Case Manager Builder, the IBM Case Manager administration client,
and Case Manager Client from a web browser.

IBM Case Manager can also integrate with IBM Business Process Manager to
complete case tasks and IBM Cognos® Real-time Monitoring or IBM Watson
Explorer Analytical Components to create active and historical analytic dashboards
for your case management.

Single-system architecture

You can install all of the components, including product prerequisites such as
FileNet P8, Db2®, and WebSphere® Application Server, on the same system.
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The single-system architecture for IBM Case Manager is ideal for development
environments, demonstration environments, or production environments for small
businesses that do not require high availability and disaster recovery. When you
use a single-system architecture for a production environment, Content Platform
Engine should be in a separate application server profile from the application
server profile that contains IBM Case Manager and the IBM Content Navigator UI
framework.

The following graphic shows the typical architecture of IBM Case Manager on a
single server.

Distributed system architecture

You can also install IBM Case Manager in a distributed architecture where IBM
Case Manager is installed on a separate system from FileNet P8. The IBM Case
Manager installation program installs Case Manager Builder, Case Manager Client,
the IBM Case Manager configuration tool, the IBM Case Manager administration
client, and the IBM Case Manager API.

For a distributed system architecture, IBM Case Manager can use either Db2,
Oracle, or SQL Server as the database and any LDAP server that FileNet P8
supports.

Case Manager 
Client

Application Server

Case Manager 
Builder

IBM Case Manager configuration tool

Content Platform Engine

IBM Case Manager 
administration client 

IBM Content Navigator

UI framework

Database supported by IBM 

Content Platform Engine and

IBM Content Navigator

Directory server supported by  

IBM Content Platform Engine 

and IBM Content Navigator

Figure 1. Single-system architecture
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The following graphic shows the typical architecture of IBM Case Manager in a
distributed development environment and the features that IBM Case Manager can
integrate with.

When you configure FileNet P8 to work with IBM Case Manager, you must
configure each target object store to work with a single workflow region, and the
workflow region must point to a single target object store.
Related concepts:
“Planning your development and production environments” on page 22
“Planning for IBM Case Manager installation” on page 28
“Case management overview” on page 1

IBM Case Analyzer
Cognos Business Analytics

IBM Operational 
Decision Manager IBM Watson ExplorerIBM FileNet P8 eForms

Application Server 

DB2, Oracle, 
or SQL Server

Application Server

IBM Case Manager 
configuration tool

IBM Case Manager

Browser

Directory server

IBM Enterprise RecordsIBM Content Manager

Content Search Services

Content Platform EngineCase Manager 
Client

Case Manager 
Builder

IBM Case Manager 
administration client 

IBM Content Navigator

UI Framework

IBM Business Process Manager

Figure 2. Distributed system architecture
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Prerequisites
When you plan for your IBM Case Manager installation, you must consider
hardware and software compatibility for the IBM Case Manager server. Because
IBM Case Manager works with many other software applications, you must also
consider which applications to include in your system, and the compatibility
requirements for all applications.

For details about the hardware and software requirements, see “System
requirements” on page 10.

Planning for IBM Case Manager security
You manage the security for IBM Case Manager with users and groups that you
configure in your Lightweight Directory Access Protocol (LDAP) repository and
apply throughout the system. You must plan for different groups of users and
different permission levels for your design environment and your production
environment.

If possible, decide which users and groups to configure before you install your
prerequisite software. If you are installing IBM Case Manager with an existing IBM
FileNet P8 environment, plan and add your users and groups before you configure
the IBM FileNet P8 system to work with IBM Case Manager.

Important: It is a best practice to create a case management master group to use for
assigning access to object stores at the time that you create the object store. Give
this group Use object store permission. With this method, you can grant new users
access to the object store by adding them to the master group. This approach can
prevent issues with changing security on an established object store.

You can use users and groups that exist in your directory server for IBM Case
Manager permissions. You can also create new users and groups.

For the development environment, you configure users and groups to create, test,
and administer solutions. For the production environment, you configure users and
groups that correspond with different case worker roles.

Restriction: To prevent problems when Active Directory users log in, use the same
full name, samAccountName, and display name when you create users.

“Planning for single sign-on (SSO)”
“Planning for security in the development environment” on page 17
“Planning for security in the production environment” on page 21

Related tasks:
“Configuring Active Directory user accounts in WebSphere Application Server” on
page 55
Related information:
 

Configuring security by using the IBM Case Manager administration client
wizard

Planning for single sign-on (SSO)
You can configure single sign-on for IBM Case Manager with IBM Security Access
Manager, CA eTrust SiteMinder, Kerberos SPNEGO, or SAML.
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Review the single sign-on documentation before you install IBM Case Manager. In
most cases, you install and configure FileNet P8 Platform and IBM Case Manager
before you set up the SSO configuration. However, some steps in the configuration
can vary if you are configuring SSO later.

For details, see Configuring single sign-on security.

Planning for security in the development environment
In the development environment, you assign permissions to users and groups for
designing, testing, and administering solutions. Business analysts design and test
solutions. Solution administrators manage the solution environment, including
copying solutions and resetting test environments.

Important: It is a best practice to create a case management master group to use for
assigning access to object stores at the time that you create the object store. Give
this group Use object store permission. With this method, you can grant new users
access to the object store by adding them to the master group. This approach can
prevent issues with changing security on an established object store.

The permissions for the users who design, administer, and manage the case
management solutions must cover two basic roles: solution designers, or business
analysts, and solution administrators. The following table shows sample groups for
users who are designing and administering solutions.

Planning your case management system 17

http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.3.3/com.ibm.casemgmt.design.doc/acmcf010.htm


Table 1. Sample groups for business analysts and solution administrators

Group Description

Business analysts Responsible for designing solutions in Case
Manager Builder and user interface
applications in Case Manager Client.
Business analysts work in a development
environment to develop and test solutions.
Business analysts need access to objects in
the design object store in order to create
solutions, edit solutions, and create the pages
for the client application.

Business analysts must have access to objects
in the case management design object store
to create and edit solutions, and create client
application pages. Business analysts must
have access to a case process configuration
and workflow definitions of a solution.

Business analysts must also have access to
IBM Content Navigator so that they can start
Process Designer and extend a case activity
with advanced Content Platform Engine
workflow functions.

Business analysts require permission to log in
to the default IBM Content Navigator
desktop. When IBM Content Navigator is
installed, the IBM Content Navigator
administration desktop with the ID admin is
set as the default. When IBM Case Manager
is configured, the default desktop is changed
to the default IBM Case Manager desktop
with the ID icm. If you do not change this
configuration, business analysts have the
appropriate access to use the Page Designer
application. If you add security restrictions to
the desktop, you must ensure that business
analysts can log in to the icm desktop under
those security restrictions. If you change the
default desktop, ensure that the business
analysts can log in to the updated default
desktop. For example, if you change the
default desktop back to the IBM Content
Navigator admin desktop, then the business
analysts must be granted IBM Content
Navigator administrator access.
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Table 1. Sample groups for business analysts and solution administrators (continued)

Group Description

Solution administrators Responsible for managing project areas,
copying and deploying solutions, and
promoting solutions to templates. The user
that you specify in the IBM Case Manager
configuration tool as the Content Platform
Engine domain user must have the
permissions that are specified for this group.

Solution administrators control any
management or destructive aspects of
solutions. For example, solution
administrators can delete a solution along
with all its artifacts. You can also grant this
role permission to reinitialize the case
management development environment,
which results in the removal of all solutions
that are deployed within the development
environment. To delete cases and reset the
development environment, solution
administrators must have GCD domain
administrator rights, administrator rights on
the target object store, and workflow system
Configuration group rights.

If the object store is created without the #AUTHENTICATED-USERS internal
group, a case management master group, or other required user or administrative
groups being added to the Object Store Create Wizard, access issues can occur.
Business analysts or solution administrators that are members of other groups that
were not added when the object store was created will not be able to perform their
duties without extensive, supplemental security configuration. This approach
applies to both the design object store and any target object stores that are created
to support the default and additional project areas. Whether you plan to create
new groups or designate existing groups, you must ensure that you grant these
groups or roles the following permissions:

Table 2. Business analyst group permissions

For this component Configure these permissions

Design object store In the New Object Store wizard, configure users and groups who have basic
non-administrative access. The IBM Case Manager administration client
automatically grants the following rights when a user or group is added to a
project area:

v AccessLevel.MAJOR_VERSION_DOCUMENT_AS_INT

v AccessLevel.WRITE_FOLDER_AS_INT

v AccessRight.WRITE_ACL_AS_IN

v Major Versioning level plus Publish, Modify Permissions, and Create
subfolder (Inherit Only) rights for this object and all children

v Delete for all children, but not this object

v For the Solutions folder, View Properties plus the right Create subfolder
for all authenticated users

Target object store For the target object store that is referenced by the Project Area where this
business analyst is assigned, give the business analyst’s security group
Administrators rights in the New Object Store wizard or in the Security
Script wizard.
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Table 2. Business analyst group permissions (continued)

For this component Configure these permissions

IBM FileNet P8 Domain GCD The business analyst’s security group also requires Global Configuration
Domain (GCD) administrator rights. This role is referred to as the IBM
FileNet P8 Administrator in IBM FileNet P8 documentation.

Content Platform Engine Add the business analyst’s security group to the workflow system
Configuration group to enable deployment, which requires creation of
rosters, queues, applications spaces, and roles. If a business analyst must run
Process Administrator in order to update work items, then also add the
business analyst group to the workflow system Administrator group.
Tip: If you do not assign users or groups to your queues and rosters, then
all users automatically have all rights to the rosters and queues. This level
might be appropriate in your development environment.

Process Designer Business analysts require permissions to open the Process Designer
application from Case Manager Builder. Configure permissions by using IBM
FileNet Workplace XT:

1. On the Tools menu, click Administration > Site Preferences.

2. Under Workplace Preferences in the left pane, click Access Roles.

3. Under the PWDesigner access role, click Add new members.

4. On the Select Users/Groups pane, select Groups, enter #AUTH in the
Starts with box, and click Search.

5. Click Accept.

Table 3. Solution administrator group permissions

For this component Configure these permissions

Design object store In the New Object Store wizard or in the
Security Script Wizard, configure the solution
administrator’s security group as an
Administrator.

Target object store For the target object stores, give the solution
administrator’s security group Administrator
rights in the New Object Store wizard or in
the Security Script wizard.

IBM FileNet P8 Domain GCD The solution administrator’s security group
also requires Global Configuration Domain
(GCD) administrator rights. This role is
referred to as the IBM FileNet P8
Administrator in IBM FileNet P8
documentation.

Content Platform Engine Add the group to the workflow system
Configuration groups rights to enable
deployment, which requires creation of
rosters, queues, applications spaces, and
roles.
Tip: If you do not assign users or groups to
your queues and rosters, then all users
automatically have Process Administrator
rights. This level might be appropriate in
your development environment.

To thoroughly test the solution design before you move the solution to a
production environment, you must create test users who are similar to the
production environment users. The business analysts can log in by using the test
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case user accounts to verify the solution design. Each application and each
customer environment has its own set of groups that are appropriate for assigning
case access. For the sake of illustration, the following examples define four groups
for case workers for testing a solution design:

Table 4. Sample groups of case workers for testing a solution in the development
environment

Group Description

Test case viewers Have only read-only access to cases.

Test case initiators Create new cases. They might also be able to view
case properties. For some applications, this group
might be a superset of case workers, or might be
combined with case workers.

Test case workers View and update cases and case-related objects.
They cannot create cases, delete cases, or change
the permission or the owner of case-related
objects.

Test case administrators Control all case-related objects, including case
folders, subfolders, comments, and tasks. Can
view the list of roles for a solution for reassigning
work only if the group has access to the
application space in Content Platform Engine.
This group does not necessarily have full control
of documents that are associated with a case.

Tip: Case viewers, case initiators, case workers, and case administrators can all
create or remove relationships between cases even if they do not have write
permission on the case folders. The request to create or remove the relationship
between cases can succeed even if the user has only read permission on the
folders.

Planning for security in the production environment
In the production environment, you assign permissions to users and groups for
working with your completed IBM Case Manager solution. These users and groups
perform the different roles that you specify in your solution, such as case workers
and case administrators.

If you must set security on an individual case solution, you can use the security
tools that are included with FileNet P8 components to adjust the security settings
of a solution.

Solution administrators are responsible for importing and deploying solutions.
Solution administrators also manage post-deployment tasks such as assigning
security to the deployed solution. The users that act as solution administrators and
the groups that are used to manage them must have GCD domain administrator
rights, administrator rights on the target object store, and Content Platform Engine
process services group rights.

Solution administrators are also involved with defining and applying security and
audit definition configurations. In some organizations this process might be in
collaboration with the business analyst or solution developer who designed the
solution. In that situation, consider adding those users to the solution
administrators group or create another group to represent those users.

Planning your case management system 21



It is a best practice to create a case management master group to use for assigning
access to object stores at the time that you create the object store. Give this group
Use object store permission. With this method, you can grant new users access to
the object store by adding them to the master group. This approach can prevent
issues with changing security on an established object store.

In a production environment, you configure security to permit or limit access to
cases and case objects. You configure security in the Content Platform Engine.

Content Platform Engine
When you configure case management security in Content Platform
Engine, you set permissions for users who can create cases, users who can
add or change tasks, and users who have full control and ownership over
cases.

Content Platform Engine process services
Security in the process services component of Content Platform Engine
controls access to queues, rosters, and the application space. Queues and
rosters control workflows and work items. The application space provides
a list of all the roles in the application space and the members for any role.

Each application and each customer environment has its own set of groups that are
appropriate for assigning case access. For example, the following configuration
defines four groups of case workers:

Table 5. Sample groups of case workers

Group Description

Case viewers Has only read-only access to a case.

Case initiators Creates new cases. They might also be able to
view case properties. For some applications, this
group might be a superset of case workers, or
might be combined with case workers.

Case workers Views and updates cases and case-related objects.
They cannot create cases, delete cases, or change
the permission or the owner of case-related
objects.

Case administrators Control all case-related objects, including case
folders, subfolders, comments, and tasks. Can
view the list of roles for a solution for reassigning
work only if the group has access to the
application space in Content Platform Engine.
This group does not necessarily have full control
of documents that are associated with a case.

Tip: Case viewers, case initiators, case workers, and case administrators can all
create and remove relationships between cases even if they do not have write
permission on the case folders. The request to create or remove the relationship
between cases can succeed even if the user has only read permission on the
folders.

Planning your development and production environments
The case management environment consists of a development environment for
creating and initially testing solutions, a test environment for fully testing the
solutions, and a production environment where users work on active and archived
cases. All of the environments include FileNet P8 object stores and databases for
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storing solution data. In addition, environments include a file system at the IBM
Case Manager tier for storing pages, views, and resources, and a file system at the
FileNet P8 tier for storing rulesets, if applicable.

Development environment

The development environment is typically in a dedicated FileNet P8 domain and
includes a design object store where solutions are stored. You use Case Manager
Builder to define solutions, which are then saved and versioned in the design
object store. After you design a solution, you deploy the solutions into a target
environment, and then you can use Case Manager Client to do basic functional
testing of your solution and to customize the user interface.

In addition, the development environment uses project areas in the design object
store to isolate the effects of resetting the test environment. Each project areas has
its own target object store and Process Engine region.

Test environment

The test environment is for testing the solutions that were created in the
development environment. You might have multiple test environments, for
example a performance testing environment and a pre-production testing
environment.

Your test environment can be in a different FileNet P8 domain or in the same
FileNet P8 domain as the development environment, but with a different set of
object stores to use for the staging and target object stores. There are no project
areas used in the test environment. Solutions built in the development
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environment are imported into the test environment.

FileNet Deployment Manager and other tools are used to migrate assets that are
not managed by IBM Case Manager tools.

Production environment

The production environment is where your solution is deployed into production
for case workers to process cases.

Your production environment is in a different FileNet P8 domain. In your
production environment, you need a single staging object store where solutions are
imported to and deployed from. You also need target environments to deploy your
solutions to. You can deploy many solutions into a single target environment.
Ensure that you have enough system resources for the number of cases that you
anticipate having in each database.
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FileNet Deployment Manager can be used to move any assets that are not created
in IBM Case Manager between the FileNet P8 object stores in the production
environment.

Required databases and object stores

Before you install and configure your case management system, you must plan and
prepare the required databases and object stores for your development, test, and
production environments.

Remember: If you are using IBM Content Manager as your document repository,
you must also prepare the IBM Content Manager environment.

Your case management system requires the following databases and object stores
for each environment:
v The FileNet P8 Global Configuration Data (GCD) database for each FileNet P8

domain.
v The database for the case management design object store.
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v The databases for the target environments. A target environment consists of one
target object store and its associated workflow system. The target object store
and its associated workflow system are collocated in the target environment
database. You can have multiple target environments in a test and production
domain.

v A case history store to record extended case history data.
v A database for IBM Content Navigator.

You can create new object stores to use with IBM Case Manager. You can also take
advantage of the documents and objects that are already contained in an object
store by designating an existing object store as your target object store.

“Planning for project areas”
“Planning for target environments” on page 27

Related concepts:
“IBM Case Manager configuration tool” on page 7
“IBM Case Manager architecture overview” on page 13
 

Concepts: FileNet P8 domains
Related information:
 

Redeployment restrictions for modifying a solution
 

Resetting the test environment

Planning for project areas
Your development environment should have one default project area and zero or
more secondary project areas. As you plan your project areas, ensure that you
assign the appropriate user privileges when you create the target object store.

When creating the target object store, you must add users or groups to the
administration group for the target object store so that in the IBM Case Manager
administration client you can easily add the users to a project area. Users will also
require access to the target object store for testing in the design environment or for
resetting the test environment. A test environment reset requires that the target
object store users have system administration privileges.

The IBM Case Manager administration client handles the privileges required for a
user to access the design object store of the project area. The IBM Case Manager
administration client does not add the privileges for the group in the target object
store and workflow system region, which is why it is recommended that you plan
master group access to a project area before you create the target object store and
workflow system. Doing so will save you the extra step of re-configuring the target
object store and workflow system configuration group. Add the master group with
User object store permission when you create the object store.

When you set up the workflow system region, you must assign users that will be
working in project areas to the workflow system security groups.

In a default project area, it is recommended that you manage users in an LDAP
group so that you can assign the group to the default project area. If you need to
add a user later, you can add the user to the LDAP group and the new user will
automatically be added to the default project area. The group designated as the
workflow system configuration group is the LDAP group that provides
configuration privileges to the workflow system region associated to the project
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area. The group designated as the workflow system administration group is the
LDAP group that provides administration privileges to the workflow system
region associated with the project area.

You should also use an LDAP group to manage access to the target object store
and give the LDAP group administration privileges to the object store. If you need
to add a user to the project area, you only need to add the user to the LDAP group
to provide the user the administration privileges to the target object store of the
project area.
Related information:
 

Resetting the test environment

Planning for target environments
Your test environment and production environment each contain one staging object
store and, typically, multiple target environments. Each target environment consists
of one target object store and its associated workflow system, and a shared or
dedicated IBM Content Navigator desktop onto which the target environment is
registered.

As you plan your target environments, ensure that you assign the appropriate user
privileges when you create a target object store in the object store creation wizard.
It is recommended that you manage users in LDAP groups so that you can assign
groups of users to target environments.

It is a best practice to create a case management master group to use for assigning
access to object stores at the time that you create the object store. Give this group
Use object store permission. You can grant new users access to the object store by
adding them to the master group, which automatically grants the new users
permission to access the target environment. This approach can prevent issues with
changing security on an established object store. For information, see Planning for
security in the production environment.

Also use an LDAP group to manage administrator access to the target object store.
Give this LDAP group administration privileges to the target object store. If you
need to add an administrative user to the target environment, add the user to this
LDAP group.

When you set up a workflow system, you must assign users who will be working
in the target environment to the workflow system administration group.

You can associate a target environment with multiple IBM Content Navigator
desktops by adding the target object store repository to your desktop or by
running the task to register the target environment multiple times. However, only
one IBM Content Navigator desktop is used by the test and assign roles URL that
is returned by the deployed solution. This desktop is the desktop that was
specified the last time that the register target environment task was run.

“Planning for shared or dedicated desktops”
Related tasks:
 

Setting up target environments

Planning for shared or dedicated desktops
You can use a shared desktop to host multiple target environments and solutions.
Or you can create extra desktops in IBM Content Navigator to separate and
partition target environments and solutions.
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If you have a limited number of target environments in production, you can use
the default IBM Case Manager desktop to provide access to solutions through Case
Manager Client. As your production environment grows, you might want to group
and separate target environments that share a user base or some other
distinguishing characteristic.

For example, you might separate target environments that are accessed by different
groups of users. You might also want to group target environments based on
organizational divisions or geographical locations.

Grouping and separating target environments can provide the following benefits:
v Faster solution discovery
v More relevant and specific security settings
v Application customization and themes for the user or organizational unit

When you create solutions and target environments, consider whether it can
benefit your production environment to group them by using a custom dedicated
desktop.

Planning for IBM Case Manager installation
IBM Case Manager depends on IBM Case Foundation on the IBM FileNet P8
Platform for content and process management. You can take advantage of an
existing installation for your IBM Case Manager environment, or you can install a
new IBM FileNet P8 Platform.

You can install IBM Case Manager on a server that is part of an IBM FileNet P8
Platform environment. The server where you install IBM Case Manager must also
have a supported application server and IBM Content Navigator installed.

You can also customize your IBM Case Manager system by adding applications
that expand the capabilities of the system.
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DB2, Oracle, 
or SQL Server

CustomizationsIBM Case Manager server

Directory
Server

Application Server

Case Manager 
Builder

Case Manager 
Client

Case Manager 
administration client

IBM Case Manager
configuration tool

IBM Case 
Manager API

IBM Case Analyzer 
Cognos Business Analytics

IBM Operational
Decision Manager

IBM Business
Process Manager

IBM Case Monitor
Cognos Real-Time 

Monitoring

IBM FileNet eForms

IBM Content Analytics

IBM Case Foundation

Application Server

Content Platform Engine

IBM Content Navigator

UI framework

“Installation and configuration roles”
“Configuration checklist” on page 31
“Planning for IBM Case Foundation installation” on page 31
“Planning for IBM Case Manager server installation” on page 32

Related concepts:
“IBM Case Manager architecture overview” on page 13
“IBM Case Manager configuration tool” on page 7
Related tasks:
“Preparing your FileNet P8 system for IBM Case Manager” on page 77

Installation and configuration roles
During your planning, identify the administrators in your environment who can
provide connection information, configuration assistance, and access rights for the
installation. These roles represent areas of responsibility for the environment. These
administrators can supply the parameters for your configuration checklist and
assist with the installation, configuration, and maintenance of your system.
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The configuration checklist identifies the properties and parameters that you must
collect and provides a way to record their values. You can then refer to the
checklist when you use the IBM Case Manager configuration tool to configure your
development and production environments.

Tip: For many of the properties, you can record the values from your completed
FileNet P8 installation and upgrade worksheet.

Installation administrator
v Runs the installation programs.
v Might also run the IBM Case Manager configuration tool to configure and

deploy IBM Case Manager applications.
v Requires write access to installation directories on the IBM Case Manager server.

Requires read, write, and execute access to the application server installation
directory on the IBM Case Manager server.

v For single-server installations using the IBM Case Manager platform installation
tool, requires local administrator access for a Windows server, or root access for
an AIX® or Linux server.

v Abbreviated as IA. Responsible for coordinating the information described in the
IBM Case Manager configuration checklist.

Information technology administrator
v Responsible for the networking and operating systems settings required by IBM

Case Manager.
v Responsible for performing certain security configurations.
v Abbreviated as ITA. Responsible for providing the information in the rows in

the IBM Case Manager configuration checklist with a value of ITA in the Role
column.

Application server administrator
v Provides connectivity information and other parameters for application server

configuration.
v Supports IBM Case Manager applications that are deployed on the application

server.
v Abbreviated as ASA. Responsible for providing the information in the IBM Case

Manager configuration checklist with a value of ASA in the Role column.

Database administrator
v Creates the new case history database.
v Administers database activity for IBM Case Manager.
v Abbreviated as DBA. Responsible for providing the information in the IBM Case

Manager configuration checklist with a value of DBA in the Role column.

IBM FileNet P8 administrator
v Provides connectivity information for the FileNet P8 Platform components.
v Creates or designates object stores for use with IBM Case Manager.
v Abbreviated as P8A. Responsible for providing the information in the rows of

the IBM Case Manager configuration checklist with a value of P8A in the Role
column.
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IBM Business Process Manager administrator
v Provides connectivity information for the IBM Business Process Manager

components.
v Likely encompasses many of the roles described in this topic, but specifically for

IBM Business Process Manager.
v Abbreviated as BPMA. Responsible for providing the information in the rows of

the IBM Case Manager configuration checklist with a value of BPMA in the Role
column.

IBM Content Manager administrator
v Provides connectivity information for the IBM Content Manager components.
v Creates or designates object stores for use with IBM Case Manager.
v Abbreviated as CMA. Responsible for providing the information in the rows of

the IBM Case Manager configuration checklist with a value of CMA in the Role
column.

Box enterprise account administrator
v Provides connectivity information for Box components.
v Abbreviated as BEAA. Responsible for providing the information in the rows of

the IBM Case Manager configuration checklist with a value of BEAA in the Role
column.

Configuration checklist
When you configure IBM Case Manager, you need information about the products
that IBM Case Manager integrates with. To quickly and efficiently install and
configure IBM Case Manager, work with the administrators of these products to
collect this information before you start the installation and configuration.

The configuration checklist identifies the properties and parameters that you must
collect and provides a way to record their values. You can then refer to the
checklist when you use the IBM Case Manager configuration tool to configure your
development and production environments.

Tip: For many of the properties, you can record the values from your completed
FileNet P8 installation and upgrade worksheet.
Related information:
 

IBM Case Manager configuration checklist

Planning for IBM Case Foundation installation
IBM Case Manager depends on IBM FileNet P8 Platform for content and process
management. You must install and configure a standard distributed IBM FileNet
P8 Platform environment before you install IBM Case Manager. You must configure
object stores on the Content Platform Engine and configure a workflow system to
work with IBM Case Manager.

You must install IBM Case Foundation before you can install and use IBM Case
Manager. Use the IBM FileNet P8 Platform installation documentation to install
and configure the environment.

When you create IBM Case Manager users, create a master group to add to your
case management object stores. This method makes is easy to add users to your
case management environment after the object stores have been created.
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Use Enterprise Manager to create the
target object store

Create or designate IBM Case Manager object stores on
the Content Platform Engine

3

Configure a workflow system to work with IBM
Case Manager

4

Use Administration Console for Content
Platform Engine to create and assign your
master group of users to the design object store

3.1

Create Case Manager object stores on the
Content Engine

3
Create IBM Case Manager users in your LDAP repository

2

Create Case Manager object stores on the
Content Engine

3
Install or upgrade IBM Case Foundation, as needed

1

Use Enterprise Manager to create the
target object store
Use Administration Console for Content
Platform Engine to create and assign your
master group of users to the target object store

3.2

Planning for IBM Case Manager server installation
T cahe server where you install IBM Case Manager requires installations of an
application server and IBM Content Navigator. If some of the components are
already installed before you install IBM Case Manager, upgrade the components
and configure them to work together.

Installing a development environment to work with a distributed
FileNet P8 system

IBM Case Manager is typically installed and configured to work with a standard
distributed installation of IBM FileNet P8 Platform. On the server where you plan
to install IBM Case Manager, you must install and deploy an application server
and IBM Content Navigator.

The IBM Case Manager installation program checks for prerequisite software, and
installs the IBM Case Manager software and client software for Content Platform
Engine.

The IBM Case Manager configuration tool configures the connection between your
IBM Case Manager server and the IBM FileNet P8 Platform environment.

After you deploy the IBM Case Manager applications by using the IBM Case
Manager configuration tool deployment tasks, you can begin to use Case Manager
Builder to create case management solutions.

32 Planning, Installation, and Upgrade Guide



Install IBM Case Manager2

Update the Content Platform Engine client files4

Install and deploy IBM Content Navigator

Install and configure the web application server1.1

1.2

Prepare the IBM Case Manager server1

Prepare to configure IBM Case Manager3

Use the configuration tool tasks to configure the development 
environment

5

Prepare access and authentication for IBM Case 
Manager administration

5.1

5.2

5 3. Register and deploy IBM Case Manager plug-ins and 
applications

Deploy Case Manager Builder

Installing a production environment to work with a distributed
FileNet P8 system

IBM Case Manager is typically installed and configured to work with a standard
distributed installation of IBM FileNet P8 Platform. On the server where IBM Case
Manager is installed, you must install and deploy an application server and IBM
Content Navigator.

The IBM Case Manager installation program checks for prerequisite software, and
installs the IBM Case Manager software and client software for Content Platform
Engine.

The IBM Case Manager configuration tool configures the connection between your
IBM Case Manager server and the IBM FileNet P8 Platform environment.

After you deploy the IBM Case Manager applications by using the IBM Case
Manager configuration tool deployment tasks, you can begin to test or to use your
case management solutions.
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Install IBM Case Manager2

Update the Content Platform Engine client files4

Install and configure the web application server1.1

1.2 Install and deploy IBM Content Navigator

Prepare the IBM Case Manager server1

Prepare to configure IBM Case Manager3

Use the configuration tool tasks to configure the production 
environment

5

Prepare access and authentication for IBM Case 
Manager administration

5.1

5 2. Register and deploy IBM Case Manager plug-ins and 
applications

Planning for non-English installations
IBM Case Manager is Unicode-enabled to support multiple languages and the
installation package contains the necessary multilingual user interface files. A
separate installation step is not required to install the translated version.

When you use Case Manager Builder and Case Manager Client in a specific locale,
the solution and application that you create display in a combination of English
and your chosen locale. The components and artifacts in an IBM Case Manager
solution originate from multiple applications. To display a fully localized solution,
you can edit the different artifacts and components that comprise the solution
package.

The locale determines the language for the display names of case properties, case
types, tasks, and other solution artifacts. Typically, you design and create a solution
for a specific locale and then, as necessary, localize the strings. When you first
deploy a solution, you must deploy the solution under the specific locale. If you
specify a different locale during deployment, users can encounter issues when
other locales are added for the solution.

Setting the locale for deployment depends on the tool you use to deploy the
solution:
v If you use the administration client to deploy the solution, change the browser

locale, or change the Application Locale value in the Change Language and
Locale Settings dialog box.

v If you use the configuration tool or command line to deploy the solution, change
the JVM locale for the configuration tool. You can find the JVM locale value in
the configmgr.ini file in the install_path\configure folder. The default locale
is the operating system locale.
“Available languages for IBM Case Manager” on page 35
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Available languages for IBM Case Manager
The tools and components included with IBM Case Manager support multiple
languages in addition to English. The languages that are supported depend on the
tool or component you are using.

Available languages for the IBM Case Manager installation
program, Case Manager Builder, Case Manager Client, and IBM
Case Manager administration client

The IBM Case Manager installation program, Case Manager Builder, Case Manager
Client, and IBM Case Manager administration client support multiple languages.
The installation program provides a locale choice on the first screen. To change the
displayed language for the Case Manager Builder and Case Manager Client
applications, change the locale of the browser that you use to access the
applications.

In addition to English, IBM Case Manager displays the installation program Case
Manager Builder, Case Manager Client, and IBM Case Manager administration
client in the following languages:

Language Locale

Arabic ar

Catalan ca

Bulgarian bg

Chinese (Simplified) zh

Chinese (Traditional) zh-tw

Croatian hr

Czechoslovakian cs

Danish da

Dutch nl

Finnish fi

French fr

German de

Greek el

Hebrew he

Hungarian hu

Italian it

Japanese ja

Kazakh kk

Korean ko

Norwegian nb or no

Polish pl

Portuguese pt

Portuguese (Brazilian) pt-br

Romanian ro

Russian ru

Slovak sk
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Language Locale

Slovenian sl

Spanish es

Swedish sv

Thai th

Turkish tr

Vietnamese vi

Available languages for the IBM Case Manager configuration tool

The IBM Case Manager configuration tool supports only those languages that are
supported both by IBM Case Manager and Eclipse. Therefore, Romanian,
Slovenian, and Vietnamese are not supported.

In addition to English, IBM Case Manager displays the configuration tool in the
following languages:

Language Locale

Chinese (Simplified) zh

Chinese (Traditional) zh_TW

Czechoslovakian cs

Danish da

Dutch nl

Finnish fi

French fr

German de

Hungarian hu

Italian it

Japanese ja

Korean ko

Norwegian nb or no

Polish pl

Portuguese pt

Portuguese (Brazilian) pt_BR

Russian ru

Spanish es

Swedish sv

Thai th

Turkish tr

The following locales are not fully supported by the IBM Case Manager
configuration tool. Locales that are not listed here or in the preceding table are not
supported by the IBM Case Manager configuration tool.
v Bulgarian
v Catalan
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v Croatian
v Greek
v Kazakh
v Romanian
v Slovak
v Slovenian

In these locales, the IBM Case Manager configuration tool displays a mixture of
English and non-English-language interface elements. If you prefer to have a
consistent experience with the tool, modify the configmgr.ini file to include -nl
en_US to force all strings to display in English.

The following sample shows the contents of the configmgr.ini file:
/opt/IBM/CaseManagement/java/sdk/bin
gui
-nl en_US
-debug
-vmargs
-Xms512M
-Xmx1024M
-XX:MaxPermSize=384m
-Djava.compiler=none
-Dlog4j.configuration=file:/opt/IBM/CaseManagement/configure/log4j.properties
-Djava.util.logging.config.file=/opt/IBM/CaseManagement/configure/configuration/
cmlogging.properties

Available languages for business rules

You can select only one locale in which to write the business rules for your
solutions when you run the Configure Business Rules task in the IBM Case
Manager configuration tool. If you need to create solutions with business rules in
other locales, rerun this task to change the rule persistence locale before you create
the solution. After a solution is created, its rule persistence locale cannot be
changed.

In addition to English, IBM Case Manager supports the following languages for
business rules:

Language Locale

Arabic ar

Chinese (Simplified) zh

Chinese (Traditional) zh-tw

Dutch nl

French fr

German de

Hebrew iw

Italian it

Japanese ja

Korean ko

Polish pl

Portuguese pt

Russian ru
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Tip: When you edit business rules in Case Manager Builder, ensure that the rule
persistence locale is listed first in the list of languages for your web browser.

Planning for IBM Case Manager upgrade
To upgrade the IBM Case Manager system, you upgrade the software in each
environment and upgrade your solutions.

The following graphic provides an overview of the tasks that are required to
upgrade IBM Case Manager:

Prepare the existing development, test, and production environments for upgrade1

Upgrade the existing environments2

Configure the upgraded environments3

Iteratively upgrade solutions as needed4

For each upgraded solution, migrate and deploy in the V5.3.2 test environment5

For the finalized version of each upgraded solution, migrate and deploy in the V5.3.2 
production environment

6

Preparing for upgrade

Before you upgrade the existing development, test, and production environments,
ensure that you have the required versions of prerequisite software such as IBM
FileNet P8, Case Analyzer, and IBM Content Navigator. You might also need to
update other software products or components if you included them in your IBM
Case Manager environment. For details on the required versions, see “System
requirements” on page 10.

Before you begin the upgrade, determine if there are any known issues with
products and components that are used with IBM Case Manager that might affect
the upgrade. For more information about such known issues, see Case Manager
upgrade/configuration issues for related components.

Upgrading and configuring

After you upgrade the development, test, and productions environments, you
upgrade the solutions in the development environment and migrate them to the
test environment. The testers communicate to the solution developers any issues
that require modification of the solutions. After the issues are resolved, the
finalized versions of the upgraded solutions are migrated and deployed to the
production environment. You can upgrade and test one solution at a time and then
migrate it to production, or upgrade and test multiple solutions and then migrate
them all to production.
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If you upgrade from an existing version, you do not need to upgrade your
solutions to V5.3.3 unless you want to edit them in Case Manager Builder. You can
continue to use solutions that were created with the existing version and are
already deployed. You can simultaneously run these existing solutions and the
solutions you create with V5.3.3.

“Supported upgrade paths”
“Upgrade scenarios”

Related tasks:
 

Deploying prerequisite assets
 

Business rules
Related information:
 

Case Manager upgrade and configuration issues for related components

Supported upgrade paths
You can upgrade to IBM Case Manager V5.3.3 from one of the supported existing
versions.

The following existing versions can be directly upgraded to V5.3.3
v V5.2.1
v V5.3.0
v V5.3.1

Tip: If you are upgrading from V5.2.1, ensure that you upgrade IBM Case
Manager to the latest V5.2.1 fix pack level. You can find the latest updates on Fix
Central.

Upgrade scenarios
You can follow various approaches to upgrade your IBM Case Manager system.
You can install the new version on the same computer as the previous version or
on a separate computer.

The upgrade steps also vary between the development environment and the test
and production environments.

“Upgrading the development environment on the existing computer with the
existing object stores”
“Upgrading the development environment on a new computer with the existing
object stores” on page 40
“Upgrading the test or production environment on a new computer” on page
41
“Upgrading the test or production environment on the existing computer” on
page 41

Upgrading the development environment on the existing
computer with the existing object stores
In this scenario, you install the IBM Case Manager V5.3.3 development
environment on the same computer and reuse the object stores that were created
for your existing version. Any solutions that you upgrade to V5.3.3 replace the
existing solutions.
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Before you begin

Ensure that you have a current backup of the system before you start the upgrade.

About this task

Upgrade the development environment on the existing computer if you want to
continue to run IBM Case Manager V5.3.3 on the same computer. Reuse the object
stores that you created for your existing version.

Procedure

To upgrade the development environment on the same computer and reuse the
existing object stores:
1. Upgrade and configure FileNet P8.
2. Ensure that the existing computer has sufficient disk space and other resources

for the new IBM Case Manager installation.
3. If you are upgrading from V5.2.1, upgrade IBM Case Manager to the latest

V5.2.1 fix pack level. You can find the latest updates on Fix Central.
4. Update or install IBM Content Navigator.
5. Install and configure IBM Case Manager V5.3.3. When you upgrade, the

existing WebSphere Application Server profile is used for IBM Case Manager
V5.3.3.

6. Upgrade and deploy the business solutions.
7. Test your business solutions in the IBM Case Manager V5.3.3 environment.

Upgrading the development environment on a new computer
with the existing object stores
In this scenario, you install the IBM Case Manager V5.3.3 development
environment on a new computer and reuse the object stores that were created for
your existing version. Any solutions that you upgrade to V5.3.3 replace the existing
solutions.

Before you begin

Ensure that you have a current backup of the system before you start the upgrade.

About this task

Upgrade the development environment on a new computer if you want to run
IBM Case Manager V5.3.3 on a more powerful computer or on a different
operating system. You can reuse the existing object stores.

Procedure

To upgrade the development environment on a new computer and reuse the
existing object stores:
1. Upgrade and configure FileNet P8.
2. Determine how much disk space and other resources are required for the new

IBM Case Manager environment.
3. If you are upgrading from V5.2.1, upgrade IBM Case Manager to the latest

V5.2.1 fix pack level. You can find the latest updates on Fix Central.
4. Update or install IBM Content Navigator.
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5. Install and configure IBM Case Manager V5.3.3. When you configure the
system, reuse the existing object stores, create new project areas, and create a
new WebSphere Application Server profile.

6. Upgrade and deploy the business solutions.
7. Test your business solutions in the IBM Case Manager V5.3.3 environment.

Upgrading the test or production environment on a new
computer
In this scenario, you install the IBM Case Manager V5.3.3 test or production
environment on a new computer and reuse the object stores that you created for
your existing version. Any solutions that you upgrade to V5.3.3 replace the existing
solutions.

Before you begin

Ensure that you have a current backup of the system before you start the upgrade.

About this task

Upgrade the test or production environment on a new computer if you want to
test and deploy your solutions on a more powerful computer or on a different
operating system.

Procedure

To upgrade the test or production environment on a new computer and reuse the
existing object stores:
1. Upgrade and configure FileNet P8.
2. Determine how much disk space and other resources are required for the new

IBM Case Manager environment.
3. If you are upgrading from V5.2.1, upgrade IBM Case Manager to the latest

V5.2.1 fix pack level. You can find the latest updates on Fix Central.
4. Update or install IBM Content Navigator on the new computer.
5. Install and configure IBM Case Manager V5.3.3 on the new computer. When

you configure the system, reuse the existing object stores and create a new
WebSphere Application Server profile.

6. Migrate your business solutions from the development environment to the test
or production environment.

7. Deploy the upgraded solutions and configure security.

Upgrading the test or production environment on the existing
computer
In this scenario, you install the IBM Case Manager V5.3.3 test or production
environment on the existing computer and reuse the object stores that you created
for your existing version. Any solutions that you upgrade to V5.3.3 replace the
existing solutions.

Before you begin

Ensure that you have a current backup of the system before you start the upgrade.
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About this task

Upgrade the test or production environment on the existing computer if you want
to continue to run IBM Case Manager V5.3.3 on the same computer.

Procedure

To upgrade the test or production environment on the same computer and reuse
the existing object stores:
1. Upgrade and configure FileNet P8.
2. Ensure that the existing computer has sufficient disk space and other resources

for the new IBM Case Manager installation.
3. If you are upgrading from V5.2.1, upgrade IBM Case Manager to the latest

V5.2.1 fix pack level. You can find the latest updates on Fix Central.
4. Update IBM Content Navigator.
5. Install and configure IBM Case Manager V5.3.3. When you configure the

system, reuse the existing object stores. You can also reuse the WebSphere
Application Server profile that you created for your existing version.

6. Migrate your business solutions from the development environment to the test
or production environment.

7. Deploy the upgraded solutions and configure security.

Planning for IBM Case Manager high availability
For a highly available installation, plan to install IBM Case Manager into an
application server cluster. IBM Case Manager also supports highly available
database configurations.

Installation

Configure your application server cluster before you install IBM Case Manager.

When you run the IBM Case Manager configuration tool to configure a
development or production environment, use highly available connections for the
following servers:
v Highly available Content Platform Engine EJB URI
v Highly available IBM Content Navigator

Ensure that a network share directory is available when you create and run the
IBM Case Manager development and production profiles. This share directory
must be accessible by all IBM Case Manager nodes in the IBM Case Manager
application server managed cluster.

The following graphic shows an example of a highly available IBM Case Manager
installation:
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Load balancing

Case workers connect to the Case Manager Client URL to log in and interact with
cases. In a highly available IBM Case Manager application server profile, there are
two more instances of the Case Manager Client application running. Load
balancing and failover are achieved by fronting the application instances with a
hardware or software-based load-balancing solution. This load-balancing solution
can be either IBM HTTP Server (IHS) or a hardware-based device. Case worker
client connections require session persistence. The load balancing mechanism must
support session affinity or “sticky sessions.” Session affinity ensures that clients are
always directed to the same instance resource initially chosen to receive the traffic.

Limitations for Content Platform Engine high availability

IBM Case Manager works with a highly available IBM FileNet P8 Platform
environment. However, in a development environment for IBM Case Manager,
your Content Platform Engine must be a stand-alone system, and not part of a
farmed environment.
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IBM Case Manager

HTTP/HTTPS

Hardware
load
balancer HTTP/HTTPS
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balancer

Application Server
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Figure 3. Highly available IBM Case Manager installation
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If a farmed Content Platform Engine is a requirement for development, you must
have only a single node running when you run the reset development environment
task from Case Manager Builder.

When the case history store is created in any environment, only a single Content
Platform Engine node can be running.

Planning for performance
You can tune your IBM Case Manager system to improve system performance.

For more information about how to tune your system, see Tuning IBM Case
Manager.

You can also monitor the performance of your system at runtime. For more
information, see Monitoring system performance.
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Installing and configuring IBM Case Manager

You must install your supporting software applications before you install IBM Case
Manager. After you install the software, you use the IBM Case Manager
administration client to configure and deploy the IBM Case Manager applications.

About this task

The installation process can vary depending on your starting point and your
installation objective. You can perform any of the following installations:
v An installation of IBM Case Manager on a server that does not already have the

prerequisite software installed
v An installation of IBM Case Manager on a server that already has your

application server and IBM Content Navigator installed.
v An upgrade of IBM Case Manager

You install a distributed system of servers that includes the FileNet P8 Platform
environment and a server for IBM Case Manager and the supporting applications.
You perform different installation and configuration tasks depending on the
prerequisite software that you already have installed. For example, if you do not
have the prerequisite software installed on your IBM Case Manager server, you
install those applications before you install IBM Case Manager.

The configuration steps are also different depending on whether you are installing
in a cluster or network deployment environment or on a stand-alone server.

If you are upgrading from the previous version of IBM Case Manager, you perform
additional tasks before and after the upgrade and configuration tasks.

Installing and configuring in a cluster deployment or network
deployment

Before you install IBM Case Manager, you must first install the prerequisite
software applications on the same server. Then you can use the IBM Case Manager
tools to install and configure the IBM Case Manager applications.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

About this task

A typical IBM Case Manager environment includes an FileNet P8 Platform system
that is installed and configured on a distributed set of servers. You can use an
existing installation, or install a new FileNet P8 Platform system to work with IBM
Case Manager. Before you install IBM Case Manager, you must configure your
FileNet P8 Platform environment to work with IBM Case Manager.

Both cluster deployment and network deployment include managed nodes and a
deployment manager. In cluster deployment, you deploy to a set of managed
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servers that are part of a cluster. In network deployment, you deploy to a managed
individual server that is not part of a cluster.

If you did not prepare a server or servers for IBM Case Manager that includes the
prerequisite software, you must install and configure the following applications to
work with IBM Case Manager:
v WebSphere Application Server Network Deployment Edition
v IBM Content Navigator

You configure and deploy IBM Content Navigator as a client of the Content
Platform Engine instance that hosts the IBM Case Manager object stores. IBM
Content Navigator hosts the administration client and the Case Manager Client
application.

After you install the prerequisites, you run the IBM Case Manager installation
program. The IBM Case Manager installation program installs the IBM Case
Manager files.

Use the IBM Case Manager configuration tool to configure the development and
production environments. You use the configuration tool to create profiles that
contain tasks, where you enter properties and settings for all aspects of your IBM
Case Manager environment and applications. After you run the configuration
tasks, your IBM Case Manager system is ready to use.
1. “Preparing your FileNet P8 system for IBM Case Manager”
2. “Preparing the IBM Case Manager server” on page 52
3. “Installing IBM Case Manager” on page 56
4. “Configuring IBM Case Manager” on page 58

Preparing your FileNet P8 system for IBM Case Manager
For your FileNet P8 environment to work with IBM Case Manager, you must
install or upgrade FileNet P8, create users and object stores, and configure the
workflow system.

About this task

The IBM Case Manager configuration tool uses many of the same values from your
FileNet P8 installation and configuration to connect IBM Case Manager to the
FileNet P8 environment. Before you install, upgrade, and configure, review the
configuration checklist and collect values as applicable.
1. “Installing or upgrading FileNet P8”
2. “Enabling case management if you installed FileNet P8 by using IBM Content

Foundation” on page 47
3. “Identifying IBM Case Manager users” on page 48
4. “Creating IBM Case Manager object stores on Content Platform Engine” on

page 50
5. “Configuring a workflow system for IBM Case Manager” on page 51

Installing or upgrading FileNet P8
IBM Case Manager requires a minimum version of FileNet P8. You use the IBM
Administration Console for Content Platform Engine to configure the object store,
users, and workflow system.
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Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

Procedure

To install or upgrade your FileNet P8 Platform environment:
1. Plan and prepare for the installation or upgrade of your IBM FileNet P8

Platform.
2. Install or upgrade IBM FileNet P8 Platform.

Enabling case management if you installed FileNet P8 by using
IBM Content Foundation
If you installed your FileNet P8 environment by using IBM Content Foundation
and you now want to use IBM Case Manager, you must update the prerequisite
software to add case management capabilities to your FileNet P8 environment.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

About this task

If you installed your FileNet P8 environment by using IBM Content Foundation,
you do not need to reinstall the Content Platform Engine (CPE) server software.
The CPE server software that is provided with IBM Content Foundation is
identical to the CPE server software that is provided with IBM FileNet Content
Manager. However, the version of IBM Content Navigator that is provided with
IBM Content Foundation is not supported by IBM Case Manager. You must install
the correct version of IBM Content Navigator.

The following procedure assumes that you have a development environment in
which IBM Content Navigator and IBM Case Manager are in the same application
server instance.

Procedure

To add case management capabilities if you installed FileNet P8 by using IBM
Content Foundation:
1. Download the following software:

a. From Passport Advantage, download a version of IBM Content Navigator
that is supported for IBM Case Manager.

b. From Passport Advantage, download any of the IBM Content Foundation
components that you want to use for case management, such as IBM
Cognos Real-time Monitoring, and the IBM Case Manager components.

2. Install the version of IBM Content Navigator that you downloaded. Ensure you
complete all applicable tasks in the configuration tool, including the Update the
FileNet P8 Client Connector Files task.

3. Validate that IBM Content Navigator works correctly against the Content
Platform Engine server that was installed by the IBM Content Foundation
installation program.
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4. Continue with the standard IBM Case Manager installation steps. Ensure that
you complete the IBM Case Manager Update the Content Platform Engine
Client Connector Files task and the other configuration tasks in the correct
order, including the Create Case Manager Application task. These tasks will
synchronize the client connector files with Content Platform Engine.

5. Validate that IBM Case Manager works correctly against the Content Platform
Engine server that was installed by the IBM Content Foundation installation
program.

Related tasks:
 

Getting fixes from Fix Central

Identifying IBM Case Manager users
When you identify the Content Platform Engine object stores that are used for IBM
Case Manager, you must identify the users that have access to these object stores.
Your IBM Case Manager users must have the appropriate access permissions on
the object stores. The required permissions vary depending on the user roles.

About this task

A best practice is to assign permissions to LDAP groups rather than individual
users.

How you assign users and groups can vary based on the directory service provider
in your environment. Use the documentation that is provided for your directory
server to identify IBM Case Manager groups.

The groups or roles that are described in this task cover the main functions of the
core IBM Case Manager applications. If you are extending your IBM Case Manager
system, you might need to create or designate additional groups or roles.

It is a best practice to create a case management master group to use for assigning
access to object stores at the time that you create the object store. Give this group
Use object store permission. With this method, you can grant new users access to
the object store by adding them to the master group. This approach can prevent
issues with changing security on an established object store. For development
environments, the master group can be #AUTHENTICATED-USERS. For a
production environment, more controlled security is needed.

Procedure

To assign IBM Case Manager groups:
1. In your directory server, find the configured realm for the Content Platform

Engine instance that you are using with IBM Case Manager.
2. Identify the following groups:
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Table 6. Groups for business analysts and solution administrators

Group Description

Business analysts Responsible for designing the solution in
Case Manager Builder and the user interface
application in Case Manager Client. Business
analysts work in a development environment
to develop and test the solution. In order to
create and edit solutions, and design the
application, business analysts need access to
objects in the design object store. In addition,
the business analysts need access to the
target object stores and the isolated region to
deploy, test, and customize the solutions.

Solution administrators Responsible for managing project areas.
Responsible for copying and deploying
solutions, and for promoting solutions to
templates. Responsible for managing roles.

3. Ensure that both groups also have the following permissions:

Table 7. Group permissions

Component area Permissions to assign

IBM FileNet P8 Domain GCD Both the business analyst and the solution
administrator groups require Global
Configuration Domain (GCD) administrator
rights. This role is referred to as the FileNet
P8 Platform Administrator in FileNet P8
Platform documentation.

Content Platform Engine Add to Configuration groups rights to enable
deployment, which requires creation of
rosters, queues, applications spaces, and
roles.

Case workers can view the list of roles for a
solution for reassigning work only if the user
or group has access to the application space.
You can add the users to the SysAdminG
group or manually add the users to the
access list of the application space

If a business analyst must run Process
Administrator in order to update work items,
then also add the business analyst to the
Process Administrator group.
Tip: If a roster does not have users or
groups that are assigned to it, then all users
can access the roster. That is, all users have
query and create rights. Users must have
create rights to launch a workflow. If a queue
does not have users or groups that are
assigned to it, then all users can access the
queue. That is, all users have query and
process rights.

Object store permissions For the business analysts group, assign Use
Object Store level permission for the design
object store and target object stores.
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Table 7. Group permissions (continued)

Component area Permissions to assign

Process Designer Business analysts must belong to the
Workflow System Configuration group to
edit workflows in the Process Designer
application from Case Manager Builder. You
can configure this group in IBM
Administration Console for Content Platform
Engine when you configure the target object
store workflow system.

Creating IBM Case Manager object stores on Content Platform
Engine
IBM Case Manager uses Content Platform Engine object stores for creating, storing,
and deploying case solutions. You can use IBM Administration Console for
Content Platform Engine to create the design object store and the target object
store. You can also use an existing object store for the target object store.

About this task

You must create or designate the design object store and target object stores for
your IBM Case Manager environment. In a typical use case, you create a new
design object store to use for creating your solutions. You can use an existing object
store that already contains documents and objects as the target object store for
deployed solutions, or you can create a new target object store.

When you create the object store, add the case management master group that you
created, and grant the group Use object store permission.

Procedure

To create the IBM Case Manager object stores:
1. In the IBM Administration Console for Content Platform Engine, create an

object store by using the New Object Store wizard. For more information, see
Creating the initial object store.

2. In the Select Add-ons window, click the Workplace/Workplace XT
Configuration button. This setting provides the add-ons that are required for
IBM Case Manager. If you want only the minimum required add-ons, ensure
that you select the following add-ons:
v Content Engine Base Extensions, which are required for all Content Engine

configurations.
v Base Application Extensions, which are a prerequisite for Search Extensions

and the Workplace Base Extensions.
v Search Extensions, which are required to browse and search for content in

IBM Content Navigator.
v Workplace Base Extensions, which are required to browse and search for

content in IBM Content Navigator.
v Workplace Template Extensions, which are required to open folders in IBM

Content Navigator.
3. In the Specify Object Store Administrators window, click Add. Then, click Find,

and find the business analyst and solution administrator groups or the
equivalent groups for your environment.

4. Complete the wizard and accept all remaining default values.
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Related information:
 

IBM FileNet P8 add-ons required for IBM Content Navigator

Configuring a workflow system for IBM Case Manager
IBM Case Manager uses workflow functionality to route and track user tasks.
When you create a workflow system, you define an isolated region and its
connection point. In addition, you can optionally customize the database storage
parameters and configure email notification.

About this task

You can create a new object store to use as your IBM Case Manager target object
store, or you can designate an existing object store.
v If you use a newly created object store, you must configure the isolated region

and connection point as explained in this task. You use IBM Administration
Console for Content Platform Engine to configure an isolated region and a
corresponding connection point. The database connection that you define must
point to the target object store database. Use this task to complete the
configuration.

v If you use an existing object store that has never been configured for workflows,
you must configure the isolated region and connection point in the same way
that you would for a new object store. Use the steps in this task to complete the
configuration.

v If you use an existing object store that has already been configured for
workflows, an isolated region and connection point have already been
configured for the object store. Skip this task.

Procedure

To configure a workflow system:
1. Start the IBM Administration Console for Content Platform Engine.
2. Start the New Workflow System wizard in the administration console.

a. In the domain navigation pane, click the object store.
b. In the object store navigation pane, right-click the Administrative >

Workflow System folder and click New to start the wizard.
3. Complete the wizard steps by using the values in your worksheet. The values

that are displayed in the wizard screens are default values, which you must
change to match your IBM Case Manager values.

Related tasks:
“Configuring the development environment for cluster or network deployment” on
page 60
“Configuring the production environment for cluster or network deployment” on
page 67
“Configuring the development environment” on page 90
“Configuring the production environment” on page 96
Related information:
 

Creating a workflow system
 

Using the Process Configuration Console
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Preparing the IBM Case Manager server
Before you can install, configure, and use IBM Case Manager, you must install the
supporting software applications on the server where you want to install IBM Case
Manager. A web application server deploys the IBM Case Manager applications.
IBM Content Navigator hosts the IBM Case Manager administration client and the
Case Manager Client.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

For an AIX or Linux server that does not use Domain Name Service (DNS) or
Network Information Service (NIS), verify that the /etc/hosts file contains the
name and Internet Protocol (IP) address of all servers that the server communicates
with, including the local host. Verify that the etc/netsvc.conf file contains the
value hosts = local.

About this task

The IBM Case Manager installation program detects whether the correct version of
IBM Content Navigator is installed. You prepare the server where you want to
install IBM Case Manager by installing and configuring the supporting software
applications.

The requirements for installing the supporting software can be different for
development and production environments.

A development environment requires IBM Content Navigator. You must install
IBM Case Manager in the same profile as IBM Content Navigator.

“Installing prerequisite software”
“Configuring the application server” on page 55

Installing prerequisite software
The Case Manager Builder application is deployed on WebSphere Application
Server Network Deployment. IBM Content Navigator hosts the Case Manager
Client. In development environments, IBM Case Manager also requires Process
Designer.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

About this task

You use the application server to deploy IBM Case Manager and IBM Content
Navigator. You also use the application server to coordinate authentication between
the IBM Case Manager applications and Content Platform Engine.

If you are installing IBM Case Manager on a server where your application server
and IBM Content Navigator are already installed, upgrade the software to the
minimum required version before you install IBM Case Manager.
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You might need to increase the memory settings in your application server to
enable better performance in your deployed IBM Case Manager applications. For
more information, see Adjusting the Java™ Virtual Machine (JVM) heap for IBM
Case Manager.

Procedure

To install the prerequisite software:
1. Install and configure your cluster or network deployment environment.
2. Create a share directory that is visible and writeable by all nodes in the cluster.

Map the share directory with the same path to all server nodes in the cluster.
3. Install your application server software. If you are using WebSphere

Application Server Network Deployment, install the latest fix pack. You can get
fix packs from Fix Central.

4. Install, configure, and deploy IBM Content Navigator.
Install one IBM Content Navigator server for each IBM Case Manager server
that you plan to install. You cannot share a single IBM Content Navigator
server among multiple IBM Case Manager servers.

WebSphere Application Server Network Deployment environments
only: IBM Content Navigator and IBM Case Manager must be deployed to the
same server (runtime environment or JVM) or cluster.

Tip: Be sure to configure the viewer for your IBM Content Navigator instance.
“Connecting and configuring additional repositories”

Related information:
 

Planning, installing, and configuring IBM Content Navigator

Connecting and configuring additional repositories:

Case Manager Client users can add documents or attachments from a repository
other than the case management object store. To enable this access, you must
connect to a repository and configure the repository to use IBM Content Navigator
as a web client. After you connect to and configure the repository, you must
associate a desktop to enable users to access the content.

Before you begin

You can use IBM Content Navigator to connect to the following types of
repositories:
v IBM Content Manager
v IBM Content Manager OnDemand
v IBM FileNet P8
v Repositories that support the OASIS Content Management Interoperability

Services (CMIS) specification
v Box

The types of repositories that you can connect to depend on the repository
connectors that are installed on your web application server. You use the IBM
Content Navigator Configuration and Deployment Tool tasks for connecting to the
repository that you plan to use. In the task, you must provide connection
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properties such as database type, connection name, host name, database name,
schema name, database port, connection ID, and password to configure the
connection.

After you run the required tasks and deploy the web application, go to the IBM
Content Navigator administration tool and connect to the repository server by
using the required library server administration user ID, such as icmadmin.

About this task

When you are configuring the parameters for the repository, consider the
configuration parameters like system properties and search.

When IBM Content Navigator connects to an IBM FileNet P8 repository that is in a
FileNet P8 domain other than the domain that is used for the design and target
object stores, all web servers that host Content Platform Engine instances must use
the same LTPA keys. Also, all Content Platform Engine instances must be the same
major, minor, and fix pack version.

When case workers add documents from another repository, a reference to the
latest version of the document in the source repository is added to the case. If the
document is deleted from the source repository, the reference is deleted from the
case or the reference becomes invalid. For IBM FileNet P8 or Box repositories, case
workers can add a copy of the current version of a document to the case
management repository instead of referencing the document in the source
repository. The copy remains in the case even if the document is deleted from the
source repository. However, any changes that are made to the document in the
source repository are not reflected in the case. To allow case workers to add a copy
of a Box document to the current case, enable the Box copy feature for the case
management repository in IBM Content Navigator. For IBM FileNet P8
repositories, no additional configuration in IBM Content Navigator is required to
enable case workers to copy documents to the case.

Procedure

To connect and configure an external repository:
1. Open the IBM Content Navigator administration tool in the web client.
2. Click Repositories > New Repository.
3. Select the repository type.
4. Click General and enter the information that is specific to the repository that

you are configuring. The repository information such as the display name, ID,
and server name are required to configure the repository.

5. Click Connect. You can save the default configuration settings for the
repository or continue to customize the settings.

6. Click Configuration Parameters > System Properties > Browse or Search to
configure additional settings for the repository.

7. Save your settings.
8. Add the newly added repository to the Case Manager desktop:

a. In the IBM Content Navigator administration tool, click Desktops and
open your Case Manager desktop.

b. On the Repositories tab, select the new repository from the Available
Repositories list.
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c. Use the move arrow to add the new repository to the Selected
Repositories list.

9. To enable case workers to add a copy of a Box document to the current case,
enable the Box copy feature for the case management repository.
a. In the IBM Content Navigator administration tool, click Repositories and

open the IBM FileNet Content Manager target object store that is used as
the case management repository.

b. On the Configuration Parameters tab, enable the Optional Features > Box
copy option.

10. For each case type in which you want users to be able to add documents or
attachments from an external repository that you configured, edit the case
type in Case Manager Builder and select Allow documents and attachments
from repositories other than the case management object stores.

Related tasks:
 

Adding and modifying case types
Related information:
 

Integrating IBM Content Navigator with Box
 

Configuring connections to repositories for IBM Content Navigator

Configuring the application server
You configure your application server to work with your installation of IBM
Content Navigator. In most cases, these configuration steps cover the configuration
that is required for IBM Case Manager on the application server. Additional
configuration might be required for your IBM Case Manager environment.

“Configuring Active Directory user accounts in WebSphere Application Server”

Configuring Active Directory user accounts in WebSphere Application Server:

If you did not use the same full name, samAccountName, and display name when
you created your Active Directory user accounts, you must configure the Login
properties value in WebSphere Application Server.

Procedure

To set the Login properties value:
1. Log in to the WebSphere Application Server administrative console.
2. Click Global security > Federated repositories > Manage repositories >

my_LDAP_provider.
3. In the Security section, set the Login properties value to one of the following

values:

Option Description

uid Users can log in with samAccountName

cn Users can log in with full name

uid;cn Users can log in with either
samAccountName or full name

4. Click Apply.
5. Save your changes.
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Installing IBM Case Manager
You can install IBM Case Manager interactively, by using the installation program.
You can also install silently, by adding installation values to an input file and
running the installation program from a command line.

Before you begin

Install the prerequisite applications before you run the IBM Case Manager
installation program.

For details about the hardware and software requirements, see “System
requirements” on page 10.

“Installing IBM Case Manager interactively”
“Installing IBM Case Manager silently” on page 57

Installing IBM Case Manager interactively
The IBM Case Manager installation program detects whether you have prerequisite
software installed. The program installs the IBM Case Manager files.

About this task

The installation program detects whether the prerequisite IBM Content Navigator
software is installed. The installation program then installs the IBM Case Manager
applications and the IBM Case Manager configuration tool.

If you are installing in a cluster and you are using IBM Forms 8.1 or earlier, you
must run the installation program on each node in the cluster. Specify the same
installation path on each server or node.

Procedure

To install IBM Case Manager interactively:
1. Log on to the managed node where you want to install IBM Case Manager. Log

on as the same user who installed your application server and IBM Content
Navigator. This user must have write access to the destination directory for
your installation of IBM Case Manager.

2. Navigate to the IBM Case Manager software package in the installation media.
3. Run the installation program:

Operating system Command

AIX 5.3.3.0-ICM-AIX.BIN

Linux 5.3.3.0-ICM-LINUX.BIN

Linux for System z® 5.3.3.0-ICM-ZLINUX.BIN

Windows 5.3.3.0-ICM-WIN.EXE

4. Complete the IBM Case Manager installation program.

Important: When the installation program prompts you for the license type,
select either IBM Business Automation Workflow Enterprise or IBM Business
Automation Workflow Express you are entitled to. Do not select IBM Case
Manager unless you are upgrading an existing IBM Case Manager installation.
For more information on upgrading, see “Upgrading IBM Case Manager” on
page 186.
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Remember: The installation path that you specify must be the same on the
deployment manager server and on each managed node.

5. When the installation completes, check for errors in the IBM Case Manager
installation log. The IBM_Case_Manager_5.3.3.0_2018.03_InstallLog.txt is
created in the installation directory. For example, review the
/opt/IBM/CaseManagement/logs/
IBM_Case_Manager_5.3.3.0_2018.03_InstallLog.txt file.

6. If you are using IBM Forms 8.1 or earlier, repeat the full installation on the
managed node for network deployment or on each node in the cluster.

What to do next

Use IBM Case Manager configuration tool to configure your IBM Case Manager
applications.

Installing IBM Case Manager silently
When you install IBM Case Manager silently, you run a command and specify an
input file. Add the information for your environment in the input file before you
start the installation. The installation program installs the files for the IBM Case
Manager applications, as well as the configuration tool.

About this task

The installation program detects whether the prerequisite IBM Content Navigator
software is installed. The installation program then installs the IBM Case Manager
applications and the IBM Case Manager configuration tool.

If you are installing in a cluster and you are using IBM Forms 8.1 or earlier, you
must run the installation program on each node in the cluster. Specify the same
installation path on each server or node.

Procedure

To install IBM Case Manager silently:
1. Log on to the managed node where you want to install IBM Case Manager. Log

on as the same user who installed your application server. This user must have
write access to the destination directory for your installation of IBM Case
Manager.

2. Navigate to the IBM Case Manager software package in the installation media.
3. Edit the cm_silent_install.txt file to reflect the installation choices for your

environment.

Important: Set the license type to the IBM Business Automation Workflow
Enterprise license or the IBM Business Automation Workflow Express license to
which you are entitled. Do not set the license type to IBM Case Manager
unless you are upgrading an existing IBM Case Manager installation. For more
information on upgrading, see “Upgrading IBM Case Manager” on page 186.

Remember: The installation path that you specify must be the same on the
deployment manager server and on each managed node.

4. Run the installation program:
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Operating system Command

AIX 5.3.3.0-ICM-AIX.BIN -i silent -f
cm_silent_install.txt

Linux 5.3.3.0-ICM-LINUX.BIN -i silent -f
cm_silent_install.txt

Linux for System z 5.3.3.0-CM-ZLINUX.BIN -i silent -f
cm_silent_install.txt

Windows 5.3.3.0-CM-WIN.EXE -i silent -f
cm_silent_install.txt

5. When the installation completes, check for errors in the IBM Case Manager
installation log. The IBM_Case_Manager_5.3.3.0_2018.03_InstallLog.txt is
created in the installation directory. For example, review the
/opt/IBM/CaseManagement/logs/
IBM_Case_Manager_5.3.3.0_2018.03_InstallLog.txt file.

6. If you are using IBM Forms 8.1 or earlier, repeat the full installation on the
deployment manager server for network deployment or on each node in the
cluster.

What to do next

Use IBM Case Manager configuration tool to configure your IBM Case Manager
applications.

Configuring IBM Case Manager
You must configure IBM Case Manager before you can use it in development or
production. Configuring your system prepares the Case Manager Builder
application and the Case Manager Client application for deployment on the
application server. After you deploy these applications, you can create, test,
manage, deploy, and work with your business solutions.

About this task

Your case management system consists of a development environment for creating
and testing case management solutions and a production environment for working
with running case management solutions. You must configure both environments.

Configuring the development environment includes configuring Case Manager
Builder and Case Manager Client. Configuring the production environment
includes configuring only Case Manager Client.

You use the IBM Case Manager configuration tool to create a profile for each
development environment instance and a profile for each production environment
instance. The profile includes several configuration and deployment tasks that you
must edit and run before you can create and deploy case management solutions.
For example, the Deploy Case Manager Builder task requires data about the
application server settings to deploy the solution design application.

If you use the graphical user interface for the configuration tool, you must edit the
property values for each task in the profile, save your changes, and then run the
task. The data that you enter in the graphical user interface is saved in XML files,
but you do not directly edit the files.
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If you use the command-line version of the configuration tool, you must directly
edit the XML files that store the values for the task. The XML files contain the
properties and values that describe the associated configuration and deployment
tasks. Three XML files contain the information that is common to all tasks in the
profile, and each configuration task in the profile has one configuration XML file.
1. “Preparing to configure your case management system”
2. “Configuring the development environment for cluster or network

deployment” on page 60
3. “Configuring the production environment for cluster or network deployment”

on page 67
Related information:
 

Running IBM Case Manager administration client from the command line

Preparing to configure your case management system
Before you run the IBM Case Manager configuration tool, you must grant
permission to the user who will configure your IBM Case Manager system. You
must also prepare Content Platform Engine to connect with your IBM Case
Manager applications.

About this task

The user who runs the IBM Case Manager configuration tool requires access to the
files and directories that contain the configuration properties.

A connectivity task in the IBM Case Manager configuration tool configures a
connection between the IBM Case Manager applications and Content Platform
Engine. To prepare for this task, you must first ensure that LTPA is configured on
Content Platform Engine.

“Granting directory permissions to the configuration tool user”

Granting directory permissions to the configuration tool user:

You must grant file and directory permissions to config_tool_user, which is the user
who runs the IBM Case Manager configuration tool, to allow this user to run the
configuration tool and create files in the install_path/configure directory.

Procedure

To grant permissions to the config_tool_user user:
1. Log in as case_manager_install_user to the server where you installed the IBM

Case Manager configuration tool.
2. Grant permissions to the config_tool_user user for the executable file that you

intend to use:

Operating system Permissions

AIX

Linux

Linux for System z

Graphical user interface

Grant execute permission on all files in the
CaseManagement\configure\tools directory.
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Operating system Permissions

AIX

Linux

Linux for System z

Command line

Grant execute permission on all files in the
CaseManagement\configure\tools directory.

Windows: graphical user interface Grant read and execute permissions on all
files in the CaseManagement\configure\tools
directory.

Windows: command line Grant read and execute permissions on all
files in the CaseManagement\configure\tools
directory.

3. Grant read and write permission to the install_path directory where you
installed IBM Case Manager

4. Grant read, write, and execute permissions to the application server installation
directory.

5. Before you start the configuration tool, log off the server where the
configuration tool is installed and log on again as config_tool_user.

Configuring the development environment for cluster or network
deployment
You must configure the development environment before you use IBM Case
Manager to create and deploy solutions. You use the development environment to
create, modify, and test solutions before moving them into a production
environment.

Before you begin

Be sure to have your completed configuration checklist available.

About this task

Configuring the development environment prepares Case Manager Builder and
Case Manager Client for use. When you provide the required values for the tasks
and run the tasks, you configure all the required settings and deployments for
your development environment.
1. “Running the development environment configuration tasks”
2. “Configuring IBM Case Manager to use the stand-alone IBM Process Designer”

on page 64
3. “Binding applications with WebSphere Application Server” on page 65
4. “Adding users to a project area” on page 66
5. “Verifying the IBM Case Manager applications in the development

environment” on page 66
Related tasks:
“Configuring a workflow system for IBM Case Manager” on page 51

Running the development environment configuration tasks:

Use the configuration tool to create a development environment profile and run
the configuration tasks.
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Before you begin

Ensure that the cluster and your IBM Content Navigator instance are running
when you run the configuration tool tasks.

Procedure

To configure the development environment:
1. Log in to the IBM Case Manager server. In a network deployment or cluster

environment, you can run the configuration tasks from one of the managed
nodes.

2. Start the configuration tool by running one of the following commands:

Operating system Command

AIX 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux for System z 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Windows Perform one of the following actions:

v Click Start > All Programs > IBM Case Manager > Case
Manager Configuration Tool.

v Run the following command:

_install_path\configure\configmgr.exe

_install_path is the location where IBM Case Manager is
installed, for example, one of the following directories:

– C:\Program Files\IBM\CaseManagement

– C:\Program Files (x86)\IBM\CaseManagement

3. Click File > Create profile to create a development environment profile and
use the values from your configuration checklist to complete the fields. In the
Network shared directory field, ensure that you specify the shared location
that you created. After the profile files are created, the profile is opened so that
you can work with the individual tasks in the profile.
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4. Edit, save, and run the Update the Content Platform Engine Client Connector
Files task. Running this task ensures that your client connector files match the
version of your Content Platform Engine. After you run this task, close and
then restart the configuration tool.

5. Edit, save, and run the following tasks. You must run the tasks in the order
listed.

Table 8. Task requirements for a development environment

Task Required

Configure the Case Management Object
Stores

Always

Define the Default Project Area Always

Configure the IBM Content Manager Host
Properties

Required if IBM Case Manager integrates
with IBM Content Manager.

Configure IBM Business Process Manager Required if IBM Case Manager integrates
with IBM Business Process Manager.

Deploy the IBM Business Process Manager
Integration Service (WebSphere Application
Server only)

Required if IBM Case Manager integrates
with IBM Business Process Manager and you
are using WebSphere Application Server.

Register the IBM Business Automation
Workflow Plug-in

Required if you want to use the plug-in for
IBM Business Process Manager that provides
a access to your IBM Process Portal Work
dashboard from your IBM Case Manager
desktop. Save your changes and then run the
task to apply your settings.

This plug-in adds the Workflow > Launch
Process action to the Action menu and
pop-up menu in the Browse view of the IBM
Case Manager desktop. You can use this
action to launch an IBM BPM process from a
document. You can also add the Launch
Process action to the menu in the Documents
view for the Case Information widget.
Important: To use the IBM Business
Automation Workflow plug-in, you must use
the Hypertext Transfer Protocol Secure
(HTTPS) in your IBM Content Navigator
URL.

Create Case Manager Applications Always

Deploy the Case Manager API Always

Register the IBM Case Manager Services
Plug-in

Always

Register the IBM Content Platform Engine
Applets Support Plug-in

Always

Deploy Case Manager Builder Always

Deploy and Register Widgets Package Always
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.
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Table 8. Task requirements for a development environment (continued)

Task Required

Deploy the Forms Application Required if IBM Case Manager integrates
with IBM Forms or IBM FileNet P8 eForms.

If you configure IBM Forms or IBM FileNet
P8 eForms on a network deployment or
cluster environment, run this task in the
profile that contains the other tasks. Select
Network Deployment or Cluster for the
deployment type, eForms and IBM Forms
for the forms type, and Deployment
Manager Profile for the environment type.

If you integrate with IBM Forms 8.1 or
earlier on a network deployment or cluster
environment, the following additional steps
are required. These additional steps are not
required if you integrate with IBM Forms 8.2
or later or with only IBM FileNet P8 eForms.

1. For the managed nodes, create a profile
on each managed node that includes only
this task and run this task. Select
Network Deployment or Cluster for the
deployment type, eForms and IBM
Forms for the forms type, and Managed
Profile for the environment type.

2. After all nodes are configured, the
managed node or cluster must be
restarted to complete the forms
integration. You can restart the managed
node or cluster now, or after you run all
other configuration tasks.

Register the IBM Case Manager
Administration Client Plug-in

Always

Configure Box Collaboration Required if you want to enable case workers
to use Box to collaborate with external users.
This task configures the connection to the
Box server.

Register Project Area Always
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Table 8. Task requirements for a development environment (continued)

Task Required

Configure Business Rules Required if you use business rules in your
solution.
Tips:

v You can select only one locale in which to
write the business rules for your solutions.
If you must create solutions with business
rules in other locales, rerun this task to
change the rule persistence locale before
you create the solution. After the first rule
for a solution is saved, the rule persistence
locale cannot be changed.

v If you rerun this task to change the
location of the rules repository directory
after you deploy any solutions, complete
the following steps after you run the task:

1. Stop Content Platform Engine.

2. From the previous rules repository
directory, move the res_data directory
to the new location of the rules
repository directory. In a cluster
environment, the rules directory must
be a shared directory that can be
accessed by all Content Platform
Engine cluster servers.

3. Restart Content Platform Engine.

Register the External Data Service Required for solutions that use the external
data service.

Deploy and Register Extensions Package Required only when you add an extensions
package for a custom property editor or
controller.
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.

6. Restart the cluster.

Configuring IBM Case Manager to use the stand-alone IBM Process Designer:

When you access Process Designer from Case Manager Builder or from the
Content Platform Engine Applets Support plug-in for IBM Content Navigator, it
runs as a Java applet from a browser with Java plug-in NSAPI support. Many
browsers no longer support Java applets or are planning to drop support for Java
applets. If your web browser does not support running Java applets, you can use a
new stand-alone Process Designer that is available with Content Platform Engine.

About this task

This version of Process Designer runs as a stand-alone Java application without
requiring a web browser.
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Procedure

To configure IBM Case Manager to use the stand-alone Process Designer:
1. Install the stand-alone Process Designer on your local system. For more

information about installing and using this software, see Running Process
Designer.

2. To choose how the Process Designer is to be hosted, run the Create Case
Manager Applications task in the IBM Case Manager configuration tool and
select one of the following options:

Option Description

CPE Support Applets Plug-in Choose this option to use either use
stand-alone Process Designer or the Process
Designer applet.

Standalone Process Designer Choose this option to disable running
Process Designer as an applet. If you choose
this option, you will no longer be able to
access Process Designer from Case Manager
Builder.

3. Run the Deploy Case Manager Builder task.
4. Copy the CaseManagement/WorkplaceXTConfig/ICMSolutionEdit.jar file to the

lib folder in your Content Platform Engine installation directory in which you
installed the stand-alone Process Designer. This file enables stand-alone Process
Designer to support editing by multiple users.

What to do next

To use stand-alone Process Designer to edit workflows for your IBM Case Manager
solution, launch the stand-alone Process Designer, and click File > Solution > Edit
to navigate to the workflow definition file in your design object store. The
workflow definition file is located in /IBM Case Manager/Solutions/Solution Name.

Binding applications with WebSphere Application Server:

If you use WebSphere Application Server, you must bind the web applications after
you run the IBM Case Manager configuration tasks.

Procedure

After the deployment tasks complete successfully, use the WebSphere Application
Server console to bind the following deployed applications to the web server:
v CaseClient
v CaseBuilder
v CaseForms, if used
v CaseManager
v ICMClient
v Any custom widgets packages and applications
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Adding users to a project area:

You must add at least one user to the default project area before you start Case
Manager Builder. Users who are not assigned to a project area cannot log into Case
Manager Builder. Users can define and modify solutions only in the project area
that the users are assigned to.

About this task

Each development environment has a default project area named
dev_env_connection_definition. You must add at least one user to the default
project area before you can use Case Manager Builder. You can define more project
areas as needed to provide isolated work areas for developing and testing
solutions in Case Manager Builder. To access a project area, you can move users
and user groups from one project area to another as needed. You can add users in
user groups to the default project area, but you can add only individual users to a
nondefault project area. A user can belong only to one nondefault project area and
the default project area.

Before you add users to the project area, add them to the master group that you
configured for access to your object store.

You can add users to project areas by using the administration client. Select the
default project area, click Actions > View and Edit, and click the Security tab to
add users. For more information, see Managing project areas.

What to do next

Adding a user to a project area gives the user access to the solutions in the project
area in the design object store. If the user is not an administrator for the target
object store, then you must set the security for the user.

Verifying the IBM Case Manager applications in the development environment:

After you install your IBM Case Manager software, configure your environment,
and deploy the applications, you can start and verify the IBM Case Manager
applications in the development environment.

Procedure

To verify the IBM Case Manager applications:
1. Verify the IBM Case Manager API deployment by accessing the following link

from a browser:

Environment Application URL

High availability http://virtual_server_name/CaseManager/
CASEREST/v1/info

Stand-alone or network deployment http://server_name:port/CaseManager/
CASEREST/v1/info

2. Log in to the IBM Case Manager administration client by accessing the
following link from a browser:

66 Planning, Installation, and Upgrade Guide

http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.3.3/com.ibm.casemgmt.design.doc/acmdt016.htm


Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icmadmin

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icmadmin

3. Log in to the Case Manager Client by accessing the default IBM Case Manager
desktop from a browser:

Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icm

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icm

Verify that your specified Lightweight Directory Access Protocol (LDAP) users
can log in to the Case Manager Client.

4. Click the help icon to test whether the Case Manager Client help system
displays content.

5. Log in to the Case Manager Builder by accessing the following link from a
browser:

Environment Application URL

High availability http://virtual_server_name/CaseBuilder

Stand-alone or network deployment http://server_name:port/CaseBuilder

Verify that your specified LDAP users can log in to the Case Manager Builder.
6. Click the help icon to test whether the Case Manager Builder help system

displays content.

Configuring the production environment for cluster or network
deployment
You must configure the production environment before you deploy your solutions
to production. You configure the production environment after you configure the
development environment.

Before you begin

Be sure to have your completed configuration checklist available.

About this task

Configuring the production environment prepares Case Manager Builder and Case
Manager Client for use. You use the IBM Case Manager configuration tool to create
a profile, which is a collection of configuration and deployment tasks. When you
provide the required values for the tasks and run the tasks, you configure all the
required settings and deployments for your production environment.
1. “Running the production environment configuration tasks” on page 68
2. “Binding applications with WebSphere Application Server” on page 72
3. “Configuring production target object store indexes” on page 72
4. “Configuring email notification” on page 73
5. “Verifying the IBM Case Manager applications in the production environment”

on page 75
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Related tasks:
“Configuring a workflow system for IBM Case Manager” on page 51

Running the production environment configuration tasks:

Use the configuration tool to create a production environment profile and run the
configuration tasks.

Before you begin

Ensure that the cluster and your IBM Content Navigator instance are running
when you run the configuration tool tasks.

Procedure

To configure the production environment:
1. Log in to the IBM Case Manager server.
2. Start the configuration tool by running one of the following commands:

Operating system Command

AIX 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux for System z 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Windows Perform one of the following actions:

v Click Start > All Programs > IBM Case Manager > Case
Manager Configuration Tool.

v Run the following command:

_install_path\configure\configmgr.exe

_install_path is the location where IBM Case Manager is
installed, for example, one of the following directories:

– C:\Program Files\IBM\CaseManagement

– C:\Program Files (x86)\IBM\CaseManagement
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3. Click File > Create profile to create a production environment profile and use
the values from your configuration checklist to complete the fields. In the
Network shared directory field, ensure that you specify the shared location
that you created. After the profile files are created, the profile is opened so that
you can work with the individual tasks in the profile.

4. Edit, save, and run the Update the Content Platform Engine Client Connector
Files task. Running this task ensures that your client connector files match the
version of your Content Platform Engine. After you run this task, close and
then restart the configuration tool.

5. Edit, save, and run the following tasks. You must run the tasks in the order
listed.

Table 9. Task requirements for a production environment

Task Required

Configure the Case Management Object
Stores

Required to configure each target
environment.

Define Target Environment Required to configure each target
environment.

Configure the IBM Content Manager Host
Properties

Required if IBM Case Manager integrates
with IBM Content Manager.

Configure IBM Business Process Manager Required if IBM Case Manager integrates
with IBM Business Process Manager.

Register the IBM Business Automation
Workflow Plug-in

Required if you want to use the plug-in for
IBM Business Process Manager that provides
a access to your IBM Process Portal Work
dashboard from your IBM Case Manager
desktop. Save your changes and then run the
task to apply your settings.

This plug-in adds the Workflow > Launch
Process action to the Action menu and
pop-up menu in the Browse view of the IBM
Case Manager desktop. You can use this
action to launch an IBM BPM process from a
document. You can also add the Launch
Process action to the menu in the Documents
view for the Case Information widget.
Important: To use the IBM Business
Automation Workflow plug-in, you must use
the Hypertext Transfer Protocol Secure
(HTTPS) in your IBM Content Navigator
URL.

Create Case Manager Applications Always

Deploy the Case Manager API Always

Register the IBM Case Manager Services
Plug-in

Always

Deploy and Register Widgets Package Always
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.
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Table 9. Task requirements for a production environment (continued)

Task Required

Deploy the Forms Application Required if IBM Case Manager integrates
with IBM Forms or IBM FileNet P8 eForms.

If you configure IBM Forms or IBM FileNet
P8 eForms on a network deployment or
cluster environment, run this task in the
profile that contains the other tasks. Select
Network Deployment or Cluster for the
deployment type, eForms and IBM Forms
for the forms type, and Deployment
Manager Profile for the environment type.

If you integrate with IBM Forms 8.1 or
earlier on a network deployment or cluster
environment, the following additional steps
are required. These additional steps are not
required if you integrate with IBM Forms 8.2
or later or with only IBM FileNet P8 eForms.

1. For the managed nodes, create a profile
on each managed node that includes only
this task and run this task. Select
Network Deployment or Cluster for the
deployment type, eForms and IBM
Forms for the forms type, and Managed
Profile for the environment type.

2. After all nodes are configured, the
managed node or cluster must be
restarted to complete the forms
integration. You can restart the managed
node or cluster now, or after you run all
other configuration tasks.

Register the IBM Case Manager
Administration Client Plug-in

Always

Configure Box Collaboration Required if you want to enable case workers
to use Box to collaborate with external users.
This task configures the connection to the
Box server.

Register Target Environment Required to configure each target
environment.
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Table 9. Task requirements for a production environment (continued)

Task Required

Configure Business Rules Required if you use business rules in your
solution.
Tips:

v You can select only one locale in which to
write the business rules for your solutions.
If you must create solutions with business
rules in other locales, rerun this task to
change the rule persistence locale before
you create the solution. After the first rule
for a solution is saved, the rule persistence
locale cannot be changed.

v If you rerun this task to change the
location of the rules repository directory
after you deploy any solutions, complete
the following steps after you run the task:

1. Stop Content Platform Engine.

2. From the previous rules repository
directory, move the res_data directory
to the new location of the rules
repository directory. In a cluster
environment, the rules directory must
be a shared directory that can be
accessed by all Content Platform
Engine cluster servers.

3. Restart Content Platform Engine.

Register the External Data Service Required for solutions that use the external
data service.

Deploy and Register Extensions Package Required only when you add an extensions
package for a custom property editor or
controller.
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.

6. Restart the cluster.
“Configuring additional target environments”

Configuring additional target environments:

If you want to add new object stores to your production environment, you must
also configure a complete target environment. The target environment includes
creating the object store, creating a worfklow system, and running additional
configuration tasks.

Before you begin

Be sure to have your completed configuration checklist available.
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About this task

For each additional object store that your environment requires, complete the full
procedure for configuring a target environment.

Procedure

To configure additional target environments:

Use the instructions in Setting up target environments.

Binding applications with WebSphere Application Server:

If you use WebSphere Application Server, you must bind the web applications after
you run the IBM Case Manager configuration tasks.

Procedure

After the deployment tasks complete successfully, use the WebSphere Application
Server console to bind the following deployed applications to the web server:
v CaseClient
v CaseManager
v Any custom widgets packages and applications

Configuring production target object store indexes:

Your database administrator must create a four-part composite index for each
production target object store that is used for case management. That database
retrieval index is required for efficiently retrieving the case history in the Event
table in target object stores.

About this task

Restriction: Create the index for production target object stores that do not already
have a four part index. In previous releases of IBM Case Manager, a two part
index was recommended, but a four part index is more effective. If a two part
index was previously applied, you must replace it with the more effective,
four-part index.

The index contains unique key values, and the four-part index uses the following
format: <case_folder_column, audit_sequence DESC, object_class_id,
source_object_classid>.

case_folder_column
The name of the database column that contains the CmAcmCaseFolder
property. The property value is a globally unique identifier (GUID). The
database column name might not be the same in different target object stores.

audit_sequence
The database column name for the CmAuditSequence property is always
named audit_sequence in all target object stores. The audit_sequence column
provides an accurate time sequence for events. The property type is float, but
the property values are sequentially increasing positive integers that are
generated as new events are stored in the Event table.
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object_class_id
The name of this column is the same in all target object stores. This column is
included in the index to make filtering the case history events more efficient
when you search the case history.

source_object_class_id
The name of this column is the same in all object stores. This column is
included in the index to make filtering the case history events more efficient
when you search the case history.

Procedure

To create the four-part index:
1. If you previously created the two-part index, drop the index permanently.
2. Use Administration Console for Content Platform Engine to identify the

database column name of the CmAcmCaseFolder property in the Event table.
Record the values for the TableDefinition and ColumnId properties for the
CmAcmCaseFolder property in the target object store.
a. Navigate to Target Object Store > Data Design > Classes > Other Classes >

Event.
b. In the Properties tab, sort on Property Name.
c. Scroll down to find the property Table Definition and record the value.
d. Click Property Value. Another Administration Console for Content Platform

Engine tab opens.
e. Open the Column Definition dropdown list and select column

CmAcmCaseFolder. The Column Definition Properties tab opens.
f. Record the value of the property Column Name.

3. Use your database tools to create the four-part index with the following form:
<case_folder_column, audit_sequence DESC, object_class_id,
source_object_class_id>. The audit_sequence field of the index must be
specified as DESCENDING.

4. Repeat this procedure for each target object store in your production
environment that uses IBM Case Manager solutions.

Configuring email notification:

You can optionally enable email notification of workflow activity. Users can
configure which notifications they want to receive and their preferred locale. For
example, users can choose to be notified when work is assigned or when work is
approaching or passes a deadline. Configure email notification on the workflow
server, in IBM Content Navigator, and in the Case Manager Client.

“Enabling notification in the Administration Console for Content Platform
Engine”
“Enabling notification in IBM Content Navigator” on page 74
“Enabling notification in Case Manager Client” on page 75

Enabling notification in the Administration Console for Content Platform Engine:

Before you can enable email notification on your Content Platform Engine system,
you must specify a language pack. You specify the language pack and enable
notification by using the Administration Console for Content Platform Engine.
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About this task

When you configure your language pack, the language you choose should match
the default locale for the target object store. This locale value is specified on the
General tab. The default locale for a new system is English.

Procedure

To enable email notification:
1. Log in to Administration Console for Content Platform Engine.
2. Expand Object stores, right-click your target object store, and click

Administrative > Workflow System..
3. Click the Language Packs tab, and click New.
4. Add your language pack.

a. Select your locale from the dropdown menu. The locale selection will auto
fill the date time mask.

b. Enter the Content Platform Engine template path. By default, the email
template directory is set to the English language directory, which is
<install_path>/IBM/FileNet/ContentEngine/tools/PE/msg/en.

5. Save your changes.
6. Configure the Remote Servers settings:

a. Click the Remote Servers tab.
b. Check the Enable email notification check box.
c. Enter the host name and port values for your SMTP server.
d. Enter an email ID as the sender of your notifications.
e. Enter the email login ID and password for the system user that logs into the

server and sends the notification.
f. Save your changes.

7. Click the Advanced tab.
8. In the server list, change the value for the CacheSyncFixupEmail setting to

false. The default value for this setting is true.
9. Save your changes.

Enabling notification in IBM Content Navigator:

You use the settings in IBM Content Navigator to enable email notifications
through the administration desktop for IBM Case Manager.

About this task

When you configure your language pack, the language you choose should match
the default locale for the target object store. This locale value is specified on the
General tab. The default locale for a new system is English.

Procedure

To enable email notification:
1. Log in to IBM Content Navigator as an administrator. Enter the following URL

in a browser:
http://server:port/navigator

server is the IBM Content Navigator server name or IP address.
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port is the IBM Content Navigator port number.
2. Navigate to Repositories > Your target object store > General, and click

Connect.
3. In the Configuration Parameters tab, make sure that the Workflow connection

point field contains a valid value.
4. Navigate to Desktops > Case Manager > Edit.
5. On the Appearance tab, Select Work as a feature, and make sure that the target

object store is specified as the default repository.
6. On the General tab, in the Additional Settings pane, select Enable this desktop

for FileNet P8 workflow email notification.
7. Save your changes.

Enabling notification in Case Manager Client:

After you enable notification for your system, you must set your notification
preferences in the Case Manager Client application.

About this task

The preferences in Case Manager Client control the destination address for email
notification. Each user or login user of Case Manager Client must configure an
email address in order to receive notification.

Procedure

To enable email notification in Case Manager Client:
1. Log in to the Case Manager Client by accessing the default IBM Case Manager

desktop from a browser: http://server_name:port/navigator/?desktop=icm
2. Open the Work view and click Preferences.
3. Enter the email address where you want to receive notifications.
4. Use the On radio buttons to select the events for which you want to receive

notification.
5. Save your changes.

Verifying the IBM Case Manager applications in the production environment:

After you configure your environment and deploy the applications, you can start
and verify the IBM Case Manager applications in the production environment.

Procedure

To verify the IBM Case Manager applications:
1. Verify the IBM Case Manager API deployment by accessing the following link

from a browser:

Environment Application URL

High availability http://virtual_server_name/CaseManager/
CASEREST/v1/info

Stand-alone or network deployment http://server_name:port/CaseManager/
CASEREST/v1/info

2. Log in to the IBM Case Manager administration client by accessing the
following link from a browser:
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Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icmadmin

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icmadmin

3. Log in to the Case Manager Client by accessing the default IBM Case Manager
desktop from a browser:

Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icm

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icm

Verify that your specified Lightweight Directory Access Protocol (LDAP) users
can log in to the Case Manager Client.

4. Click the help icon to test whether the Case Manager Client help system
displays content.

Installing and configuring on a stand-alone server
Before you install IBM Case Manager, you must first install the prerequisite
software applications on the same server. Then you can use the IBM Case Manager
tools to install and configure the IBM Case Manager applications.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

About this task

A typical IBM Case Manager environment includes an IBM FileNet P8 Platform
system that is installed and configured on a distributed set of servers. You can use
an existing installation, or install a new FileNet P8 Platform system to work with
IBM Case Manager. Before you install IBM Case Manager, you must configure your
FileNet P8 Platform environment to work with IBM Case Manager.

If you have not prepared a server for IBM Case Manager that includes the
prerequisite software, you must install and configure the following applications for
IBM Case Manager:
v WebSphere Application Server
v IBM Content Navigator

For a development environment, you configure and deploy IBM Content Navigator
as a client of the Content Platform Engine instance that hosts the IBM Case
Manager object stores.

For a production environment, you again configure and deploy IBM Content
Navigator as a client of Content Platform Engine.

Use the IBM Case Manager configuration tool to configure the development and
production environments. You use the configuration tool to create profiles that
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contain tasks, where you enter properties and settings for all aspects of your IBM
Case Manager environment and applications. After you run the configuration
tasks, your IBM Case Manager system is ready to use.
1. “Preparing your FileNet P8 system for IBM Case Manager”
2. “Preparing the IBM Case Manager server” on page 82
3. “Installing IBM Case Manager” on page 86
4. “Configuring IBM Case Manager” on page 88

Preparing your FileNet P8 system for IBM Case Manager
For your FileNet P8 environment to work with IBM Case Manager, you must
install or upgrade FileNet P8, create users and object stores, and configure the
workflow system.

About this task

The IBM Case Manager configuration tool uses many of the same values from your
FileNet P8 installation and configuration to connect IBM Case Manager to the
FileNet P8 environment. Before you install, upgrade, and configure, review the
configuration checklist and collect values as applicable.
1. “Installing or upgrading FileNet P8”
2. “Enabling case management if you installed FileNet P8 by using IBM Content

Foundation” on page 78
3. “Identifying IBM Case Manager users” on page 79
4. “Creating IBM Case Manager object stores on Content Platform Engine” on

page 80
5. “Configuring a workflow system for IBM Case Manager” on page 81
Related reference:
“Configuration checklist” on page 31

Installing or upgrading FileNet P8
IBM Case Manager requires a minimum version of FileNet P8. You use the IBM
Administration Console for Content Platform Engine to configure the object store,
users, and workflow system.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

Procedure

To install or upgrade your FileNet P8 Platform environment:
1. Plan and prepare for the installation or upgrade of your IBM FileNet P8

Platform.
2. Install or upgrade IBM FileNet P8 Platform.
Related information:
 

Planning and preparing for IBM FileNet P8 installation
 

Planning and preparing for IBM FileNet P8 upgrade
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Enabling case management if you installed FileNet P8 by using
IBM Content Foundation
If you installed your FileNet P8 environment by using IBM Content Foundation
and you now want to use IBM Case Manager, you must update the prerequisite
software to add case management capabilities to your FileNet P8 environment.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

About this task

If you installed your FileNet P8 environment by using IBM Content Foundation,
you do not need to reinstall the Content Platform Engine (CPE) server software.
The CPE server software that is provided with IBM Content Foundation is
identical to the CPE server software that is provided with IBM FileNet Content
Manager. However, the version of IBM Content Navigator that is provided with
IBM Content Foundation is not supported by IBM Case Manager. You must install
the correct version of IBM Content Navigator.

The following procedure assumes that you have a development environment in
which IBM Content Navigator and IBM Case Manager are in the same application
server instance.

Procedure

To add case management capabilities if you installed FileNet P8 by using IBM
Content Foundation:
1. Download the following software:

a. From Passport Advantage, download a version of IBM Content Navigator
that is supported for IBM Case Manager.

b. From Passport Advantage, download any of the IBM Content Foundation
components that you want to use for case management, such as IBM
Cognos Real-time Monitoring, and the IBM Case Manager components.

2. Install the version of IBM Content Navigator that you downloaded. Ensure you
complete all applicable tasks in the configuration tool, including the Update the
FileNet P8 Client Connector Files task.

3. Validate that IBM Content Navigator works correctly against the Content
Platform Engine server that was installed by the IBM Content Foundation
installation program.

4. Continue with the standard IBM Case Manager installation steps. Ensure that
you complete the IBM Case Manager Update the Content Platform Engine
Client Connector Files task and the other configuration tasks in the correct
order, including the Create Case Manager Application task. These tasks will
synchronize the client connector files with Content Platform Engine.

5. Validate that IBM Case Manager works correctly against the Content Platform
Engine server that was installed by the IBM Content Foundation installation
program.

Related tasks:
 

Getting fixes from Fix Central
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Identifying IBM Case Manager users
When you identify the Content Platform Engine object stores that are used for IBM
Case Manager, you must identify the users that have access to these object stores.
Your IBM Case Manager users must have the appropriate access permissions on
the object stores. The required permissions vary depending on the user roles.

About this task

A best practice is to assign permissions to LDAP groups rather than individual
users.

How you assign users and groups can vary based on the directory service provider
in your environment. Use the documentation that is provided for your directory
server to identify IBM Case Manager groups.

The groups or roles that are described in this task cover the main functions of the
core IBM Case Manager applications. If you are extending your IBM Case Manager
system, you might need to create or designate additional groups or roles.

It is a best practice to create a case management master group to use for assigning
access to object stores at the time that you create the object store. Give this group
Use object store permission. With this method, you can grant new users access to
the object store by adding them to the master group. This approach can prevent
issues with changing security on an established object store. For development
environments, the master group can be #AUTHENTICATED-USERS. For a
production environment, more controlled security is needed.

Procedure

To assign IBM Case Manager groups:
1. In your directory server, find the configured realm for the Content Platform

Engine instance that you are using with IBM Case Manager.
2. Identify the following groups:

Table 10. Groups for business analysts and solution administrators

Group Description

Business analysts Responsible for designing the solution in
Case Manager Builder and the user interface
application in Case Manager Client. Business
analysts work in a development environment
to develop and test the solution. In order to
create and edit solutions, and design the
application, business analysts need access to
objects in the design object store. In addition,
the business analysts need access to the
target object stores and the isolated region to
deploy, test, and customize the solutions.

Solution administrators Responsible for managing project areas.
Responsible for copying and deploying
solutions, and for promoting solutions to
templates. Responsible for managing roles.

3. Ensure that both groups also have the following permissions:
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Table 11. Group permissions

Component area Permissions to assign

IBM FileNet P8 Domain GCD Both the business analyst and the solution
administrator groups require Global
Configuration Domain (GCD) administrator
rights. This role is referred to as the FileNet
P8 Platform Administrator in FileNet P8
Platform documentation.

Content Platform Engine Add to Configuration groups rights to enable
deployment, which requires creation of
rosters, queues, applications spaces, and
roles.

Case workers can view the list of roles for a
solution for reassigning work only if the user
or group has access to the application space.
You can add the users to the SysAdminG
group or manually add the users to the
access list of the application space

If a business analyst must run Process
Administrator in order to update work items,
then also add the business analyst to the
Process Administrator group.
Tip: If a roster does not have users or
groups that are assigned to it, then all users
can access the roster. That is, all users have
query and create rights. Users must have
create rights to launch a workflow. If a queue
does not have users or groups that are
assigned to it, then all users can access the
queue. That is, all users have query and
process rights.

Object store permissions For the business analysts group, assign Use
Object Store level permission for the design
object store and target object stores.

Process Designer Business analysts must belong to the
Workflow System Configuration group to
edit workflows in the Process Designer
application from Case Manager Builder. You
can configure this group in IBM
Administration Console for Content Platform
Engine when you configure the target object
store workflow system.

Related information:
 

Creating Content Engine directory server accounts

Creating IBM Case Manager object stores on Content Platform
Engine
IBM Case Manager uses Content Platform Engine object stores for creating, storing,
and deploying case solutions. You can use IBM Administration Console for
Content Platform Engine to create the design object store and the target object
store. You can also use an existing object store for the target object store.
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About this task

You must create or designate the design object store and target object stores for
your IBM Case Manager environment. In a typical use case, you create a new
design object store to use for creating your solutions. You can use an existing object
store that already contains documents and objects as the target object store for
deployed solutions, or you can create a new target object store.

When you create the object store, add the case management master group that you
created, and grant the group Use object store permission.

Procedure

To create the IBM Case Manager object stores:
1. In the IBM Administration Console for Content Platform Engine, create an

object store by using the New Object Store wizard. For more information, see
Creating the initial object store.

2. In the Select Add-ons window, click the Workplace/Workplace XT
Configuration button. This setting provides the add-ons that are required for
IBM Case Manager. If you want only the minimum required add-ons, ensure
that you select the following add-ons:
v Content Engine Base Extensions, which are required for all Content Engine

configurations.
v Base Application Extensions, which are a prerequisite for Search Extensions

and the Workplace Base Extensions.
v Search Extensions, which are required to browse and search for content in

IBM Content Navigator.
v Workplace Base Extensions, which are required to browse and search for

content in IBM Content Navigator.
v Workplace Template Extensions, which are required to open folders in IBM

Content Navigator.
3. In the Specify Object Store Administrators window, click Add. Then, click Find,

and find the business analyst and solution administrator groups or the
equivalent groups for your environment.

4. Complete the wizard and accept all remaining default values.
Related information:
 

Concepts: object stores
 

IBM FileNet P8 add-ons required for IBM Content Navigator

Configuring a workflow system for IBM Case Manager
IBM Case Manager uses workflow functionality to route and track user tasks.
When you create a workflow system, you define an isolated region and its
connection point. In addition, you can optionally customize the database storage
parameters and configure email notification.

About this task

You can create a new object store to use as your IBM Case Manager target object
store, or you can designate an existing object store.
v If you use a newly created object store, you must configure the isolated region

and connection point as explained in this task. You use IBM Administration
Console for Content Platform Engine to configure an isolated region and a
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corresponding connection point. The database connection that you define must
point to the target object store database. Use this task to complete the
configuration.

v If you use an existing object store that has never been configured for workflows,
you must configure the isolated region and connection point in the same way
that you would for a new object store. Use the steps in this task to complete the
configuration.

v If you use an existing object store that has already been configured for
workflows, an isolated region and connection point have already been
configured for the object store. Skip this task.

Procedure

To configure a workflow system:
1. Start the IBM Administration Console for Content Platform Engine.
2. Start the New Workflow System wizard in the administration console.

a. In the domain navigation pane, click the object store.
b. In the object store navigation pane, right-click the Administrative >

Workflow System folder and click New to start the wizard.
3. Complete the wizard steps by using the values in your worksheet. The values

that are displayed in the wizard screens are default values, which you must
change to match your IBM Case Manager values.

Preparing the IBM Case Manager server
Before you can install, configure, and use IBM Case Manager, you must install the
supporting software applications on the server where you want to install IBM Case
Manager. A web application server deploys the IBM Case Manager applications.
IBM Content Navigator hosts the IBM Case Manager administration client and the
Case Manager Client.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

For an AIX or Linux server that does not use Domain Name Service (DNS) or
Network Information Service (NIS), verify that the /etc/hosts file contains the
name and Internet Protocol (IP) address of all servers that the server communicates
with, including the local host. Verify that the etc/netsvc.conf file contains the
value hosts = local.

About this task

The IBM Case Manager installation program detects whether the correct version of
IBM Content Navigator is installed. You prepare the server where you want to
install IBM Case Manager by installing and configuring the supporting software
applications.

The requirements for installing the supporting software can be different for
development and production environments.

A development environment requires IBM Content Navigator. You must install
IBM Case Manager in the same profile as IBM Content Navigator.
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1. “Installing prerequisite software”
2. “Configuring the application server” on page 85

Installing prerequisite software
The IBM Case Manager applications are deployed on a web application server.
IBM Content Navigator hosts the IBM Case Manager administration client and
Case Manager Client. In development environments, IBM Case Manager also
requires Process Designer.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

About this task

You use the application server to deploy IBM Case Manager and IBM Content
Navigator. You also use the application server to coordinate authentication between
the IBM Case Manager applications and Content Platform Engine.

If you are installing IBM Case Manager on a server where your application server
and IBM Content Navigator are already installed, upgrade the software to the
minimum required version before you install IBM Case Manager.

You might need to increase the memory settings in your application server to
enable better performance in your deployed IBM Case Manager applications. For
more information, see Adjusting the Java Virtual Machine (JVM) heap for IBM
Case Manager

Procedure

To install the prerequisite software:
1. Install your application server, including the latest fix packs and updates.
2. Install, configure, and deploy IBM Content Navigator.

Install one IBM Content Navigator server for each IBM Case Manager server
that you plan to install. You cannot share a single IBM Content Navigator
server among multiple IBM Case Manager servers.

Tip: Note the directory service server host name in the IBM Content Navigator
LDAP configuration task because you must use the same value when installing
IBM Case Manager.

WebSphere Application Server environments only: You must deploy IBM
Content Navigator and IBM Case Manager to the same server (runtime
environment or JVM).

Tip: Be sure to configure the viewer for your IBM Content Navigator instance.
“Connecting and configuring additional repositories” on page 84

Related information:
 

WebSphere Application Server documentation
 

Planning, installing, and configuring IBM Content Navigator
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Connecting and configuring additional repositories:

Case Manager Client users can add documents or attachments from a repository
other than the case management object store. To enable this access, you must
connect to a repository and configure the repository to use IBM Content Navigator
as a web client. After you connect to and configure the repository, you must
associate a desktop to enable users to access the content.

Before you begin

You can use IBM Content Navigator to connect to the following types of
repositories:
v IBM Content Manager
v IBM Content Manager OnDemand
v IBM FileNet P8
v Repositories that support the OASIS Content Management Interoperability

Services (CMIS) specification
v Box

The types of repositories that you can connect to depend on the repository
connectors that are installed on your web application server. You use the IBM
Content Navigator Configuration and Deployment Tool tasks for connecting to the
repository that you plan to use. In the task, you must provide connection
properties such as database type, connection name, host name, database name,
schema name, database port, connection ID, and password to configure the
connection.

After you run the required tasks and deploy the web application, go to the IBM
Content Navigator administration tool and connect to the repository server by
using the required library server administration user ID, such as icmadmin.

About this task

When you are configuring the parameters for the repository, consider the
configuration parameters like system properties and search.

When IBM Content Navigator connects to an IBM FileNet P8 repository that is in a
FileNet P8 domain other than the domain that is used for the design and target
object stores, all web servers that host Content Platform Engine instances must use
the same LTPA keys. Also, all Content Platform Engine instances must be the same
major, minor, and fix pack version.

When case workers add documents from another repository, a reference to the
latest version of the document in the source repository is added to the case. If the
document is deleted from the source repository, the reference is deleted from the
case or the reference becomes invalid. For IBM FileNet P8 or Box repositories, case
workers can add a copy of the current version of a document to the case
management repository instead of referencing the document in the source
repository. The copy remains in the case even if the document is deleted from the
source repository. However, any changes that are made to the document in the
source repository are not reflected in the case. To allow case workers to add a copy
of a Box document to the current case, enable the Box copy feature for the case
management repository in IBM Content Navigator. For IBM FileNet P8
repositories, no additional configuration in IBM Content Navigator is required to
enable case workers to copy documents to the case.
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Procedure

To connect and configure an external repository:
1. Open the IBM Content Navigator administration tool in the web client.
2. Click Repositories > New Repository.
3. Select the repository type.
4. Click General and enter the information that is specific to the repository that

you are configuring. The repository information such as the display name, ID,
and server name are required to configure the repository.

5. Click Connect. You can save the default configuration settings for the
repository or continue to customize the settings.

6. Click Configuration Parameters > System Properties > Browse or Search to
configure additional settings for the repository.

7. Save your settings.
8. Add the newly added repository to the Case Manager desktop:

a. In the IBM Content Navigator administration tool, click Desktops and
open your Case Manager desktop.

b. On the Repositories tab, select the new repository from the Available
Repositories list.

c. Use the move arrow to add the new repository to the Selected
Repositories list.

9. To enable case workers to add a copy of a Box document to the current case,
enable the Box copy feature for the case management repository.
a. In the IBM Content Navigator administration tool, click Repositories and

open the IBM FileNet Content Manager target object store that is used as
the case management repository.

b. On the Configuration Parameters tab, enable the Optional Features > Box
copy option.

10. For each case type in which you want users to be able to add documents or
attachments from an external repository that you configured, edit the case
type in Case Manager Builder and select Allow documents and attachments
from repositories other than the case management object stores.

Related tasks:
 

Adding and modifying case types
Related information:
 

Integrating IBM Content Navigator with Box

Configuring the application server
You configure your application server to work with your installation of IBM
Content Navigator. In most cases, these configuration steps cover the configuration
that is required for IBM Case Manager on the application server. Additional
configuration might be required for your IBM Case Manager environment.

“Configuring Active Directory user accounts in WebSphere Application Server”

Configuring Active Directory user accounts in WebSphere Application Server:

If you did not use the same full name, samAccountName, and display name when
you created your Active Directory user accounts, you must configure the Login
properties value in WebSphere Application Server.
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Procedure

To set the Login properties value:
1. Log in to the WebSphere Application Server administrative console.
2. Click Global security > Federated repositories > Manage repositories >

my_LDAP_provider.
3. In the Security section, set the Login properties value to one of the following

values:

Option Description

uid Users can log in with samAccountName

cn Users can log in with full name

uid;cn Users can log in with either
samAccountName or full name

4. Click Apply.
5. Save your changes.

Installing IBM Case Manager
You can install IBM Case Manager interactively, by using the installation program.
You can also install silently, by adding installation values to an input file and
running the installation program from a command line.

Before you begin

Install the prerequisite applications before you run the IBM Case Manager
installation program.

For details about the hardware and software requirements, see “System
requirements” on page 10.

About this task

The IBM Case Manager installation program installs the required files for all the
IBM Case Manager applications.

“Installing IBM Case Manager interactively”
“Installing IBM Case Manager silently” on page 87

Installing IBM Case Manager interactively
The IBM Case Manager installation program detects whether you have prerequisite
software installed. The program installs the IBM Case Manager files.

About this task

The installation program detects whether the IBM Content Navigator software is
installed. The installation program then installs the IBM Case Manager application
files and the IBM Case Manager configuration tool.

Procedure

To install IBM Case Manager interactively:
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1. Log on to the server where you want to install IBM Case Manager. Log on as a
user with write access to the destination directory for your installation of IBM
Case Manager, and with read, write, and execute access for the application
server installation directory.

2. Navigate to the IBM Case Manager software package in the installation media.
3. Run the installation program:

Operating system Command

AIX 5.3.3.0-ICM-AIX.BIN

Linux 5.3.3.0-ICM-LINUX.BIN

Linux for System z 5.3.3.0-ICM-ZLINUX.BIN

Windows 5.3.3.0-ICM-WIN.EXE

4. Complete the IBM Case Manager installation program.

Important: Set the license type to the IBM Business Automation Workflow
Enterprise license or the IBM Business Automation Workflow Express license to
which you are entitled. Do not set the license type to IBM Case Manager
unless you are upgrading an existing IBM Case Manager installation. For more
information on upgrading, see “Upgrading IBM Case Manager” on page 186.

5. When the installation completes, check for errors in the IBM Case Manager
installation log. The IBM_Case_Manager_5.3.3.0_2018.03_InstallLog.txt is
created in the installation directory. For example, review the
/opt/IBM/CaseManagement/logs/
IBM_Case_Manager_5.3.3.0_2018.03_InstallLog.txt file.

What to do next

Use the IBM Case Manager configuration tool to configure your IBM Case
Manager applications.

Installing IBM Case Manager silently
When you install IBM Case Manager silently, you run a command and specify an
input file. Add the information for your environment in the input file before you
start the installation. The installation program installs IBM Case Manager
applications.

About this task

The installation program detects whether the prerequisite IBM Content Navigator
software is installed. The installation program then installs the IBM Case Manager
applications and the IBM Case Manager configuration tool.

Procedure

To install IBM Case Manager silently:
1. Log on to the server where you plan to install IBM Case Manager. Log on as a

user with write access to the destination directory for your installation of IBM
Case Manager, and with read, write, and execute access for the application
server installation directory.

2. Navigate to the IBM Case Manager software package in the installation media.
3. Edit the cm_silent_install.txt file to reflect the installation choices for your

environment.
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Important: Set the license type to the IBM Business Automation Workflow
Enterprise license or the IBM Business Automation Workflow Express license to
which you are entitled. Do not set the license type to IBM Case Manager
unless you are upgrading an existing IBM Case Manager installation. For more
information on upgrading, see “Upgrading IBM Case Manager” on page 186.

4. Run the installation program:

Operating system Command

AIX 5.3.3.0-ICM-AIX.BIN -i silent -f
cm_silent_install.txt

Linux 5.3.3.0-ICM-LINUX.BIN -i silent -f
cm_silent_install.txt

Linux for System z 5.3.3.0-ICM-ZLINUX.BIN -i silent -f
cm_silent_install.txt

Windows 5.3.3.0-ICM-WIN.EXE -i silent -f
cm_silent_install.txt

5. When the installation completes, check for errors in the IBM Case Manager
installation log. The IBM_Case_Manager_5.3.3.0_2018.03_InstallLog.txt is
created in the installation directory. For example, review the
/opt/IBM/CaseManagement/logs/
IBM_Case_Manager_5.3.3.0_2018.03_InstallLog.txt file.

What to do next

Use IBM Case Manager configuration tool to configure your IBM Case Manager
applications.

Configuring IBM Case Manager
You must configure IBM Case Manager before you can use it in development or
production. Configuring your system prepares the Case Manager Builder
application and the Case Manager Client application for deployment on the
application server. After you deploy these applications, you can create, test,
manage, deploy, and work with your business solutions.

About this task

Your case management system consists of a development environment for creating
and testing case management solutions and a production environment for working
with running case management solutions. You must configure both environments.

Configuring the development environment includes configuring Case Manager
Builder and Case Manager Client. Configuring the production environment
includes configuring only Case Manager Client.

You use the IBM Case Manager configuration tool to create a profile for each
development environment instance and a profile for each production environment
instance. The profile includes several configuration and deployment tasks that you
must edit and run before you can create and deploy case management solutions.
For example, the Deploy Case Manager Builder task requires data about the
application server settings to deploy the solution design application.
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If you use the graphical user interface for the configuration tool, you must edit the
property values for each task in the profile, save your changes, and then run the
task. The data that you enter in the graphical user interface is saved in XML files,
but you do not directly edit the files.

If you use the command-line version of the configuration tool, you must directly
edit the XML files that store the values for the task. The XML files contain the
properties and values that describe the associated configuration and deployment
tasks. Three XML files contain the information that is common to all tasks in the
profile, and each configuration task in the profile has one configuration XML file.
1. “Preparing to configure your case management system”
2. “Configuring the development environment” on page 90
3. “Configuring the production environment” on page 96

Preparing to configure your case management system
Before you run the IBM Case Manager configuration tool, you must grant
permission to the user who will configure your IBM Case Manager system. You
must also prepare Content Platform Engine to connect with your IBM Case
Manager applications.

About this task

The user who runs the IBM Case Manager configuration tool requires access to the
files and directories that contain the configuration properties.

A connectivity task in the IBM Case Manager configuration tool configures a
connection between the IBM Case Manager applications and Content Platform
Engine. To prepare for this task, you must first ensure that LTPA is configured on
Content Platform Engine.

“Granting directory permissions to the configuration tool user”

Granting directory permissions to the configuration tool user:

You must grant file and directory permissions to config_tool_user, which is the user
who runs the IBM Case Manager configuration tool, to allow this user to run the
configuration tool and create files in the install_path/configure directory.

Procedure

To grant permissions to the config_tool_user user:
1. Log in as case_manager_install_user to the server where you installed the IBM

Case Manager configuration tool.
2. Grant permissions to the config_tool_user user for the executable file that you

intend to use:

Operating system Permissions

AIX

Linux

Linux for System z

Graphical user interface

Grant execute permission on all files in the
CaseManagement\configure\tools directory.
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Operating system Permissions

AIX

Linux

Linux for System z

Command line

Grant execute permission on all files in the
CaseManagement\configure\tools directory.

Windows: graphical user interface Grant read and execute permissions on all
files in the CaseManagement\configure\tools
directory.

Windows: command line Grant read and execute permissions on all
files in the CaseManagement\configure\tools
directory.

3. Grant read and write permission to the install_path directory where you
installed IBM Case Manager

4. Grant read, write, and execute permissions to the application server installation
directory.

5. Before you start the configuration tool, log off the server where the
configuration tool is installed and log on again as config_tool_user.

Configuring the development environment
You must configure the development environment before you use IBM Case
Manager to create and deploy solutions. You use the development environment to
create, modify, and test solutions before moving them into a production
environment.

Before you begin

Be sure to have your completed configuration checklist available.

Procedure

To configure the development environment:
1. Log in to the IBM Case Manager server.
2. Start the configuration tool by running one of the following commands:

Operating system Command

AIX 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr
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Operating system Command

Linux for System z 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Windows Perform one of the following actions:

v Click Start > All Programs > IBM Case Manager > Case
Manager Configuration Tool.

v Run the following command:

_install_path\configure\configmgr.exe

_install_path is the location where IBM Case Manager is
installed, for example, one of the following directories:

– C:\Program Files\IBM\CaseManagement

– C:\Program Files (x86)\IBM\CaseManagement

3. Click File > Create profile to create a development environment profile and
use the values from your configuration checklist to complete the fields. In the
Network shared directory field, ensure that you specify the shared location
that you created. After the profile files are created, the profile is opened so that
you can work with the individual tasks in the profile.

4. Edit, save, and run the Update the Content Platform Engine Client Connector
Files task. Running this task ensures that your client connector files match the
version of your Content Platform Engine. After you run this task, close and
then restart the configuration tool.

5. Edit, save, and run the following tasks. You must run the tasks in the order
listed.

Table 12. Task requirements for a development environment

Task Required

Configure the Case Management Object
Stores

Always

Define the Default Project Area Required if you create new object stores for
the V5.3.3 development environment.

Configure the IBM Content Manager Host
Properties

Required if IBM Case Manager integrates
with IBM Content Manager.

Configure IBM Business Process Manager Required if IBM Case Manager integrates
with IBM Business Process Manager and you
create new object stores for the V5.3.3
development environment.

This task is applicable only if you use
WebSphere Application Server.
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Table 12. Task requirements for a development environment (continued)

Task Required

Register the IBM Business Automation
Workflow Plug-in

Required if you want to use the plug-in for
IBM Business Process Manager that provides
a access to your IBM Process Portal Work
dashboard from your IBM Case Manager
desktop. Save your changes and then run the
task to apply your settings.

This plug-in adds the Workflow > Launch
Process action to the Action menu and
pop-up menu in the Browse view of the IBM
Case Manager desktop. You can use this
action to launch an IBM BPM process from a
document. You can also add the Launch
Process action to the menu in the Documents
view for the Case Information widget.
Important: To use the IBM Business
Automation Workflow plug-in, you must use
the Hypertext Transfer Protocol Secure
(HTTPS) in your IBM Content Navigator
URL.

Create Case Manager Applications Always

Deploy the Case Manager API Always

Register the IBM Case Manager Services
Plug-in

Always

Deploy Case Manager Builder Always

Deploy and Register Widgets Package Always
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.

Deploy the Forms Application Required if IBM Case Manager integrates
with IBM Forms or IBM FileNet P8 eForms.

Register the IBM Case Manager
Administration Client Plug-in

Always

Configure Box Collaboration Required if you want to enable case workers
to use Box to collaborate with external users.
This task configures the connection to the
Box server.

Register Project Area Always
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Table 12. Task requirements for a development environment (continued)

Task Required

Configure Business Rules Required if you use business rules in your
solution.
Tips:

v You can select only one locale in which to
write the business rules for your solutions.
If you need to create solutions with
business rules in other locales, rerun this
task to change the rule persistence locale
before you create the solution. After the
first rule for a solution is saved, the rule
persistence locale cannot be changed.

v If you rerun this task to change the
location of the rules repository directory
after you deploy any solutions, complete
the following steps after you run the task:

1. Stop Content Platform Engine.

2. From the previous rules repository
directory, move the res_data directory
to the new location of the rules
repository directory. In a cluster
environment, the rules directory must
be a shared directory that can be
accessed by all Content Platform
Engine cluster servers.

3. Restart Content Platform Engine.

Register the External Data Service Required for solutions that use the external
data service.

Deploy and Register Extensions Package Required only when you add an extensions
package for a custom property editor or
controller.
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.

6. Restart the application server.
“Configuring IBM Case Manager to use the stand-alone IBM Process Designer”
on page 94
“Adding users to a project area” on page 94
“Verifying the IBM Case Manager applications in the development
environment” on page 95

Related tasks:
“Configuring the production environment” on page 96
“Configuring a workflow system for IBM Case Manager” on page 51
Related reference:
“Configuration checklist” on page 31
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Configuring IBM Case Manager to use the stand-alone IBM Process Designer:

When you access Process Designer from Case Manager Builder or from the
Content Platform Engine Applets Support plug-in for IBM Content Navigator, it
runs as a Java applet from a browser with Java plug-in NSAPI support. Many
browsers no longer support Java applets or are planning to drop support for Java
applets. If your web browser does not support running Java applets, you can use a
new stand-alone Process Designer that is available with Content Platform Engine.

About this task

This version of Process Designer runs as a stand-alone Java application without
requiring a web browser.

Procedure

To configure IBM Case Manager to use the stand-alone Process Designer:
1. Install the stand-alone Process Designer on your local system. For more

information about installing and using this software, see Running Process
Designer.

2. To choose how the Process Designer is to be hosted, run the Create Case
Manager Applications task in the IBM Case Manager configuration tool and
select one of the following options:

Option Description

CPE Support Applets Plug-in Choose this option to use either use
stand-alone Process Designer or the Process
Designer applet.

Standalone Process Designer Choose this option to disable running
Process Designer as an applet. If you choose
this option, you will no longer be able to
access Process Designer from Case Manager
Builder.

3. Run the Deploy Case Manager Builder task.
4. Copy the CaseManagement/WorkplaceXTConfig/ICMSolutionEdit.jar file to the

lib folder in your Content Platform Engine installation directory in which you
installed the stand-alone Process Designer. This file enables stand-alone Process
Designer to support editing by multiple users.

What to do next

To use stand-alone Process Designer to edit workflows for your IBM Case Manager
solution, launch the stand-alone Process Designer, and click File > Solution > Edit
to navigate to the workflow definition file in your design object store. The
workflow definition file is located in /IBM Case Manager/Solutions/Solution Name.

Adding users to a project area:

You must add at least one user to the default project area before you start Case
Manager Builder. Users who are not assigned to a project area cannot log into Case
Manager Builder. Users can define and modify solutions only in the project area
that the users are assigned to.
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About this task

Each development environment has a default project area named
dev_env_connection_definition. You must add at least one user to the default
project area before you can use Case Manager Builder. You can define more project
areas as needed to provide isolated work areas for developing and testing
solutions in Case Manager Builder. To access a project area, you can move users
and user groups from one project area to another as needed. You can add users in
user groups to the default project area, but you can add only individual users to a
nondefault project area. A user can belong only to one nondefault project area and
the default project area.

Before you add users to the project area, add them to the master group that you
configured for access to your object store.

You can add users to project areas by using the administration client. Select the
default project area, click Actions > View and Edit, and click the Security tab to
add users. For more information, see Managing project areas.

What to do next

Adding a user to a project area gives the user access to the solutions in the project
area in the design object store. If the user is not an administrator for the target
object store, then you must set the security for the user.

Verifying the IBM Case Manager applications in the development environment:

After you install your IBM Case Manager software, configure your environment,
and deploy the applications, you can start and verify the IBM Case Manager
applications in the development environment.

Procedure

To verify the IBM Case Manager applications:
1. Verify the IBM Case Manager API deployment by accessing the following link

from a browser:

Environment Application URL

High availability http://virtual_server_name/CaseManager/
CASEREST/v1/info

Stand-alone or network deployment http://server_name:port/CaseManager/
CASEREST/v1/info

2. Log in to the IBM Case Manager administration client by accessing the
following link from a browser:

Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icmadmin

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icmadmin

3. Log in to the Case Manager Client by accessing the default IBM Case Manager
desktop from a browser:
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Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icm

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icm

Verify that your specified Lightweight Directory Access Protocol (LDAP) users
can log in to the Case Manager Client.

4. Click the help icon to test whether the Case Manager Client help system
displays content.

5. Log in to the Case Manager Builder by accessing the following link from a
browser:

Environment Application URL

High availability http://virtual_server_name/CaseBuilder

Stand-alone or network deployment http://server_name:port/CaseBuilder

Verify that your specified LDAP users can log in to the Case Manager Builder.
6. Click the help icon to test whether the Case Manager Builder help system

displays content.
Related tasks:
“Verifying the IBM Case Manager applications in the production environment” on
page 103

Configuring the production environment
You must configure the production environment before you deploy your solutions
to production. You configure the production environment after you configure the
development environment.

Before you begin

Be sure to have your completed configuration checklist available.

About this task

Configuring the production environment prepares Case Manager Builder and Case
Manager Client for use. You use the IBM Case Manager configuration tool to create
a profile, which is a collection of configuration and deployment tasks. When you
provide the required values for the tasks and run the tasks, you configure all the
required settings and deployments for your production environment.

Procedure

To configure the production environment:
1. Log in to the IBM Case Manager server.
2. Start the configuration tool by running one of the following commands:
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Operating system Command

AIX 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux for System z 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Windows Perform one of the following actions:

v Click Start > All Programs > IBM Case Manager > Case
Manager Configuration Tool.

v Run the following command:

_install_path\configure\configmgr.exe

_install_path is the location where IBM Case Manager is
installed, for example, one of the following directories:

– C:\Program Files\IBM\CaseManagement

– C:\Program Files (x86)\IBM\CaseManagement

3. Click File > Create profile to create a development environment profile and
use the values from your configuration checklist to complete the fields. Ensure
that you specify the following values:
v Use the default profile location, for example, Dmgr01.
v For the Content Engine connection, ensure that you are pointing to a single

Content Engine node.

After the profile files are created, the profile is opened so that you can work
with the individual tasks in the profile.

4. Edit, save, and run the Update the Content Platform Engine Client Connector
Files task. Running this task ensures that your client connector files match the
version of your Content Platform Engine. After you run this task, close and
then restart the configuration tool.

5. Edit, save, and run the following tasks. You must run the tasks in the order
listed.
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Table 13. Task requirements for a production environment

Task Required

Configure the Case Management Object
Stores

Required to configure each target
environment.

Define Target Environment Required to configure each target
environment.

Configure the IBM Content Manager Host
Properties

Required if IBM Case Manager integrates
with IBM Content Manager.

Configure IBM Business Process Manager Required if IBM Case Manager integrates
with IBM Business Process Manager.

Register the IBM Business Automation
Workflow Plug-in

Required if you want to use the plug-in for
IBM Business Process Manager that provides
a access to your IBM Process Portal Work
dashboard from your IBM Case Manager
desktop. Save your changes and then run the
task to apply your settings.

This plug-in adds the Workflow > Launch
Process action to the Action menu and
pop-up menu in the Browse view of the IBM
Case Manager desktop. You can use this
action to launch an IBM BPM process from a
document. You can also add the Launch
Process action to the menu in the Documents
view for the Case Information widget.
Important: To use the IBM Business
Automation Workflow plug-in, you must use
the Hypertext Transfer Protocol Secure
(HTTPS) in your IBM Content Navigator
URL.

Create Case Manager Applications Always

Deploy the Case Manager API Always

Register the IBM Case Manager Services
Plug-in

Always

Deploy and Register Widgets Package Always
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.

Deploy the Forms Application Required if IBM Case Manager integrates
with IBM Forms or IBM FileNet P8 eForms.

Register the IBM Case Manager
Administration Client Plug-in

Always

Configure Box Collaboration Required if you want to enable case workers
to use Box to collaborate with external users.
This task configures the connection to the
Box server.

Register Target Environment Required to configure each target
environment.
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Table 13. Task requirements for a production environment (continued)

Task Required

Configure Business Rules Required if you use business rules in your
solution.
Tips:

v You can select only one locale in which to
write the business rules for your solutions.
If you must create solutions with business
rules in other locales, rerun this task to
change the rule persistence locale before
you create the solution. After the first rule
for a solution is saved, the rule persistence
locale cannot be changed.

v If you rerun this task to change the
location of the rules repository directory
after you deploy any solutions, complete
the following steps after you run the task:

1. Stop Content Platform Engine.

2. From the previous rules repository
directory, move the res_data directory
to the new location of the rules
repository directory. In a cluster
environment, the rules directory must
be a shared directory that can be
accessed by all Content Platform
Engine cluster servers.

3. Restart Content Platform Engine.

Register the External Data Service Required for solutions that use the external
data service.

Deploy and Register Extensions Package Required only when you add an extensions
package for a custom property editor or
controller.
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.

6. Restart the application server.
“Configuring additional target environments” on page 100
“Configuring production target object store indexes” on page 100
“Configuring email notification” on page 101
“Verifying the IBM Case Manager applications in the production environment”
on page 103

Related tasks:
“Configuring the development environment” on page 90
“Configuring a workflow system for IBM Case Manager” on page 51
Related reference:
“Configuration checklist” on page 31
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Configuring additional target environments:

If you want to add new object stores to your production environment, you must
also configure a complete target environment. The target environment includes
creating the object store, creating a worfklow system, and running additional
configuration tasks.

Before you begin

Be sure to have your completed configuration checklist available.

About this task

For each additional object store that your environment requires, complete the full
procedure for configuring a target environment.

Procedure

To configure additional target environments:

Use the instructions in Setting up target environments.

Configuring production target object store indexes:

Your database administrator must create a four-part composite index for each
production target object store that is used for case management. That database
retrieval index is required for efficiently retrieving the case history in the Event
table in target object stores.

About this task

Restriction: Create the index for production target object stores that do not already
have a four part index. In previous releases of IBM Case Manager, a two part
index was recommended, but a four part index is more effective. If a two part
index was previously applied, you must replace it with the more effective,
four-part index.

The index contains unique key values, and the four-part index uses the following
format: <case_folder_column, audit_sequence DESC, object_class_id,
source_object_classid>.

case_folder_column
The name of the database column that contains the CmAcmCaseFolder
property. The property value is a globally unique identifier (GUID). The
database column name might not be the same in different target object stores.

audit_sequence
The database column name for the CmAuditSequence property is always
named audit_sequence in all target object stores. The audit_sequence column
provides an accurate time sequence for events. The property type is float, but
the property values are sequentially increasing positive integers that are
generated as new events are stored in the Event table.

object_class_id
The name of this column is the same in all target object stores. This column is
included in the index to make filtering the case history events more efficient
when you search the case history.
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source_object_class_id
The name of this column is the same in all object stores. This column is
included in the index to make filtering the case history events more efficient
when you search the case history.

Procedure

To create the four-part index:
1. If you previously created the two-part index, drop the index permanently.
2. Use Administration Console for Content Platform Engine to identify the

database column name of the CmAcmCaseFolder property in the Event table.
Record the values for the TableDefinition and ColumnId properties for the
CmAcmCaseFolder property in the target object store.
a. Navigate to Target Object Store > Data Design > Classes > Other Classes >

Event.
b. In the Properties tab, sort on Property Name.
c. Scroll down to find the property Table Definition and record the value.
d. Click Property Value. Another Administration Console for Content Platform

Engine tab opens.
e. Open the Column Definition dropdown list and select column

CmAcmCaseFolder. The Column Definition Properties tab opens.
f. Record the value of the property Column Name.

3. Use your database tools to create the four-part index with the following form:
<case_folder_column, audit_sequence DESC, object_class_id,
source_object_class_id>. The audit_sequence field of the index must be
specified as DESCENDING.

4. Repeat this procedure for each target object store in your production
environment that uses IBM Case Manager solutions.

Configuring email notification:

You can optionally enable email notification of workflow activity. Users can
configure which notifications they want to receive and their preferred locale. For
example, users can choose to be notified when work is assigned or when work is
approaching or passes a deadline. Configure email notification on the workflow
server, in IBM Content Navigator, and in the Case Manager Client.

“Enabling notification in the Administration Console for Content Platform
Engine”
“Enabling notification in IBM Content Navigator” on page 102
“Enabling notification in Case Manager Client” on page 103

Enabling notification in the Administration Console for Content Platform Engine:

Before you can enable email notification on your Content Platform Engine system,
you must specify a language pack. You specify the language pack and enable
notification by using the Administration Console for Content Platform Engine.

About this task

When you configure your language pack, the language you choose should match
the default locale for the target object store. This locale value is specified on the
General tab. The default locale for a new system is English.
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Procedure

To enable email notification:
1. Log in to Administration Console for Content Platform Engine.
2. Expand Object stores, right-click your target object store, and click

Administrative > Workflow System..
3. Click the Language Packs tab, and click New.
4. Add your language pack.

a. Select your locale from the dropdown menu. The locale selection will auto
fill the date time mask.

b. Enter the Content Platform Engine template path. By default, the email
template directory is set to the English language directory, which is
<install_path>/IBM/FileNet/ContentEngine/tools/PE/msg/en.

5. Save your changes.
6. Configure the Remote Servers settings:

a. Click the Remote Servers tab.
b. Check the Enable email notification check box.
c. Enter the host name and port values for your SMTP server.
d. Enter an email ID as the sender of your notifications.
e. Enter the email login ID and password for the system user that logs into the

server and sends the notification.
f. Save your changes.

7. Click the Advanced tab.
8. In the server list, change the value for the CacheSyncFixupEmail setting to

false. The default value for this setting is true.
9. Save your changes.

Enabling notification in IBM Content Navigator:

You use the settings in IBM Content Navigator to enable email notifications
through the administration desktop for IBM Case Manager.

About this task

When you configure your language pack, the language you choose should match
the default locale for the target object store. This locale value is specified on the
General tab. The default locale for a new system is English.

Procedure

To enable email notification:
1. Log in to IBM Content Navigator as an administrator. Enter the following URL

in a browser:
http://server:port/navigator

server is the IBM Content Navigator server name or IP address.
port is the IBM Content Navigator port number.

2. Navigate to Repositories > Your target object store > General, and click
Connect.

3. In the Configuration Parameters tab, make sure that the Workflow connection
point field contains a valid value.
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4. Navigate to Desktops > Case Manager > Edit.
5. On the Appearance tab, Select Work as a feature, and make sure that the target

object store is specified as the default repository.
6. On the General tab, in the Additional Settings pane, select Enable this desktop

for FileNet P8 workflow email notification.
7. Save your changes.

Enabling notification in Case Manager Client:

After you enable notification for your system, you must set your notification
preferences in the Case Manager Client application.

About this task

The preferences in Case Manager Client control the destination address for email
notification. Each user or login user of Case Manager Client must configure an
email address in order to receive notification.

Procedure

To enable email notification in Case Manager Client:
1. Log in to the Case Manager Client by accessing the default IBM Case Manager

desktop from a browser: http://server_name:port/navigator/?desktop=icm
2. Open the Work view and click Preferences.
3. Enter the email address where you want to receive notifications.
4. Use the On radio buttons to select the events for which you want to receive

notification.
5. Save your changes.

Verifying the IBM Case Manager applications in the production environment:

After you configure your environment and deploy the applications, you can start
and verify the IBM Case Manager applications in the production environment.

Procedure

To verify the IBM Case Manager applications:
1. Verify the IBM Case Manager API deployment by accessing the following link

from a browser:

Environment Application URL

High availability http://virtual_server_name/CaseManager/
CASEREST/v1/info

Stand-alone or network deployment http://server_name:port/CaseManager/
CASEREST/v1/info

2. Log in to the IBM Case Manager administration client by accessing the
following link from a browser:

Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icmadmin
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Environment Application URL

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icmadmin

3. Log in to the Case Manager Client by accessing the default IBM Case Manager
desktop from a browser:

Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icm

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icm

Verify that your specified Lightweight Directory Access Protocol (LDAP) users
can log in to the Case Manager Client.

4. Click the help icon to test whether the Case Manager Client help system
displays content.

Related tasks:
“Verifying the IBM Case Manager applications in the development environment”
on page 95
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Extending your case management system

You can further enhance your case management solution by integrating forms,
additional rules, analytics, and logging and reporting.

“Integrating forms into your solution”
“Integrating with IBM Business Process Manager” on page 116
“Integrating IBM case analytics tools” on page 124
“Integrating with the IBM Case Monitor Dashboard” on page 129
“Integrating IBM Watson Explorer Analytical Components” on page 133
“Integrating with IBM Content Manager” on page 135
“Integrating with IBM Enterprise Records” on page 153
“Integrating with IBM Sametime” on page 154
“Integrating with Operational Decision Manager” on page 159
“Integrating with a version control system (VCS)” on page 164
“Integrating with Box” on page 170

Integrating forms into your solution
You can integrate IBM Forms with IBM Case Manager to use forms with your
solutions. Forms can provide customizable interfaces in the Case Manager Client
Form widget and automation features such as custom field formats, custom field
validation, and a calculation engine.

“Forms in solutions”
“Installing IBM Forms” on page 106
“Configuring IBM FileNet eForms for P8” on page 108
“Adding forms to your solution” on page 110
“Guidelines for designing a form to use in the Form widget” on page 112
“Unsupported features for forms in Case Manager Client” on page 114
“Form policies” on page 115

Related concepts:
 

Deployment overview
Related information:
 

Form widget

Forms in solutions
You can configure solutions to use the Form widget in place of the Properties
widget to enable case workers to view and edit the property values for a case or
for a step (work item).

For step (work item) properties, you can configure the Form widget to use a form
attachment. When the widget opens, it finds and displays a form that is located in
the target object store. After the case worker completes the step, a form data
document is saved as a case document in the case folder and is attached to the
step.
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The form data document can collect hundreds of details about many aspects a
case. To help manage a case, you can configure a form to extract key
decision-making information from the form data document. You then map this
subset of information to the case properties so that the information can be
displayed to case workers in the Form widget. Case workers can also view a
read-only version of the form by opening its form data document from either the
Documents view in the Case Information widget or from the Attachment widget.

For both case and step (work item) properties, you can configure the Form widget
to use a specific form template as an interface to collect data without saving a form
data document. Case workers can create a case or view and edit the property
values for a case or step. After a case worker completes the case or step, the
updated case data are mapped to case properties. A form data document is not
saved.

The Form widget is included by default on Add Case Form, Case Details Form,
Add Task Form, Work Details Form, and Form Attachment Work Details pages.

Restriction: The Form widget does not support policy-based forms.

Installing IBM Forms
You can integrate IBM Forms to add form templates and form data documents to
your IBM Case Manager solution. If you plan to use this integration, you must first
install IBM Forms in your IBM Case Manager environment.

Before you begin

Workplace XT is required to edit a policy-based form. If you plan to use Workplace
XT, ensure that Workplace XT is installed before you install IBM Forms. You must
be root user to install IBM Forms in an AIX environment.

About this task

The following diagram shows IBM Forms with IBM Case Manager in a highly
available environment.
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The IBM Forms server or server cluster is called by the IBM Case Manager server
or server cluster to provide electronic forms rendering capabilities and capture user
data into the form for storage in the IBM FileNet P8.

If there is a WebForm Translator server installed on a remote server, there is no
need to install it locally. Otherwise, user needs to select WebForm Translator
component besides installing the ICM Integrator.

Procedure

To install IBM Forms:
1. Find the IBM Forms compressed file for your operating system. Extract all of

the files and folders to a temporary directory on your system.
2. Double-click the appropriate executable file to start the IBM Forms server

installation program.
3. Select the installation language and click OK.
4. Click Next. Then, accept the license agreement.
5. After IBM Autonomic Deployment Engine is installed and configured, enter a

location for the server. Then, click Next.
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6. Select ICM Integrator from the list of available components and click Next. If
there is not a WebForm Translator server installed on a remote server, you must
select to install the WebForm Translator component too. The details for how to
install the WebForm Translator server can be found in the Webform Server 8
documentation.

7. On the Decisions panel, select ICM Integrator 5.3 for use with IBM Case
Manager V5.3.3 and click Next.

8. Provide the path to the installation location for IBM Case Manager and click
Next.

9. Click Install to complete the installation.

What to do next

Run both the Create Case Manager Applications and Deploy Forms Application
tasks in the IBM Case Manager configuration tool. If you integrate with IBM Forms
8.1 or earlier, restart the application server when you run the tasks on a
stand-alone server.

In a cluster or network deployment environment, run both the Create Case
Manager Applications and Deploy Forms Application tasks on the deployment
management server. If you integrate with IBM Forms 8.1 or earlier, you must also
run the tasks on each managed node and restart the application server cluster after
you run the tasks on the last node. If you integrate with IBM Forms 8.2 or later,
you do not need to run the tasks on the managed nodes or restart the application
server cluster.
Related reference:
“Configuration checklist” on page 31
Related information:
 

Webform Server 8 documentation

Configuring IBM FileNet eForms for P8
The FileNet P8 eForms application is included in the IBM Case Manager
installation. To complete the configuration, you must run the Deploy Forms
Application task in IBM Case Manager administration client.

Before you begin

Be sure to have your completed configuration checklist available.

About this task

The following diagram shows FileNet P8 eForms with IBM Case Manager in a
highly available environment.
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Tip: In general, FileNet P8 and IBM Case Manager are FIPS compliant. However,
FileNet P8 eForms is not FIPS compliant if it calls an external data server. If FIPS
compliance is required for your environment, ensure that FileNet P8 eForms does
not call an external data server or use IBM Forms instead of FileNet P8 eForms.

Procedure

To complete the FileNet P8 eForms configuration:
1. Run both the Create Case Manager Applications and Deploy Forms Application

tasks in the IBM Case Manager configuration tool. In a cluster or network
deployment environment, run the Create Case Manager Applications and
Deploy Forms Application tasks on the deployment management server. If you
are installing only FileNet P8 eForms and you are not installing IBM Forms,
you do not need to run this task on the managed nodes or restart the cluster or
managed nodes.

2. If you plan to use policy-based forms, review the “Form policies” on page 115
and follow the instructions that are provided at the following link: How
FileNet P8 eForms Integrates with Workplace.

Important: Workplace XT is required to edit a policy-based form.
Related reference:
“Configuration checklist” on page 31
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Adding forms to your solution
As a business analyst, you can integrate forms with your IBM Case Manager
application. Case workers can then use these forms to enter the data that is
required to complete tasks.

Before you begin

Create a form template by using one of the following applications:

IBM Forms
Use IBM Forms Designer to create a form template. To import a form that
was created with IBM Forms or to attach that form to a case, the form
must have the XFDD file extension. Additionally, you must select the
ITXFormTemplate class or one of its subclasses as the document class when
you import the form into Content Platform Engine.

IBM FileNet eForms for P8
Use FileNet eForms Designer to create a form template. A form template is
an ITX file. You must select the ITXFormTemplate class or one of its
subclasses as the document class when you import the form into Content
Platform Engine.

Fields are mapped to case or step parameters by name. To map a form template
field to a case or step parameter, name the field so that it matches the symbolic
name of the parameter. In the Case Manager Client, the form template field reflects
the settings of the associated case or step parameter. For example, if the parameter
is marked as read-only, a case worker can view, but not modify, the form field that
is associated with it.

After you design a form template, add it to the target object store.

Important: You must select the ITXFormTemplate class or one of its subclasses as
the document class when you import the form into Content Platform Engine. You
must save the form template file in the target object store or the form will not
work in your solution. If you must move files from the target object store for any
reason, such as resetting the test environment, be sure to back up all the form
objects and return them to the target object store after the reset is complete. To
prevent case workers from using the form template directly, instead of in the Form
widget, do not put the form template or form data document in a case folder.

If your solution is not deployed, use Case Manager Builder to deploy the solution
to the development environment.

Important: You cannot add an XFDD or ITX file by using Administration Console
for Content Platform Engine. Even if the add operation appears successful, the
resulting document will not work correctly as a form template. Using such a
document results in errors.

To add a form with an XFDD or ITX file extension to your solution, you must use
either IBM FileNet Workplace XT or IBM Content Navigator. You must add the
XFDD or ITX file to Content Platform Engine as an instance of the ITX Form
Template document class to ensure that the file is assigned the correct MIME type.

To use IBM Content Navigator to add an XFDD or ITX file, set the Display form
template class option to Yes on the Configuration Parameters tab for the relevant
target object store.
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About this task

Case Manager Client includes several pages that you can use as a case data page, a
step page, or a step launch page for a task that uses a form. These pages contain
the Form widget by default. You can also configure a custom page to use the Form
widget. You cannot include the Properties widget or the Attachments widget on
the page with the Form widget.

To enable case workers to view a form template or view and edit a form policy or
policy-based form data from the Case Document widget or Attachment widget,
make sure that Workplace XT is installed. In addition, you must install the
Workplace XT plug-in into IBM Content Navigator.

To enable case workers to add a form template from their local system into a case
folder or attachment, you must also enable showing the form template class in IBM
Content Navigator.

The Form widget supports two configuration options:

Use a specific form template
When you select this option, you specify a form template that is saved and
used in the Form widget each time the page is rendered. Because the form
template is always used in the configured page, you must create a new
page for each form template that you want to use in the solution.

To find out the value of the version series ID, you must go to Workplace
XT:
1. Right-click on a form template and select Show HyperLink in the

menu.
2. Click Show Released to see the URL of the released version of the form

template.

Within that URL, you can find the version series ID (vsId) parameter, for
example, vsId = %7BXXXXXXXXX%7D. The real vsID does not include
%7B, which is at the beginning of the parameter or %7D, which is at the
end of the parameter.

If you want to get the version ID of a specific version of the form template:
1. Click Select From Versions.
2. Select the version that you want to see the URL for that specific

version, for example, id=%7BAAF32605-11FD-43E4-B268-530282539035
%7D. The real ID is the value part without the %7B at beginning and
%7D at the end.

Use a form attachment
When you select this option, the Form widget automatically selects a form
attachment that is attached to the current task step each time the page is
rendered. Because the form is selected dynamically at run time, a single
page can use many different forms. Therefore, the page can be used
multiple times for different tasks in the solution.

You can also select this option to support a general-purpose form
processing task. For example, you create a task and configure a
corresponding page to use a Form widget that is configured with this
option. A launch step uses a page that contains the Properties widget and
the Attachments widget, and the user can attach a form data document to
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the task. Subsequent steps in the workflow can use the page that contains
the Form widget, which selects the form that you attached to the task in
the launch step.

Only a form template and form data that are generated from IBM Case
Manager can be rendered in the Form widget. Workplace XT policy-based
form data cannot be rendered in the Form widget. If you attach IBM Case
Manager based form data into the attachment, when it is rendered in the
Form widget the case property value is merged with the form field value.
If a case property is mapped to a form field, then the case property value
overwrites the form field value even though the case property value is
null. If a case property is not mapped to a form field, then the value in the
form field stays. If more than one form document is added into the
Attachment widget, then only the first form is used.

Procedure

To add a form to your solution:
1. In Case Manager Builder, edit the solution and go to the Pages tab.
2. Expand the Pages tab for your solution and find the Add Task Form page,

Work Details Form page, Form Attachment Work Details page, Add Case
Form page, Case Details Form page, or the custom step page that you want
to add.

3. Click Edit Settings in the Form widget. Configure the widget, then click OK
to save the widget settings in the page.

4. Repeat these steps for each page that you want to add to this solution.
5. Go to the Case Types tab, and open the case type to which you want to add

the pages.
6. In the Case Type page, you can select Form page as the default layout for the

Add Case Page or the Case Details Page.
7. In the Step Designer, click the step in the workflow.
8. In the Page_Layout field, enter the name of the page that you created in a

previous step.
9. In the Step Properties section, click the Edit icon (pencil) for the Attachments

field.
10. To select an attachment for a step, you must define the attachment by clicking

Manage Attachments.
11. Click OK.
12. Repeat these steps for each step that will display the form.
13. Validate your solution and save the changes.
14. Commit the changes and then redeploy your solution.

What to do next

In Case Manager Client, test the solution.
Related tasks:
 

Creating translated form templates for your case management application

Guidelines for designing a form to use in the Form widget
When you configure the Form widget to use a form attachment or form template,
you must design the form according to specific guidelines to ensure that form
content displays correctly.
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You can create the forms that are used by the Form widget by using IBM Forms or
FileNet P8 eForms. You can save the form to a Content Platform Engine object
store directly from IBM Forms or FileNet P8 eForms Designer.

You can then configure the Form widget by using one of the following methods:
v Configuring the Form widget to use a form template
v Configuring the Form widget to use a form attachment

Typically, you configure the Form widget to use a form template if you want to
take advantage of the enhanced interface features that the form provides and you
do not need to save form data documents each time that case or step properties are
updated. If you want to save form data documents each time that case or step
properties are updated, configure the Form widget to use a form attachment.

Tip: You do not need to create form policies, entry templates, and other
documents that are related to IBM Forms or FileNet P8 eForms. These objects are
not used in the Form widget implementation.

When designing a form, keep in mind that the attribute of a mapped case property
is combined with the attribute of a form field. A case property can have a default
value, and you can specify it as required or hidden. In a step, the case property
can be read only, editable, or so on. A form field has a default value and you can
specify that the form field is required, read only, and so on. When a case property
is mapped to a form field, the attributes are combined. For example, if a case
property is required, but the mapped form field is not required, then after
combining the case property is still required. Another example is if a case property
is editable, but the mapped form field is read only, then after mapping, the case
property rendered in the form field is read only.

Designing a form by using IBM Forms

When you configure the Form widget to use a form that was designed in IBM
Forms, the Form widget provides the following features that are not available in
the Properties widget:
v High-precision multi-page user interface definition
v Dynamically hiding controls, sections, or pages
v Customizable accessibility and data formatting
v Wizard-driven interaction pages
v Ability to embed scripts, web service calls, calculations, and custom controls
v Inclusion of file attachments and XML digital signatures within the form

Use the following guidelines when you design a form by using IBM Forms:
v Ensure that the form field name and type match the corresponding case

property field symbolic name and type. The widget maps the translated Name
property of the workflow data field to the public data name that is specified in
the form. This name is set in the Properties window when the form field is
made public.

Tip: When designing an IBM Forms template, the form field that is going to
map to case property has to be public.

v Design the form page layout to fit the expected dimensions of the widget.
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v Choose font styles and color styles that match the other widgets in your
environment. The Form widget renders these styles as they are defined in the
template.

v To use an open selection combination box, a multiselection list box, or a
multiselection check box group, map the form item to a single-valued case
property instead of a choice list case property. Put the choice list in the form
template.

v Use a column of a table item to map to an array case property.

Designing a form by using FileNet P8 eForms

When you configure the Form widget to use a form that was designed in FileNet
P8 eForms, the Form widget provides the following features that are not available
in the Properties widget:
v Customizable user interface
v Ability to embed scripts, calculations, and custom controls
v Multiple tabbed-page view
v Creation of high-resolution paper copies (PDF)

Use the following guidelines when you design a form by using FileNet P8 eForms:
v Ensure that the form field name and type match the corresponding case

property field symbolic name and type.
The widget maps the translated Name property of the workflow data field to the
Cell Name property or Display Name property in the form. The widget first
checks the translated Name property against the Cell Name property. If no
match is found, the widget checks the translated Name property against the
Display Name property.

v Set the page size of the form to fit in the expected dimensions of the widget.
v Use short page names so that the page tab labels are readable in the widget

view.
v Select font styles and color styles that match the other widgets in your

environment. The Form widget renders these styles as they are defined in the
template.

Related tasks:
 

Creating translated form templates for your case management application

Unsupported features for forms in Case Manager Client
When you design a form for use by the Form widget, be aware that Case Manager
Client does not support certain features that are available in IBM Forms, in FileNet
P8 eForms, or in the FileNet P8 platform.

Unsupported IBM Forms features

The Form widget does not support for the following IBM Forms features:

Form policies
The widget renders forms by using the form templates that are accessible
from IBM Content Navigator. It does not use form policies to render forms.

Unsupported FileNet P8 eForms features

The Form widget does not support for the following FileNet P8 eForms features:

114 Planning, Installation, and Upgrade Guide

http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.3.3/com.ibm.casemgmt.design.doc/acmdt032.htm


Form policies
The widget renders forms by using the form templates that are accessible
from IBM Content Navigator. It does not use form policies to render forms.

Certain Forms Designer features
The widget does not support the following features:
v Signature fields
v Picture fields

Accessibility
The widget does not provide an accessible form.

Restriction: You cannot use external properties or properties that are associated
with a task for forms in a case management solution. This limitation applies for
both IBM Forms and FileNet P8 eForms.

Unsupported FileNet P8 platform features

The Form widget does not support the following globalization features:
v Although the Form widget does support application of custom date and number

formats, it does not support globalized short, medium, long, and full date
formats.

v You can create a form for languages that are read right to left. However, the
Form widget does not automatically adapt the user interface layout based on the
browser language setting.

Form policies
IBM Case Manager provides support for policy-based form data documents for
reuse of existing content. You can use form policies to initiate new form-related
documents or launch form-related processes.

A policy-based form data document is a document that is connected to a document
form policy or a workflow form policy. Policy-based form data documents can be
added to a case as task attachments or as content in the case folder. Case workers
can use them to view or edit the form data in the case. Case workers can also open
the policy document to generate form data or launch a form workflow.

Workplace XT is required to integrate form policies in your solutions and to enable
editing of policy-based form data documents in a case. Use Workplace XT to add
form templates to the target object store, manage entry templates, and create and
manage form policies.

Policy-based form data documents are ignored by the Form widget when it selects
form attachments. If a policy-based form data document is attached to the task, the
widget skips the document.

Case workers can view policy-based form data documents in read-only format by
opening them from either the Documents page in the Case Information widget or
from the Attachment widget. The read-only format does not include additional
form policy actions or configuration such as sidebar content or custom toolbar
buttons. Case workers can edit policy-based form data documents by selecting the
Edit option from the context menu. The documents are displayed in a separate
browser window, and all form policy actions and configuration are available.
Related information:
 

Getting started with form policies
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Integrating with IBM Business Process Manager
By using IBM Business Process Manager with IBM Case Manager, you can take
advantage of the features that each product offers. For example, IBM Business
Process Manager provides a platform on which you can implement process
applications that involve human tasks or automated business processes. IBM Case
Manager provides a platform on which you can implement case tasks that require
case workers to act on decisions that are based on the context of documents and
other content objects.

Before you begin

In IBM Business Process Manager, you must create a Process Center profile and a
Process Server profile. For more information, see one of the following topics in the
IBM Business Process Manager documentation:
v On AIX: Configuring profiles and creating a network deployment environment
v On Linux: Configuring profiles and creating a network deployment environment
v On Windows: Configuring profiles and creating a network deployment

environment

After you create the profiles, you must configure LDAP settings, single sign-on
(SSO) and secure socket layer (SSL) support by completing the steps in
Implementing single sign-on to minimize web user authentications in the IBM
Business Process Manager documentation. The LDAP repository must be federated.

Tip: If you plan to use an LDAP server that is already configured for IBM Case
Manager, you do not need to complete the step that describes how to add the user
directory to the federated realm on the IBM Case Manager server. Also,
configuring SSL is optional for IBM Case Manager, but it is a best practice.

Important: Users can connect to IBM Business Process Manager only by using SSL.
Therefore, errors can occur if the SSL certificate is the default self-signed certificate,
but has not been imported into the appropriate places. To prevent these errors,
import the IBM Business Process Manager WebSphere Application Server SSL
certificate into the Content Platform Engine and the JVM for the IBM Case
Manager configuration tool. For information about importing the certificate, see
IBM Case Manager configuration tool returns an SSLHandshakeException error.

About this task

To configure your systems to work with IBM Case Manager solutions from within
IBM Business Process Manager, see the Building an IBM Case Manager Integration
service topic in the IBM Business Process Manager documentation.

The following diagram shows the architecture of IBM Business Process Manager
Advanced with IBM Case Manager in a highly available environment.
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When you design solutions, the IBM Business Process Manager Integration
Designer calls the Content Engine by using the Content Engine Web Services API
to read the solution definition and modify the XPDL file.

“Associating solutions with IBM Business Process Manager”
“Maintaining solutions that are associated with IBM Business Process Manager
process applications” on page 121
“Troubleshooting IBM Business Process Manager integration” on page 122

Related reference:
“Configuration checklist” on page 31
Related information:
 

IBM Business Process Manager documentation

Associating solutions with IBM Business Process Manager
In Case Manager Builder, you can associate your IBM Case Manager solutions with
IBM Business Process Manager automated business processes or with IBM Business
Process Manager process applications. An automated business process is a set of
business-related activities that are invoked to achieve a business goal. A process
application is a component that allows people and services to interact.

Before you begin

Be sure to have your completed configuration checklist available.

Procedure

To set up your configuration so you can associate solutions with IBM Business
Process Manager:
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1. In the LDAP directory, select a user account to use as the IBM Business Process
Manager integration user. The user must have the necessary privileges to start
and carry out any IBM Business Process Manager process that is used by IBM
Case Manager.

Tip: The IBM Business Process Manager integration user name and password
are required for the IBM Case Manager configuration tool tasks that integrate
IBM Business Process Manager with IBM Case Manager.
For more information about creating user accounts in IBM Business Process
Manager, see Administering users and groups in the IBM Business Process
Manager documentation.

2. In IBM Case Manager configuration tool, run the following tasks:
v Configure IBM Business Process Manager
v Deploy IBM Business Process Manager Integration Service

3. Build and deploy a solution.
“Creating a task that runs an IBM Business Process Manager process
application”
“Creating a task that runs an IBM Business Process Manager automated
business process” on page 119

Related reference:
“Configuration checklist” on page 31
Related information:
 

Authoring environments
 

BPEL processes and human tasks

Creating a task that runs an IBM Business Process Manager
process application
To associate an IBM Case Manager solution with a process application that is
created by using the IBM Business Process Manager Process Designer, create a task
in Case Manager Builder. Then, use IBM Business Process Manager to map the task
to one or more business process definitions.

Before you begin

Ensure that a process application is created in the IBM Business Process Manager
Process Center. Then, ensure that a snapshot of the process application is exported
to the IBM Business Process Manager Process Server. The name of the process
application must match the name of the IBM Case Manager solution.

If you run the process application in Process Server only, then you must make a
snapshot of the process application and designate it as the default snapshot. If you
run the process application in the Process Center, you do not need to designate a
default snapshot. Instead, the snapshot that was most recently activated in the IBM
Business Process Manager Process Admin Console is used by Case Manager
Builder.

About this task

The following diagram shows the component architecture of a system that
integrates IBM Business Process Manager with IBM Case Manager to enable IBM
Case Manager to invoke a business process from a task. The diagram also provides
an example of how IBM Business Process Manager process applications map to
IBM Case Manager solutions.
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The solution name must match the process application name.
More than one task can point to the same business process definition.

IBM FileNet P8 domain

Business process definition

IBM Business Process Manager

Process application

Object store

Task

Case type

Solution

Procedure

Create the task in Case Manager Builder by completing the steps in Adding an
IBM Business Process Manager process as a task.

What to do next

If a new snapshot becomes available for an IBM Case Manager solution, open the
solution in Case Manager Builder to automatically discover and bind the solution
to the new snapshot. Then, validate each case type that reuses the IBM Business
Process Manager task to ensure that the process mapping is valid. Correct any
mapping that is not valid, then save and redeploy the solution.
Related information:
Cannot access Process Designer from Case Manager Builder with Google Chrome
 

Managing installed snapshots
 

Authoring environments

Creating a task that runs an IBM Business Process Manager
automated business process
To associate a solution with an automated process that is created by using IBM
Business Process Manager Integration Designer, create a task in Case Manager
Builder. Then, use IBM Business Process Manager to map the task to a new
business process that implements the workflow for that task. The business process
is implemented as an external web service.

Procedure
1. Create and map the task in Case Manager Builder by completing the steps in

Adding an IBM Business Process Manager process as a task.
2. To expand the integration of business processes and cases, you can use the

WebSphere Adapter for Enterprise Content Management. This adapter enables
your business process to access objects, including case data and documents,
from an IBM FileNet P8 object store.
“Specifying credentials for a web service” on page 120
“Accessing case content from IBM Business Process Manager” on page 120
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Related information:
 

Authoring environments

Specifying credentials for a web service:

By default, the FileNet P8 Component Manager service user credentials are used
for authentication with a web service on IBM Business Process Manager. However,
you can use the Component Manager in Process Task Manager to configure
different credentials for the web service.

About this task

When you associate a task with a business process, Integration Designer adds a
partner link reference to the XPDL file for the solution. In the runtime
environment, the partner link reference identifies the business process that is to be
started when the task is started.

Important: SSL support in the FileNet P8 environment is a systemwide
configuration that governs all web service traffic into Process Engine. Therefore,
you must consider the ramifications on your overall system before you enable SSL.

Procedure

To specify different credentials for the web service:
1. In Process Task Manager, expand the Component Managers node and click the

connection point for the web service.
2. Click the Web Services tab and then click the Advanced tab in the Web

Services page.
3. Click Add.
4. Select the partner link reference for your web service.
5. Enter the user name and password that are to be used to access the web

service.
Related reference:
 

Security considerations

Accessing case content from IBM Business Process Manager:

You configure an automated process to access enterprise content, including case
content, in a Content Engine object store. To do so, you use the Enterprise Content
Management adapter that is provided in Integration Designer in IBM Business
Process Manager Advanced.

About this task

With WebSphere Adapter for Enterprise Content Management, you can create
integrated processes that include the exchange of information with a Content
Engine object store, without special coding. The adapter uses the open source
specification for content repositories called Content Management Interoperability
Services (CMIS).
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By using the adapter, your business process can send requests to the object store.
For example, your business process can create a new document in the object store,
update an existing document, or receive event notifications from the server when a
document is created or deleted.

For an IBM Case Manager solution, you do not need to use the WebSphere
Adapter for Enterprise Content Management to access case content. Instead, the
access to case documents is provided through the case type definition.
Related reference:
 

WebSphere Adapter for Enterprise Content Management documentation

Maintaining solutions that are associated with IBM Business
Process Manager process applications

When you copy or move a solution that is associated with an IBM Business
Process Manager process application, you must also copy or move the process
application.

“Copying IBM Case Manager solutions that are associated with IBM Business
Process Manager process applications”
“Moving IBM Case Manager solutions that are associated with IBM Business
Process Manager process applications” on page 122

Copying IBM Case Manager solutions that are associated with
IBM Business Process Manager process applications
When you copy an IBM Case Manager solution that is associated with an IBM
Business Process Manager process application, you must also copy the associated
IBM Business Process Manager process application.

About this task

You must complete these steps when you copy a solution, or when you create a
solution from a template.

Procedure

To copy an IBM Case Manager solution or create a solution from a template and
copy its associated IBM Business Process Manager process application:
1. In IBM Business Process Manager, clone the snapshot of the process application

that is associated with the solution or solution template.
2. Change the name of the cloned process application to match the name of the

new solution.
3. Create a snapshot of the cloned process application.
4. Install the snapshot on Process Server or activate the snapshot on the Process

Center server.
5. In IBM Case Manager, copy the solution package by using the IBM Case

Manager administration client or by using Case Manager Builder. When you
copy the solution, IBM Case Manager automatically updates the solution
definition file.

Important: If you copy the solution first, you must open and save the copied
solution after you clone and create the snapshot of the process application to
update the solution definition file.

6. Deploy the solution.
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Related information:
 

Adding and deploying a case management solution
 

Creating a solution from a template
 

Copying a solution to another development environment
 

Importing and exporting process applications
 

Managing snapshots

Moving IBM Case Manager solutions that are associated with
IBM Business Process Manager process applications
When you move an IBM Case Manager solution from one domain, server, or
environment to another, and it is associated with an IBM Business Process
Manager process application, you must also move the associated IBM Business
Process Manager process application.

Procedure

To move an IBM Case Manager solution and its associated IBM Business Process
Manager process application:
1. In IBM Business Process Manager, export the snapshot of the process

application that is associated with the solution.
2. In IBM Case Manager administration client, export the solution package from

the source environment.
3. In IBM Business Process Manager, import the process application snapshot to

the target IBM Business Process Manager environment.
4. In IBM Case Manager administration client, import the solution package to the

target environment.
5. Install the snapshot on Process Server, or activate the snapshot on the Process

Center server in the target IBM Business Process Manager environment.
6. Deploy the solution.
Related information:
 

Migrating a solution from one environment to another
 

Importing and exporting process applications
 

Managing snapshots

Troubleshooting IBM Business Process Manager integration
Troubleshoot typical errors that might surface when you integrate IBM Business
Process Manager with IBM Case Manager.

Related troubleshooting information

“Tasks are associated with the wrong snapshot of an IBM Business Process
Manager process application” on page 123
“Changes to IBM Business Process Manager process applications are not
reflected in tasks” on page 123
“Results output by IBM Business Process Manager are not shown in a task” on
page 123
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Tasks are associated with the wrong snapshot of an IBM
Business Process Manager process application
If an IBM Business Process Manager process application has multiple active
snapshots, Case Manager Builder might select the wrong snapshot to apply to
tasks.

Symptoms
Case Manager Builder applies identifier for the first active snapshot that is listed
for a process application in the IBM Business Process Manager Process Center. This
snapshot might not be the default snapshot for a task.

Resolving the problem
In IBM Business Process Manager, deactivate any unused snapshots. Ensure that
only one active snapshot is set as the default for the process application with
which a task is associated.

Related information

Deactivating snapshots on a Process Center server
 

Activating snapshots for use with Process Portal
 

Designating default snapshots

Changes to IBM Business Process Manager process applications
are not reflected in tasks
When an IBM Business Process Manager process application is changed, Case
Manager Builder does not automatically apply the changes to tasks. These changes
can include the creation of a new snapshot or the rollback to previous snapshot.

Symptoms
IBM Case Manager cannot invoke the IBM Business Process Manager process
application at run time because the event action subscription cannot access the new
snapshot ID from the IBM Business Process Manager server.

Resolving the problem
Whenever a change is made to the IBM Business Process Manager process
application, open and save all associated tasks in Case Manager Builder to pick up
the latest changes to the application. Then, redeploy the solution.

Related information

Administering IBM Case Manager tasks

Results output by IBM Business Process Manager are not shown
in a task
A task that is associated with an IBM Business Process Manager is updated based
on output results that are received by the Content Platform Engine server.

Symptoms
The task does not reflect updates that are made on the IBM Business Process
Manager server.

Causes
This problem occurs because the IBM Business Process Manager server does not
have the fully qualified path name to the Content Platform Engine server. As a
result, IBM Case Manager does not receive the callback function package that
contains the output results.
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Resolving the problem
When you run the Configure Profile task in the IBM Case Manager configuration
tool, ensure that you enter the fully qualified path in the Content Platform Engine
server name field.

Integrating IBM case analytics tools
Case analytics tools can help you monitor and manage your daily business
operations. The tools can also provide historical trend information that enables you
to adjust future operations as needed. This information can help you discover new
business patterns and trends, and to identify new business opportunities.

About this task

The following tools use the data that is extracted by the Case Analyzer services
from case management solutions:
v IBM FileNet Case Monitor
v Case Analyzer Excel Reports
v Cognos Business Intelligence

With the data extracted by Case Analyzer services, you can generate real-time
reports and historical data analysis by analyzing case, task, and workflow events.
The Case Analyzer component integrates with Cognos Business Intelligence to
provide web-based analytic and reporting capabilities. It also supports using
Microsoft Excel as a thick client-based analytic and reporting solution.

IBM FileNet Case Monitor provides the capability to collect and report on
case-specific events and metrics. It integrates with IBM Cognos Real-time
Monitoring.

The following diagram shows these case analytic tools integrated with IBM Case
Manager in a highly available environment.
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For a high availability environment, you must install IBM Cognos Real-time
Monitoring the same way on both a primary and secondary node. Each installation
must be on separate physical servers. Only the primary node is started. An HTTP
load balancer or proxy is used to detect which node is active and automatically
directs user traffic to the active node. If the active node is offline, the passive node
is started and is automatically detected by the load balancer.

The Case Analyzer service, which is a background task in the Content Platform
Engine, collects data from the workflow system event logs and the object store
audit log. The service stores the information in a database that is used by IBM
Cognos Real-time Monitoring and Cognos Business Intelligence reports.

“Using Case Analyzer with OLAP integration” on page 126
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“Integrating with IBM Case Monitor and IBM Cognos Real-time Monitoring”
on page 128

Using Case Analyzer with OLAP integration
Case Analyzer, a component of IBM Case Foundation, reads data from both
workflow and Content Platform Engine event logs. Analytical data from both
sources is published to a common Case Analyzer database. To support case
management systems, new metrics that are related to cases and tasks were added
to Case Analyzer, formerly known as FileNet Process Analyzer.

About this task

For reporting on Cases and Tasks that are currently active the Case Analyzer
provides Cases In Progress and Tasks In Progress cubes. The Cases In Progress
cube has metrics for case-related details, such as the current case count and the
average age of cases. Tasks in Progress metrics can provide details such as current
task count, wait time, processing time, and task age.

For historical reporting and analysis, the Case Analyzer provides Case Load and
Task Load cubes. Case Load metrics can provide details, such as outgoing and
incoming case numbers and average completion time for the various time periods.
Task Load metrics provide details such as incoming and outgoing task numbers,
and average wait time, ready time, processing time, and completion time for the
various time periods.

To use the values of case, task, and workflow data fields in case analytic reports,
you must identify which data fields will be exposed, specify their properties as
dimensions or measures, and specify the appropriate OLAP cube to store the data.
The values for case, task, and workflow data fields, which come from the Content
Platform Engine and the workflow system, are stored in the Case Analyzer
database.

You can view the Case Analyzer reports in the following formats:
v Microsoft Excel reports available when you install the Case Analyzer client
v Reports in the Cognos Business Intelligence console.

“Case Analyzer OLAP integration using Cognos Business Intelligence”
“Integrating with Case Analyzer to create Microsoft Excel reports” on page 127

Related information:
 

Manage Case Analyzer data fields

Case Analyzer OLAP integration using Cognos Business
Intelligence
The Cognos Business Intelligence integration can provide historical analytics for
case trends and patterns. For example, you can get data on the average time to
complete cases or business tasks during a specific time interval. You can also find
the number of cases that were created, that are currently active, or that are
complete during a specific time interval.

Before you begin

You must install the Cognos Business Intelligence software and the Case Analyzer
software and databases.
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About this task

This task provides a high level view of the configuration steps. Use the detailed
instructions in the Case Analyzer documentation and the Cognos Business
Intelligence documentation to ensure successful configuration.

Procedure

To configure integration with Case Analyzer
1. Set up the OLAP integration by installing and configuring Case Analyzer.
2. Use the audit configuration wizard in the IBM Case Manager administration

client to enable auditing of the desired case and task properties.
3. Use the FileNet Process Task Manager to configure the Case Analyzer settings.

In the Content Engine properties, for the Object Store Name, enter the name of
the IBM Case Manager target object store. For more information, see
Configuring Case Analyzer components.

4. Move the report templates to the Cognos Business Intelligence server, and use
the Cognos Business Intelligence administration console to set up Case
Analyzer reporting. For more information, see Configure Cognos Business
Intelligence project for Case Analyzer.

Related tasks:
 

Preparing a database for the case history store
Related information:
 

Installing and configuring Case Analyzer

Integrating with Case Analyzer to create Microsoft Excel reports
The client software provided with Case Analyzer provides Microsoft Excel
reporting. After you install and configure the Case Analyzer client, you can
customize the reports and publish them to the web.

Before you begin

Install the Case Analyzer software and databases.

About this task

This task provides a high-level view of the configuration steps. Use the detailed
instructions in the Case Analyzer documentation to ensure successful
configuration.

Procedure

To configure integration with Case Analyzer so that you can create Microsoft Excel
reports:
1. Set up the OLAP integration by installing and configuring Case Analyzer.
2. Use the audit configuration wizard in the IBM Case Manager administration

client to enable auditing of the desired case and task properties.
3. Use the FileNet Process Task Manager to configure the Case Analyzer settings.

In the Content Platform Engine properties, for the Object Store Name, enter the
name of the IBM Case Manager target object store. For more information, see
Configuring Case Analyzer components.
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4. Install the Case Analyzer client. The Client system must have Microsoft Excel
and Microsoft SQL Server software installed. You can choose to install the Case
Analyzer client with the IBM Case Foundation installation. For more
information, see Installing IBM Case Foundation.

5. Use the tasks in the IBM Case Analyzer user guide to configure, create, use,
and publish your reports. During the configuration, you must also configure
access to the Case Analyzer OLAP database. For more information, see
Configuring Excel Reports for Case Analyzer.

Related tasks:
 

Preparing a database for the case history store
Related information:
 

Installing and configuring Case Analyzer

Integrating with IBM Case Monitor and IBM Cognos Real-time
Monitoring

IBM Case Monitor integrates with Cognos Real-time Monitoring to provide a view
of the current business activities. The updated Case Monitor objects that you
import into Cognos Real-time Monitoring provide views of data that are specific to
case management systems.

Before you begin

To use IBM FileNet Case Monitorwith your case management application, you
must install both Case Analyzer and Cognos Real-time Monitoring. Install the IBM
Cognos Real-time Monitoring software on a server in your environment.

About this task

Cognos Real-time Monitoring provides the dashboard and workbench that you use
to gather and display meaningful business metrics. You can use the Cognos
Real-time Monitoring Workbench to define the queries that retrieve data about
cases and workflows. You can use Cognos Real-time Monitoring Dashboard to
view predefined dashboards and dashboard objects (charts) that display the data
from the active cases and workflows.

IBM Case Monitor provides the set of objects that you import into Cognos
Real-time Monitoring to monitor cases, tasks, workflows, and work items. After
you import Case Monitor objects, you can use them as is, or you can customize
them.

You can customize the monitoring and set up thresholds and alerts as needed. For
example, you can monitor the following information:
v The number of active cases, tasks, work items, and workflows
v The number of active cases and tasks in each state
v The average age of active cases and tasks
v The average processing time for active work items and workflows
v The average time that tasks spend in each state
v The average idle time for active work items
v The average total processing time for active work items
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Monitoring and tracking enables you to review volume, find and eliminate
bottlenecks, and ensure that operations are working efficiently and effectively.

This task provides a high level view of the configuration steps. Use the detailed
instructions in the Case Monitor documentation and the IBM Cognos Real-time
Monitoring documentation to ensure successful configuration.

Procedure

To configure integration with IBM Case Monitor and IBM Cognos Real-time
Monitoring:
1. Install and configure Case Analyzer. For more information, see Installing and

configuring Case Analyzer in the FileNet P8 documentation.
2. Install and configure IBM Cognos Real-time Monitoring. For more information,

see Real-time Monitoring Installation and Configuration in the IBM Cognos
Real-time Monitoring documentation.

3. Configure Case Monitor. For more information, see Case Monitor configuration
in the FileNet P8 documentation.

4. Use the audit configuration wizard in the IBM Case Manager administration
client to enable auditing of the desired case and task properties.

5. Expose case properties to the Case Analyzer store that you want to monitor or
add to a dashboard. For more information see Manage Case Analyzer data
fields in the FileNet P8 documentation.

6. Configure and customize data fields for reporting by using the IBM Cognos
Real-time Monitoring Workbench application. For more information, see Basic
Case Monitor functionality in the FileNet P8 documentation.

7. Customize the reporting interface, and monitor reporting results by using the
IBM Cognos Real-time Monitoring Dashboard. For more information, see
Advanced Case Monitor functionality in the FileNet P8 documentation.

Related tasks:
 

Preparing a database for the case history store
Related information:
 

IBM FileNet Case Monitor

Integrating with the IBM Case Monitor Dashboard
You can use the IBM Case Monitor Dashboard to view of business activity data
that is specific to case management systems. This dashboard, which is an IBM
Content Navigator desktop, provides a dashboard that displays widgets that show
case and task activity across solutions. You can use this data to review volume,
find and eliminate bottlenecks, and ensure that operations are working efficiently
and effectively.

About this task

The IBM Case Monitor Dashboard retrieves data about the solutions that are
deployed to a target object store from the Case Analyzer store that you configure
for that object store. In the dashboard, users can switch between Case Analyzer
stores to obtain information about solutions in different target object stores.

Important: By default, any user who has access to the target object store has access
to the IBM Case Monitor Dashboard.

Extending your case management system 129

http://www.ibm.com/support/knowledgecenter/SSNW2F_5.5.0/com.ibm.p8.installingpa.doc/bpmia000.htm
http://www.ibm.com/support/knowledgecenter/SSNW2F_5.5.0/com.ibm.p8.installingpa.doc/bpmia000.htm
http://www.ibm.com/support/knowledgecenter/SSLU3P_10.1.0/com.ibm.swg.im.cognos.install.10.1.0.doc/install.html
http://www.ibm.com/support/knowledgecenter/SSNW2F_5.5.0/com.ibm.p8.prmonitor.doc/gs_get_started.htm
http://www.ibm.com/support/knowledgecenter/SSNW2F_5.5.0/com.ibm.p8.pe.taskmgrui.doc/pa_data_fields.htm
http://www.ibm.com/support/knowledgecenter/SSNW2F_5.5.0/com.ibm.p8.pe.taskmgrui.doc/pa_data_fields.htm
http://www.ibm.com/support/knowledgecenter/SSNW2F_5.5.0/com.ibm.p8.prmonitor.doc/bas_overview.htm
http://www.ibm.com/support/knowledgecenter/SSNW2F_5.5.0/com.ibm.p8.prmonitor.doc/bas_overview.htm
http://www.ibm.com/support/knowledgecenter/SSNW2F_5.5.0/com.ibm.p8.prmonitor.doc/adv_overview.htm
http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.3.3/com.ibm.casemgmt.design.doc/acmdt037.htm
http://www.ibm.com/support/knowledgecenter/SSNW2F_5.5.0/com.ibm.p8.prmonitor.doc/_start_here_bam.htm


Procedure

To configure the IBM Case Monitor Dashboard:
1. In the IBM Case Manager configuration tool, edit and run the Register the IBM

Case Monitor Widgets Package task.

Important: If you run this task in a cluster environment, you must ensure that
the plug-in is loaded on each node of the cluster. Either restart the cluster to
force the plug-in to be loaded on all nodes or manually load the plug-in on
each node by using the IBM Content Navigator administration client.

2. Optional: In IBM Content Navigator, change the refresh interval, time unit, and
color scheme for the IBM Case Monitor Dashboard Plug-in.
The refresh interval determines how often the IBM Case Monitor Dashboard is
to retrieve information from the Case Analyzer store and refresh the chart
widgets. By default, the dashboard refreshes the chart widgets every 300
seconds. Setting the refresh time to 60 seconds or less affect performance
negatively.
The time unit determines whether time values in the dashboard are displayed
in days, hours, or minutes.

3. Configure a Case Analyzer store for each target object store that you want to
monitor. For more information, see “Configuring the IBM Case Monitor
Dashboard” on page 132.
“IBM Case Monitor Dashboard pages”
“Configuring the IBM Case Monitor Dashboard” on page 132
“Troubleshooting the IBM Case Monitor Dashboard” on page 132

IBM Case Monitor Dashboard pages
The IBM Case Monitor Dashboard includes a set of pages that display the chart
widgets. Each page displays the activity for a specific type of case artifact such as
cases or tasks.

“Case dashboard page”
“Task dashboard page” on page 131

Case dashboard page
The case dashboard page displays chart widgets that provide case-related statistics.
The data is retrieved for all cases within a specified Case Analyzer store that
processes data from the Content Platform Engine logs on the target object store.
You can switch to different Case Analyzer stores as needed.

The case dashboard page contains the following widgets:

Cases in Progress widget
This widget displays a bar graph in which each bar shows the number of
cases that are active for a case type. When you hover on a bar in the
graph, a tooltip displays the case type name and the number of cases in
progress.

Cases in Each State widget
This widget displays a pie chart shows the proportion of active cases each
of three states: initializing, working, and failed. When you hover on a
sector of the pie, a tooltip displays the number of cases in that state.

Average Age of Cases widget
This widget displays a bar graph in which each bar shows the average age
of active cases for a case type. The average age is calculated by adding the
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elapsed time for each case and dividing by the number of cases. When you
hover on a bar in the graph, a tooltip displays the case type name and the
average age.

Average Elapsed Time of Completed Cases widget
This widget displays a line graph that shows the average elapsed time for
each case type of the cases that completed in the current calendar quarter.
When you hover on a point in the line, a tooltip displays the case type
name and the average elapsed time of completed cases.

Incoming and Outgoing Cases in Current Quarter widget
This widget displays a bar graph in which two bars show the number of
cases that opened and closed in the current calendar quarter for a case
type. When you hover of a bar in the graph, a tooltip indicates whether the
bar represents incoming or outgoing cases. The tooltip also displays the
case type name and the number of incoming or outgoing cases.

Task dashboard page
The task dashboard page displays chart widgets that provide task-related statistics.
The data is retrieved for all tasks within a specified Case Analyzer store that
processes data from the Content Platform Engine logs on the target object store.
You can switch to different Case Analyzer stores as needed.

The task dashboard page contains the following widgets:

Tasks in Progress widget
This widget displays a bar graph in which each bar shows the number of
tasks that are active for a task type. When you hover on a bar in the graph,
a tooltip displays the task type name and the number of tasks in progress.

Tasks in Each State widget
This widget displays a pie chart shows the proportion of active tasks in
each of four states: failed, ready, waiting, and working. When you hover
on a sector of the pie, a tooltip displays the number of tasks in that state.

Average Age of Active Tasks widget
This widget displays a bar graph in which each bar shows the average age
of active tasks for a task type. The average age is calculated by adding the
elapsed time for each task and dividing by the number of tasks. When you
hover on a bar in the graph, a tooltip displays the task type name and the
average age.

Average Elapsed Time of Active Tasks by State widget
This widget displays a bar graph in which each bar shows for a task type
the average elapsed time of active tasks in a particular state. The bars are
grouped by the four states: failed, ready, waiting, and working. When you
hover on a bar in the graph, a tooltip displays the task type name, task
state, and the average elapsed time of that task type in particular state.

Incoming and Outgoing Tasks in Current Quarter widget
This widget displays a bar graph in which two bars show the number of
tasks that opened and closed in the current calendar quarter for a task
type. When you hover on a bar in the graph, a tooltip indicates whether
the bar represents incoming or outgoing tasks. The tooltip also displays the
task type name and the number of incoming or outgoing tasks.

Average Elapsed Time of Completed Tasks
This widget displays a line graph that shows the average elapsed time for
each task type of the tasks that completed in the current calendar quarter.
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When you hover on a point in the line, a tooltip displays the task type
name and the average elapsed time of completed tasks.

Configuring the IBM Case Monitor Dashboard
The IBM Case Monitor Dashboard is a separate IBM Content Navigator desktop
that is included in the IBM Case Manager installation. To complete the
configuration, you must configure a Case Analyzer store and register the plug-in.

Procedure

To configure the IBM Case Monitor Dashboard:
1. Prepare the database for the Case Analyzer store. For more information, see

Database administrator installation tasks.
a. Create JDBC data sources. Run the Configure JDBC Data Sources task by

using the IBM FileNet P8 Configuration Manager. For more information, see
Editing the Configure JDBC Data Sources tasks and Configuration Manager
reference.

b. Create a database connection. For more information, see Creating a database
connection. Based on performance considerations, you might want to share
data sources. For more information, see Sharing data sources. You enter the
database schema name when you configure and enable the Case Analyzer
store by using the IBM Case Manager administration client.

2. Create the Case Analyzer store:
a. Log in to the IBM Case Manager administration client.
b. Under the domain, expand Object Stores and click the target object store in

which you want to create the Case Analyzer store.
c. Click New Case Analyzer Store and enter the information for the new

store.
You can also create a Case Analyzer store by using Administration Console for
Content Platform Engine. However, the administration console provides many
options that are not used in IBM Case Manager.

3. Log in to the IBM Case Manager configuration tool and run the Register the
Case Monitor Widgets Package task to add the IBM Case Monitor Dashboard
desktop to IBM Content Navigator:

Troubleshooting the IBM Case Monitor Dashboard
You can troubleshoot problems with the IBM Case Monitor Dashboard by
appending a debugging parameter to the URL that Is used.

The debugging parameter that you use depends on what you are troubleshooting:
v To troubleshoot the IBM Case Monitor Dashboard source code only, append the

&debugmonitor parameter the URL as shown in the following example:
http://server:9080/navigator/?desktop=icmmonitor&debugmonitor=true

v To troubleshoot the IBM Case Monitor Dashboard and Case Manager Client
dependency source code, append the &icmdebug parameter the URL as shown in
the following example:
http://server:9080/navigator/?desktop=icmmonitor&icmdebug=true

v To troubleshoot the ICase Manager Client and IBM Content Navigator
dependency source code for IBM Case Monitor Dashboard, append the &debug
parameter the URL as shown in the following example:
http://server:9080/navigator/?desktop=icmmonitor&debug=true
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Integrating IBM Watson Explorer Analytical Components
IBM Watson Explorer Analytical Components provides unstructured analytics
based on textual pattern discovery. The IBM Watson Explorer Analytical
Components integration with IBM FileNet P8 is extended to include a crawler that
is specific to case management solutions.

Before you begin

Before you complete this task, install the IBM Watson Explorer Analytical
Components software on a server in your environment.

About this task

The IBM Watson Explorer Analytical Components crawler for case management
solutions can be configured with filters to include or exclude specific objects, such
as case type, document class, file extension, or document name pattern.

The crawler also indexes cases for specific properties, for example, name, state,
creation date, or comments. You can specify which properties to index in the IBM
Watson Explorer Analytical Components administration console.

You configure a collection in IBM Watson Explorer Analytical Components by
specifying the location of the content source, parameters for discovery, and
parameters for content analysis. You can then use the IBM Watson Explorer
Analytical Components content analytics miner application to explore the analyzed
content, discover unexpected correlations between words and phrases, and see
which words and phrases occur frequently in many cases.

You can use multiple views to explore the analyzed content from different
perspectives. For example, you might want to explore trends or deviations in the
data, or you might want to look for connections between cases by exploring
correlation and frequency values through two facets at the same time.

As you explore a collection and view the results, you can iteratively fine tune your
query, zoom in on particular items of interest, and expand or narrow the set of
case documents that you want to focus on.

Procedure

To configure IBM Watson Explorer Analytical Components for IBM Case Manager:
1. Install the Content Engine Client software on the IBM Watson Explorer

Analytical Components crawler server. For more information, see Configuring
the crawler server to support Case Manager and FileNet P8 crawlers.

2. In the IBM Watson Explorer Analytical Components administration console,
create a collection for your IBM Case Manager content. For more information,
see Creating a collection.

3. In the IBM Watson Explorer Analytical Components administration console,
create the Case Manager crawler. To create the crawler, you run a wizard that
helps you identify the content that you want to crawl, or analyze, as well as
additional settings such as security options. For more information, see Case
Manager crawlers.

4. Set up text analysis rules. This task is usually performed by a business analyst
or subject matter expert who determines how the text will be analyzed. For
more information, see Analytic resources and content analytics.
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5. Set up a schedule for running the Case Manager crawler. For more information,
see Crawler schedules.

6. After the crawler runs, use the content analytics miner application to view,
query, and analyze the collected, indexed data. For more information, see
Analyzing content.
“Installing IBM Watson Explorer Analytical Components”

Installing IBM Watson Explorer Analytical Components
IBM Watson Explorer Analytical Components is a tool for crawling and
interactively analyzing the text and metadata of documents and content objects.
IBM Watson Explorer Analytical Components provides a specific IBM Case
Manager Crawler, which can be used to analyze case comments in a case
management system. IBM Watson Explorer Analytical Components is a separate
installation and configuration from IBM Case Manager.

About this task

The following diagram shows IBM Watson Explorer Analytical Components with
IBM Case Manager in a highly available environment.
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Procedure

To install IBM Watson Explorer Analytical Components:

Follow the installation and configuration instructions that are provided at the
following link: Installing Watson Explorer Content Analytics.

Integrating with IBM Content Manager
By integrating IBM Content Manager with IBM Case Manager, you can use
documents that are stored in IBM Content Manager in your case management
solution. IBM Content Manager becomes the repository for the documents that are
attached to cases and tasks.

About this task

By integrating IBM Content Manager with IBM Case Manager, your solution can
incorporate the following features:
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Case processing
You can create cases, add documents to cases, and delete documents from
cases in IBM Case Manager based on actions that are done on IBM Content
Manager items.

When you configure a solution to use an IBM Content Manager item type,
certain events are associated with the item type. These associations are
called event subscriptions. As a caseworker works with a document or
item in that item type, appropriate actions are triggered in IBM Case
Manager. For example, you can configure a solution so that when a
caseworker creates a document with an IBM Content Manager item type, a
new case is created in IBM Case Manager.

Proxy objects
Integrating with IBM Content Manager creates a system of proxy objects
that enables the coordination between IBM Content Manager documents
and IBM Case Manager cases.

In IBM Content Manager, the proxy object represents the case folder. For
each case folder in IBM Case Manager, there is a proxy object in IBM
Content Manager. This proxy object does not include any user properties.
Instead, the proxy object contains the following properties that identify the
case folder in IBM Case Manager:
v Case ID
v Case folder GUID
v Initiating document ID
v Object store symbolic name
v Solution name
v Case type
v Case folder name

In IBM Case Manager, the proxy object is a proxy document that represents
a document or a folder. For each document or folder in IBM Content
Manager, the proxy object in IBM Case Manager contains an external
reference to IBM Content Manager and no user properties.

The creation, modification, and deletion of these proxy objects is done
through event handlers in both the IBM Content Manager and IBM Case
Manager systems.

Important: Integrate with IBM Content Manager if your solution requires the
ability to update documents in the IBM Content Manager repository based on case
events. If your solution does not require this ability, consider configuring your
solution to use IBM Content Manager as an external repository. For information
about configuring external repositories, see “Connecting and configuring additional
repositories” on page 53.

The following diagram shows the component architecture of a system that
integrates IBM Content Manager with IBM Case Manager.
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You could also use a single WebSphere Application Server instance where IBM
Case Manager, the IBM Content Manager resource manager application, and the
IBM FileNet P8 Content Engine are all on the same machine.

Restrictions:

v IBM Case Manager solutions are specific to the content management repository
in which the solution was created. A solution from an IBM FileNet Content
Manager repository cannot run in an IBM Content Manager repository, and a
solution from an IBM Content Manager repository cannot run in an IBM FileNet
Content Manager repository.

v Case operations are not supported when you integrate IBM Case Manager with
IBM Content Manager.
“Comparison of access to documents in an IBM Content Manager repository”
on page 138
“Preparing the IBM Content Manager server” on page 139
“Configuring access to Content Platform Engine” on page 142
“Integrating IBM Content Manager with IBM Case Manager” on page 144
“Known limitations and differences for IBM Content Manager” on page 145
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Comparison of access to documents in an IBM Content
Manager repository

There are two ways in which you can provide case workers with access to
documents in an IBM Content Manager repository. You can integrate with IBM
Content Manager to make that repository the primary storage for case documents.
Alternatively, you can use an IBM Content Manager repository as the primary
storage and configure access to IBM Content Manager as an external repository.

These approaches provide different levels of access to the documents in a IBM
Content Manager repository The following table summarizes support each
approach provides for specified IBM Case Manager features.

IBM Case Manager feature
Integration with IBM
Content Manager

IBM Content Manager as an
external repository

Initiate a case when a
document is created

Supported Not supported

Copy a document property to
case property

Partial support Not supported

Search for existing
documents

Supported Supported

File or unfile a document in a
case

Supported Supported

Check a case document in or
out

Supported Supported

View or retrieve a case
document

Latest version Latest version

Update a document property
from IBM Case Manager

Supported Supported

Delete a document from IBM
Case Manager

Supported Supported

Delete a case document from
the IBM Content Manager
system

Supported Not supported

Start a task when a document
is added to a case

Supported Not supported

Access documents from
multiple IBM Content
Manager systems

Not supported Supported

Case History Filing and unfiling
documents are recorded

Filing and unfiling documents
are recorded

File documents in case
subfolders

Not supported Supported

Include documents from any
CMIS repository into Case
along with IBM Content
Manager

Not supported Supported

In addition to the differences in feature support, IBM Content Manager integration
requires you to set up an IBM Content Manager event monitor. The event monitor
is not required if you use IBM Content Manager as an external repository.
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Preparing the IBM Content Manager server
Ensure that the IBM Content Manager server is at the correct version level for
integration with IBM Case Manager. Also, install the Content Engine client on the
IBM Content Manager server and set up three IBM Content Manager user IDs.

Procedure

To configure your IBM Content Manager server for integration with IBM Case
Manager:
1. If you have not already done so, install and set up your IBM Content Manager

environment.
In addition to an IBM Content Manager production server, set up a
development or test server to use when you design solutions.
Typically, your test server mirrors the production server that your solution will
use. Import any item types that will be reused in your solution into the test
server. You can also create new item types in the test server that will later be
imported into the production server.

Restriction: You cannot create item types in Case Manager Builder. Instead,
reuse the item types that were created in IBM Content Manager. Proxy
document objects are created in IBM Case Manager to represent the reused item
types.

2. Ensure that the IBM Content Manager system is at Version 8.4.3 Fix Pack 1 or
later.
Version 8.4.3 Fix Pack 1 performs the following tasks to support integration
with IBM Case Manager:
v Adds new database tables to the library server for event subscription and

processing specific to IBM Case Manager.
v Installs the case event handler on your IBM Content Manager system.
v Updates the event monitor for IBM Case Manager integration.

3. Install the Content Platform Engine client on the IBM Content Manager server
where the system administration client resides and where the case event
handler will be run.

Important: Install the version of the Content Platform Engine client that is used
by IBM Case Manager.
The Content Platform Engine client is required by the case event handler so
that IBM Content Manager can communicate with the IBM Case Manager
server.

4. Configure LDAP integration and import LDAP users for IBM Content Manager:
a. Configure LDAP integration to ensure that IBM Content Manager and IBM

Case Manager use the same LDAP server.
b. Create the following privilege sets to configure IBM Content Manager

document security for IBM Case Manager users:
v ICMCasePrivAll

v ICMCaseViewOnly

For information on creating these privilege sets and assigning users to them,
see Requirements and best practices for configuring IBM Content Manager
to work with IBM Case Manager.
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Best practice: Ensure that the application server LDAP configurations for
the IBM Content Manager server and the Content Platform Engine server
are identical and that they use the same LTPA key. You also need this
security information when you configure the IBM Content Navigator and
IBM Case Manager servers.

5. Ensure that the following IBM Content Manager IDs are created and that they
have the permissions that are required for use with IBM Case Manager:
v icmadmin

v icmconct

v icmintid

6. Enable single sign-on in the Content Manager EE library server.
7. Be sure to use the ICM$NAME attribute when you define item types in IBM

Content Manager.
If you do not use the ICM$NAME attribute, IBM Content Navigator displays a
blank name for the document.
“User IDs and privilege sets for IBM Content Manager integration”

User IDs and privilege sets for IBM Content Manager integration
To integrate IBM Content Manager with IBM Case Manager, you must set up
certain user IDs and privilege sets in the IBM Content Manager environment.

User IDs

IBM Case Manager uses the following user IDs to log on to IBM Content Manager:

Table 14. IBM Content Manager IDs that are required by IBM Case Manager

User ID Description

icmadmin This IBM Content Manager administration ID represents a super user or a
library server administrator. By default, the ID for this user is icmadmin.

You specify the credentials for this ID when you run the Configure IBM
Content Manager Host Properties task in the IBM Case Manager
configuration tool.

IBM Case Manager uses this ID one time to log in to IBM Content Manager
and create the ICMPROXYFDRS item type that is used for the proxy case
folders. This item type includes attributes and event subscriptions that are
required for IBM Case Manager.

The icmadmin credentials are not stored in IBM Case Manager.

icmconct This IBM Content Manager shared database connection ID is used to
connect to the database server. By default, the ID for this user is icmconct.

You specify the credentials for this ID when you run the Configure IBM
Content Manager Host Properties task in the IBM Case Manager
configuration tool.

IBM Case Manager uses this ID to connect to the IBM Content Manager
database to enable single sign-on from Case Manager Client.

The icmconct credentials are encrypted and stored in the Content Platform
Engine connection object.
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Table 14. IBM Content Manager IDs that are required by IBM Case Manager (continued)

User ID Description

icmintid This IBM Content Manager integration ID is used specifically for IBM Case
Manager. By default, the ID for this user is icmintid.

You assign ICMIntPrivSet privilege set to this integration ID.

You specify the credentials for this ID when you run the Configure IBM
Content Manager Host Properties task in the IBM Case Manager
configuration tool.

IBM Case Manager stores this ID in the Content Platform Engine
connection object for use by the IBM Case Manager REST API and the
Content Platform Engine event handlers.

The icmintid credentials are encrypted and stored in the Content Platform
Engine connection object.

Privilege sets

IBM Case Manager users who work with objects that are stored in the IBM
Content Manager repository must have IBM Content Manager privileges to work
with those objects. The most efficient way to assign only the required privileges is
to create the following custom privilege sets for the IBM Case Manager users.

Table 15. IBM Content Manager privilege sets that are required by IBM Case Manager

Privilege set Description

ICMCasePrivAll You assign the following privileges to this
privilege set:

v All the privileges from the system-defined
ClientTaskAll privilege group

v The AllowTrustedLogon privilege

v The SystemQueryUserPrivs privilege

You assign case users who need read and
write access to IBM Content Manager
documents to the ICMCasePrivAll privilege
set. For example, in production environment,
you can assign case administrators and case
workers to this privilege set. In the
development environment, you can assign
all case users to this privilege set.

ICMCaseViewOnly You assign the following privileges to this
privilege set:

v All the privileges from the system-defined
ClientTaskView privilege group

v The AllowTrustedLogon privilege

v The SystemQueryUserPrivs privilege

You assign case users who need read-only
access to IBM Content Manager documents
to this privilege set. For example, in the
production environment, you can assign case
viewers and case initiators to this privilege
set.
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Table 15. IBM Content Manager privilege sets that are required by IBM Case
Manager (continued)

Privilege set Description

ICMIntPrivSet You assign the following privileges to this
privilege set:

v All the privileges from the system-defined
ClientTaskAll privilege group

v The SystemSuperDomainAdmin privilege

You assign the icmintid user ID to this
privilege set.

Configuring access to Content Platform Engine
To access Content Platform Engine documents in your case management system,
you must create a user account that is used by IBM Content Manager to access
case data in Content Platform Engine. You must also configure access to the Proxy
Document class that is used to represent IBM Content Manager documents in the
IBM Case Manager environment.

Before you begin

Before you configure access to Content Platform Engine, ensure that the following
tasks are complete:
v IBM Case Manager V5.3.3 or later is installed.
v The development environment is configured by running the required tasks in

the IBM Case Manager configuration tool.
v The connection to your LDAP server is configured in IBM Content Navigator.

You must use the same configuration settings that you used for IBM Content
Manager.

v The user account that the IBM Content Manager case event handler uses to
access Content Platform Engine exists in the LDAP. By default, the user ID for
this account is cm8intid.

Important: You must use the same LDAP for IBM Case Manager, IBM Content
Manager, and Content Platform Engine.

Restriction: You cannot create multiple project areas when you are integrating
with IBM Content Manager. You must use the default project area.

Procedure
1. Log on to IBM Administration Console for Content Platform Engine as an

object store administrator.
2. Click the target object store, and then click Data Design > Classes > Document

> CM8 Proxy Document to open the property sheet for the CM8 Proxy
Document class.

3. On the Security tab, click Add. Add the cm8intid user to the Selected Users
and Groups list and set the security as follows in the Permissions area:
a. In the Permission type list, click Allow.
b. In the Apply to list, click This object and all children.
c. In the Permission group list, click View properties.
d. Ensure that the following check boxes are selected:
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v View all properties

v Create instance

v Read permissions

e. Optional: Delete the #AUTHENTICATED-USERS ACE from the list of
ACEs. If you delete the #AUTHENTICATED-USERS ACE, you must repeat
these steps to add case workers or groups. Assign these users the View
properties level with View all properties right and the Read permissions
right selected.

4. On the Default Instance Security tab, click Add. Add the cm8intid user to the
Selected Users and Groups list and set the default security as follows in the
Permissions area:
a. In the Permission type list, click Allow.
b. In the Apply to list, click This object only.
c. In the Permission group list, click View properties.
d. Ensure that the following check boxes are selected:

Table 16.

Option Selected check boxes

For users who require rights to view
comments on cases

v View all properties

v Read permissions

For users who require rights to view and
add comments to cases

v View all properties

v Link a document/Annotate

v Read permissions

5. Add the cm8intid user to your master user group or, alternatively, to the target
object store users group. For information on adding users, see Update object
store with new users and groups.

6. Configure the Solution Deployments folder to give the cm8intid user access
rights to case objects in the Content Platform Engine:
a. In the navigation for the target object store node, click Root Folder > IBM

Case Manager > Solution Deployments.
b. On the Security tab, click Add. Add the cm8intid user to the Selected Users

and Groups list and set the security as follows in the Permissions area:
v In the Permission type list, click Allow.
v In the Apply to list, click This object and all children.
v In the Permission group list, click Modify properties.

7. After IBM Case Manager solutions are deployed in the target environment in
the production domain, grant the cm8intid user Create rights privileges to the
rosters of your solutions. Roster permissions are assigned in the Process
Configuration Console.

Important: This step is required only in the production domain. If you grant
cm8intid user Create rights privileges to the rosters of your solutions in the
development domain, you will break the security.

Related tasks:
“Installing and configuring IBM Case Manager” on page 45
Related information:
 

Configuring the roster to enable launching task workflows
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Integrating IBM Content Manager with IBM Case Manager
To access IBM Content Manager documents in your case management system, you
must configure IBM Case Manager by running several tasks in the IBM Case
Manager configuration tool.

Procedure

To integrate your IBM Case Manager environment with IBM Content Manager:
1. If IBM Content Manager uses an Oracle database, verify that the Oracle JDBC

driver (ojdbc6.jar) is on the IBM Case Manager server, then edit the
ICM_install_home/configure/configuration/config.ini file to ensure that the
oracle.driver.location element is set to the full path of the driver.

Important: Even if Content Platform Engine is not using an Oracle database,
the Oracle JDBC driver (ojdbc6.jar) must be installed on the Content Platform
Engine application server and the application server environment variables
must be updated to include a reference to the driver.

2. In the IBM Case Manager configuration tool, run the Configure IBM Content
Manager Host Properties task.

Important: The default instance security for the IBM Content Manager
Integration Data custom object in Content Platform Engine uses the security for
the object store (Full Control for object store administrators and Use Object
Store for users). If you have sensitive data in your development environment or
users change the default security, you might want to secure the custom object
by configuring an ACL for it.
v The ACL must give owner, read, and write access to the administrator who

runs the IBM Case Manager configuration tool.
v The ACL must give read access to all other accounts.
v Case Manager Builder requires read access to the Content Engine custom

object to connect to the IBM Content Manager development host.
This access enables Case Manager Builder to discover item types that are
defined on the IBM Content Manager development host and reuse them in
the solution. Case Manager Builder is not run in the production environment,
so only the IBM Case Manager configuration tool needs access to the custom
object in the production environment.

3. Complete the IBM Content Manager system administration tasks that are
required to establish communication between IBM Case Manager and IBM
Content Manager. For more information, see Modifying the event monitor,
event handler, and case event handler settings.
“Configuring the Oracle JDBC driver for integration with IBM Content
Manager”

Configuring the Oracle JDBC driver for integration with IBM
Content Manager
If you are using Oracle as your IBM Content Manager database, you must
configure the Oracle JDBC Driver in the WebSphere Application Server profiles for
the IBM Case Manager REST API and Content Platform Engine.

Procedure

To configure the Oracle JDBC driver, make the following changes in the IBM Case
Manager REST API profile and Content Platform Engine profile:
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1. In WebSphere Application Server, click Environment > WebSphere variables.
2. Ensure that the ORACLE_JDBC_DRIVER_PATH variable contains the correct

path to the Oracle JDBC driver ojdbc6.jar file.
For IBM Case Manager, the full path for this file is <WAS_Home>/jdbcdrivers/
Oracle/ojdbc6.jar.
If Content Platform Engine uses an Oracle database, you must use the
ojdbc6.jar file to set the Oracle JDBC driver for Content Platform Engine.
Although Content Platform Engine also supports the ojdbc5.jar file, the
ojdbc6.jar file is required to enable Content Platform Engine to communicate
with the IBM Case Manager Oracle database.

3. Add the path to the Oracle JDBC driver to the JVM classpath field:

Operating system JAR file path

AIX ${ORACLE_JDBC_DRIVER_PATH}/ojdbc6.jar

Linux ${ORACLE_JDBC_DRIVER_PATH}/ojdbc6.jar

Linux for System z ${ORACLE_JDBC_DRIVER_PATH}/ojdbc6.jar

Windows ${ORACLE_JDBC_DRIVER_PATH}\\
ojdbc6.jar

Known limitations and differences for IBM Content Manager
Resetting the test environment, deploying solutions, and other tasks that you do in
IBM Case Manager require additional steps or have limitations when you use IBM
Content Manager as a document repository.

“Resetting the test environment with IBM Content Manager”
“Deploying the solution to the production environment for IBM Content
Manager” on page 150
“Item types in Case Manager Builder” on page 150
“IBM Content Manager metadata name is displayed by using the IBM Case
Manager server locale” on page 150
“Item reindexing for IBM Content Manager” on page 151
“Folders” on page 152
“Wildcard characters and search” on page 152
“Project areas” on page 152
“Case history for IBM Content Manager documents” on page 153

Resetting the test environment with IBM Content Manager
You can use the Case Manager Builder Reset Test Environment feature to remove
the deployed solutions and other data from the development environment project
area. This feature removes the deployed solutions and cases from your FileNet P8
development environment. It also removes the IBM Content Manager proxy case
folders and the documents filed in them. Additionally, it removes event
subscriptions for any IBM Content Manager item types that are reused in solutions
deployed to the project area that is associated with an IBM Content Manager
library server.

About this task

When you reset the test environment for IBM Case Manager by clicking Reset Test
Environment, this action removes the proxy case folder objects and their filed
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documents from your IBM Content Manager test repository. However, it does not
remove documents that are not instances of the IBM Content Manager item types
that are reused for solutions.

To remove these objects, you must do several tasks manually in IBM Content
Manager.

You must be a system administrator and a database administrator for IBM Content
Manager to complete these tasks.

Procedure

To complete the IBM Content Manager steps that are required to remove the
unused objects:
1. Export the item types in the IBM Content Manager test system as an XML file:

a. Log in to the IBM Content Manager system administration client.
b. Export the item types as an XML file. If the item types in the IBM Content

Manager test system do not exist in the IBM Content Manager production
system or if they were changed in the IBM Content Manager test system
so that the data model objects are not synchronized with the objects in the
production system, then to preserve the data in the item types, you must
export them. When you export item types, you can also export dependent
objects such as item type attributes.

2. Stop the resource manager application from the WebSphere Application Server
administrative console.

3. Remove the configuration for IBM Content Manager components:
a. Log in as the root user or administrator on the library server.
b. Run the following command to start the configuration wizard:

IBMCMROOT/bin/config_CM. IBMCMROOT is the default installation location
for IBM Content Manager. For example, the default location is
/opt/IBM/db2cmv8/ for AIX and C:\Program Files\IBM\db2cmv8 for
Windows.

c. Select Remove configuration. Then, select Library server to remove the
configuration for the library server database. If the resource manager
database and resource manager application are installed on the same
machine, select Resource manager database and Resource manager
application.

d. Follow the instructions in the configuration wizard to complete the steps
to remove the configuration of components.

e. If the resource manager database and application are installed on a
different machine, log in as the root user or administrator of the resource
manager machine and repeat these steps to remove the configuration on
the machine for the resource manager.

4. Drop the library server database and resource manager database:
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Option Description

The library server and resource manager
databases are on the same machine.

1. On the library server machine, log in as
the library server database administrator
ID. The default library server
administrator ID is icmadmin.

2. Enter the following commands to drop
the databases:

v For a DB2® database, open a DB2
command-line window and enter the
following commands:

db2 force applications all
db2 drop db ls_db_name
db2 drop db rm_db_name

ls_db_name is the name of the library
server database and rm_db_name is the
name of the resource manager
database. The default name of the
library server database is icmnlsdb. The
default name of the resource manager
database is rmdb.

v For an Oracle database, start the
database in restrict mode and bring it
in mount state. Then, enter the
following commands:

sqlplus / as sysdba
shutdown immediate;
startup restrict mount;
drop database;
exit
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Option Description

The library server and resource manager
databases are on different machines.

1. Drop the library server database:

a. On the library server machine, log in
as the library server database
administrator ID. The default library
server administrator ID is icmadmin.

b. Enter the following commands to
drop the database:

v For a DB2 database, open a DB2
command-line window and enter
the following commands:

db2 force applications all
db2 drop db ls_db_name

ls_db_name is the name of the
library server database. The default
name of the library server database
is icmnlsdb.

v For an Oracle database, start the
database in restrict mode and bring
it in mount state. Then, enter the
following commands:

sqlplus / as sysdba
shutdown immediate;
startup restrict mount;
drop database;
exit

2. Drop the resource manager database:

a. On the resource manager machine, log
in as the resource manager database
administrator ID. The default resource
manager database administrator ID is
rmadmin.

b. Enter the following commands to
drop the database:

v For a DB2 database, open a DB2
command-line window and enter
the following commands:

db2 force applications all
db2 drop db rm_db_name

rm_db_name is the name of the
resource manager database. The
default name of the resource
manager database is rmdb

v For an Oracle database, start the
database in restrict mode and bring
it in mount state. Then, enter the
following commands:

sqlplus / as sysdba
shutdown immediate;
startup restrict mount;
drop database;
exit
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5. Remove data from the resource manager staging area:
a. Log in to the resource manager machine as the root user or with an ID

that has privileges to delete directories and files.
b. Delete all files in the staging area. An example path for the staging area on

a Windows machine is C:\staging.
c. Delete all files and directories in the hard disk collection. An example

location is the file system volume LBOSDATA. On Windows, an example
path is C:\lbosdata.

6. If you are using Oracle as your IBM Content Manager database, you must
create the Oracle databases for the IBM Content Manager library server and
resource manager.

7. Add the configuration for IBM Content Manager components:
a. Log in as the root user on the library server machine.
b. Run the following command to start the configuration wizard:

IBMCMROOT/bin/config_CM. IBMCMROOT is the default installation location
for IBM Content Manager. For example, the default location is
/opt/IBM/db2cmv8/ for AIX and C:\Program Files\IBM\db2cmv8 for
Windows.

c. Select Add configuration if other IBM Content Manager components are
still installed on this machine.

d. Select Library server to add the configuration for the library server
database. If the resource manager database and resource manager
application are installed on the same machine, select Resource manager
database and Resource manager application.

e. Follow the instructions in the configuration wizard to complete the steps
to add the configuration of components.

f. If the resource manager database and application are installed on a
different machine, log in as the root user of the resource manager machine
and repeat these steps to add the configuration on the machine for the
resource manager.

8. Start the resource manager application from the WebSphere Application Server
administrative console.

9. Import the exported item types back into the IBM Content Manager test
system:
a. Log in to the system administration client.
b. Import the item types and other data model objects from the XML file into

the IBM Content Manager system.
c. Because the Reset Test Environment feature removes all event

subscriptions from the item types, you must manually add the event
subscriptions back into the item types after you reimport them.

Tip: Any IBM Case Manager event descriptions are added when the
solution is redeployed, so you do not need to add them manually.

10. Log in to the IBM Case Manager configuration tool and rerun the Configure
IBM Content Manager Host Properties task to bootstrap the IBM Content
Manager test system.

11. Re-configure the security for the cm8intid user. During the reset of the test
environment the Content Platform Engine security is restored to the original
state.
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Deploying the solution to the production environment for IBM
Content Manager
After you complete the development and initial testing of a case management
solution, you can deploy the solution to a Content Platform Engine production
object store to make the solution available for your case workers. The IBM Case
Manager administration client does not package IBM Content Manager items types
for deployment. Therefore, if you are using a IBM Content Manager repository for
your solution, you must export any new or modified item types from your test
repository and then import them to your production repository.

Procedure

To deploy item types from a IBM Content Manager test repository to a IBM
Content Manager production repository:
1. Ensure that your production environment is configured for integrating IBM

Content Manager with IBM Case Manager. For more information, see the
following topics:
v “Preparing the IBM Content Manager server” on page 139
v “Integrating IBM Content Manager with IBM Case Manager” on page 144

2. Use the IBM Content Manager system administration client to export the item
types and their attributes from the test repository to an XML file. For more
information, see Exporting data as XML.

3. Import the item types from the XML file to the IBM Content Manager
production repository. For more information see, Importing data.

4. Deploy the solution from development environment to the production
environment. For more information, see Deploying migrated solutions.

5. Configure security for production environment. For more information, see
Configuring security for IBM Content Manager solutions

Item types in Case Manager Builder
Items types are the IBM Content Manager equivalent of the document classes that
are used in IBM Case Manager. You associate item types with a solution to
organize and classify the IBM Content Manager documents that belong to a case.

Unlike document classes, you cannot create item types in Case Manager Builder.
Instead, you must reuse item types that were created in IBM Content Manager.

You cannot modify a reused item type in Case Manager Builder. Properties of a
reused item type are not displayed in Case Manager Builder, and you cannot add
new properties to the reused item type.

Deleting an item type from a IBM Content Manager repository does not delete it
from IBM Case Manager. You must use Case Manager Builder to delete the item
type from each solution in which it is used and then redeploy the solution.

IBM Content Manager metadata name is displayed by using the
IBM Case Manager server locale
When IBM Content Manager metadata name is displayed in Case Manager Builder
or Case Manager Client, the metadata name does not use the locale that is set for
the browser. Instead, the metadata name is displayed by using the locale of the
IBM Case Manager server.
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Item reindexing for IBM Content Manager
You can create an event subscription in IBM Content Manager so that you are
notified when an item is reindexed.

Reindexing an item moves that item from the source item type to the target item
type. The event that is generated depends on the event subscription:
v If the target item type has an event subscription for the REINDEX event, then

the reindex to an item type event will be generated.
v If the source item type has an event subscription for the REINDEXFROM event,

then the reindex from an item type event will be generated.

Restriction: You cannot reindex an IBM Content Manager item that is attached to
a task or an IBM Business Process Manager process in IBM Case Manager.
Reindexing the item breaks the task or process.

Reindex an item event

Tip: The reindex an item event is displayed as Add To Item Type in the IBM
Content Manager system administration client.

For the reindex an item event, the case event handler first verifies that the target
item type is used in the solution.

If the target item type is used in the solution but the source item type is not, the
case event handler uses the item ID of the original document to search the case
folders on the IBM Case Manager server for a proxy document that corresponds to
the document that was reindexed:
v If the handler does not find the proxy document, the handler creates a new

proxy document under the document class that corresponds to the new item
type name. If this new item type is configured to initiate a new case, the handler
creates a new case instance and files the proxy document in the folder for that
case. If this new item type is configured as a precondition to initiate a new task,
the handler creates a new task.

v If the case event handler finds the proxy document, the handler updates the
values of the PID and document class of the proxy document to match the
values of the reindexed item. If the target item type is configured to initiate a
new case, the reindexed document does not initiate the new case because the
document is already in an existing case.

If the target item type is not used in case management, no action is taken and the
event is marked as processed in the event monitor database queue.

Reindex from an item event

Tip: The reindex from an item event is displayed as Remove From Item Type in
the IBM Content Manager system administration client.

For the reindex from an item event, the case event handler first verifies that the
source item type is used in the solution.

If the source item type is used in the solution, the case event handler finds the
proxy document on the IBM Case Manager server and updates the values of the
PID and document class of the proxy document to match the values of the
reindexed item.
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If the case event handler does not find the proxy document, the handler creates a
proxy document under the document class that corresponds to the new item type
name.

Folders
You can define an IBM Content Manager item type so that a new case is created
automatically when a document of that item type is created. When you open the
new case folder in Case Manager Client, you can see the document filed in the
Home folder.

You cannot define subfolders

You cannot define subfolders for a case type from Case Manager Builder. You
cannot view or perform any other actions on such a subfolder in Case Manager
Client.

You can do only limited actions with folders

You cannot click on any IBM Content Manager folders in Case Manager Client.

You can right-click an IBM Content Manager folder in the Attachments widget to
display a pop-up menu that contains only the following actions: Properties,
Remove Attachment, and Refresh.

No pop-up menu is available for IBM Content Manager folders in the Documents
view of the Case Information widget.

Document not displayed in case folder

When a document that is part of a case is reindexed by using an IBM Content
Manager client such as eClient or IBM WEBi, you might not see the document in
the case folder. Restarting the IBM Content Management Interoperability Services
for Content Manager web application from your IBM WebSphere Application
Server administrative console should fix this issue.

Wildcard characters and search
If you are using a Content Platform Engine object store that supports content-based
searches, you can use a question mark (?) as a single-character wildcard in your
queries. If you are using a IBM Content Manager repository, the ? wildcard
character is not supported. However, you can use the asterisk (*) as a
multiple-character wildcard.

Project areas
To limit the effects of resetting the test environment, you can define a project area.
You can assign solutions and users to a project area, and later remove the project
area without interrupting other users in the development environment.

If you are using IBM Content Manager, you can define only one project area.
Related tasks:
Creating new project areas
Related information:
 

Creating new project areas
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Case history for IBM Content Manager documents
Typically, all events that are performed on case documents are recorded in the case
history. However, not all events performed on IBM Content Manager documents
are recorded. The case history from Case Manager Client contains entries only for
the following events on these documents: Case File, Case Unfile, and Document
Delete.

Tip: You can ignore the properties update events on IBM Content Manager
documents because they are generated by IBM Content Manager document
creation or reindex. These property updates are not for IBM Content Manager
document property update.

Integrating with IBM Enterprise Records
You can declare IBM Case Manager documents as records. To use IBM Enterprise
Records with IBM Case Manager, you must connect the IBM Enterprise Records
system and the IBM Case Manager system to the same object store.

About this task

By integrating IBM Enterprise Records with IBM Case Manager, your solution can
incorporate the following features and benefits:
v Documents in a case can be declared as records. The record is stored in the IBM

Enterprise Records file plan object store.

Important: When you manually declare a record from the search results in IBM
Content Navigator and this document is already attached to a case, you must
search for the document and declare it as a record from the search results. You
cannot browse for the document.

v A source document that was declared as a record can be added to a case because
the record object store on the IBM Enterprise Records system is also configured
as the target object store on the IBM Case Manager system.

v The IBM Enterprise Records and IBM Case Manager applications can exist on
the same application server. However, coexistence is not required.

v The IBM Enterprise Records system and the IBM Case Manager system must use
the same object store.

v When you configure your IBM Enterprise Records system and your IBM Case
Manager system at the same time and connect to the same object store, all
documents that are added to the target object store can be declared as records.

Procedure

To integrate IBM Enterprise Records with IBM Case Manager:
1. Install and configure IBM Case Manager.
2. Install and configure IBM Enterprise Records.
3. Create an object store that is configured as both a target object store and a

record object store.
4. Optional: Declare source documents in your cases on IBM Case Manager as

records from the search results in IBM Content Navigator.
“Known limitations for IBM Enterprise Records” on page 154

Related tasks:
“Installing and configuring IBM Case Manager” on page 45
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Related information:
 

IBM Enterprise Records Installation and Upgrade
 

Creating the IBM Enterprise Records Object store configuration profile and
running the profile tasks
 

Declare records

Known limitations for IBM Enterprise Records
Integrating IBM Case Manager with IBM Enterprise Records has several
limitations.

Limitations

The following limitations apply when you integrate IBM Case Manager with IBM
Enterprise Records:
v You cannot declare a record directly from IBM Case Manager.
v There is no support for configuring a file plan object store as a target object store

or a source object store.
v You must configure a single object store for both applications as a place to store

the source documents. You must create a single object store and configure it as a
target object store on IBM Case Manager and as a record-enabled object store
(ROS) on IBM Enterprise Records.

v When a source document is declared as a record, the security of the record is
controlled by IBM Enterprise Records, overriding any security settings in your
case.

v You cannot determine whether a source document has been declared as a record
from the IBM Case Manager user interface.

v To declare a document that is already attached to a case as record, you must
search for the document in IBM Content Navigator and then declare it as a
record from the search results. You cannot browse for the document.

Tip: If you use the traditional IBM Enterprise Records client, search for the
record in Workplace XT.

Integrating with IBM Sametime
You can integrate IBM Sametime® capabilities with Case Manager Client. With IBM
Sametime integration, case workers can check whether other workers who are
involved in a case are logged in to the application. They can chat with other case
workers in an instant messaging window by using the IBM Sametime web
interface.

About this task

Restriction: IBM Case Manager supports IBM Sametime integration for users who
are upgrading from an earlier version of IBM Case Manager that was integrated
with IBM Sametime. You can get more information about IBM Case Manager
support for IBM Sametime from the Software Product Compatibility Report. For
information about generating this report, see “System requirements” on page 10
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For IBM Sametime integration, client requests on the IBM Content Navigator
server are communicated through an HTTP proxy to the IBM Sametime proxy
server, and then to the IBM Sametime server. You should have all servers on the
same local area network (LAN).

IBM Sametime integration does not require a thick client installation on the user
desktop. Chat services are connected with the rest of the case management
components through a single sign-on (SSO) configuration in WebSphere
Application Server.

The following diagram shows IBM Sametime with IBM Case Manager in a highly
available environment.

“Installing and configuring the IBM Sametime integration”

Installing and configuring the IBM Sametime integration
You can install and configure IBM Sametime to enable chat services in Case
Manager Client. To prepare for IBM Sametime integration, you must install and
configure a Lotus® Domino® server, an IBM Sametime community server, and an
IBM Sametime proxy server. You must also configure single sign-on (SSO) between
your WebSphere Application Server for IBM Case Manager and the Lotus Domino
server.

Sametime Proxy server

WebSphere

Application Server

Network Deployment

cluster

Sametime

Community

Server

cluster

HTTP/HTTPS

Browser

HTTP/HTTPS

Hardware

load

balancer HTTP/HTTPS
HTTP/HTTPS

Hardware

load

balancer

HTTP/HTTPS

DNS

load

balancer

IBM Case Manager

Hardware

load

balancer

Java API/IIOP

EJB/IIOP

Content storage

(Files)

Content Search Services farm

(Index area)

Content Platform Engine

farm

DB2, Oracle, or SQL Server

(Data)

JDBC

HTTP/HTTPS

SOAP/HTTP/HTTPS
JDBC

Extending your case management system 155



About this task

Important: The IBM Connections profile in the IBM Connections plug-in for IBM
Sametime is provided only as a sample. Additional configuration and resources are
needed for the IBM Connections profile portion of the plug-in. For more
information, see the following developerWorks article: Expand Your IBM Case
Manager System – Integrating with IBM Sametime.

Procedure

To install and configure IBM Sametime integration:
1. Install the IBM Sametime server version 8.5.2 Interim Feature Release 1

(8.5.2IFR1). For complete instructions, see Administering Sametime Standard
8.5.2 Interim Feature Release 1 documentation.
a. Install IBM Sametime Domino server. For an AIX or Linux installation, see

Installing a Domino server on AIX, Linux, or Solaris . For a Windows
installation, see Installing a Domino server on Windows.

b. Install the Notes® client and the Domino administrator client. For more
information, see Installing the Notes client and Domino administrative
client.

c. Install the IBM Sametime community server. For more information, see
Installing a community server on AIX, Linux, Solaris, or Windows.

d. Install the IBM Sametime proxy server. For more information, see Installing
a Lotus Sametime Proxy Server.

e. Record the names of the of the IBM Sametime server and the IBM Sametime
proxy server to use when you configure your case management system.

f. Configure SSO. For more information, see Enabling Single Sign-on.
2. Confirm that SSO is enabled for your servers. Confirm that SSO is enabled on

both the Lotus Sametime server and the case management server.
a. In the WebSphere administration console, navigate to Security > Global

Security > Web and SIP security > Single sign-on (SSO) and ensure that
the following settings are selected:
v Enabled

v Interoperability Mode

v Web inbound security attribute propagation

b. In Domain name, specify the IBM Sametime server domain. For example,
you might enter a server domain such as ibm.com.

Tip: The IBM Sametime server and IBM Case Manager server must be in
the same domain as specified in the Domain name field. For example,
lotus.ibm.com and ecm.ibm.com are part of the ibm.com domain. However,
if you specify lotus.ibm.com as the IBM Sametime server domain and
ecm.ibm.com as the IBM Case Manager, SSO will not work between the two
machines. You must use the common part of the domain name, ibm.com, to
establish SSO.

c. Save any changes and restart WebSphere Application Server. If you did not
make any changes, you do not need to restart WebSphere Application
Server.

3. Install the IBM Ajax proxy server to the WebSphere Application Server that is
running the IBM Case Manager and IBM Content Navigator services. Configure
the proxy-config.xml file in the IBM Ajax proxy service.
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For WebSphere Application Server V8.5.0 or later, the AjaxProxy.war file is
available in the $WAS_HOME\installableApps folder (for example,
C:\IBM\WebSphere\AppServer\installableApps ).
For earlier versions of WebSphere Application Server, the AjaxProxy.war file is
available in the $WAS_HOME\web2mobilefep_1.1\installableApps\AjaxProxy
folder (for example, C:\IBM\WebSphere\AppServer\ web2mobilefep_1.1\
installableApps\AjaxProxy). If you are using WebSphere Application Server
V8.0 or earlier, you must install the Web 2.0 and Mobile Feature Pack. You can
download this feature pack from the following web page: http://
www.ibm.com/software/products/en/web2mobile
a. Install the AjaxProxy.war file as a web application on the WebSphere

Application Server that is running the IBM Case Manager and IBM Content
Navigator services. Use AjaxProxy as the context root. You can find the
AjaxProxy.war file in the WebSphere Feature Pack for Web 2.0.

b. Edit the proxy-config.xml file that is included in the AjaxProxy.war file
with the following changes:
v For security, remove the default mapping for any URL by removing or

commenting out the following two lines:
<proxy:mapping contextpath="/http/*">
<proxy:mapping contextpath="/https/*"/>

v Add the following proxy mapping to the IBM Sametime server URL.
Replace 9082 with the port number of your IBM Sametime server.
<proxy:mapping contextpath="/http/SametimeServer.yourCompany.com:9082/*">

v Allow forwarding only for the IBM Sametime server by adding the
following code to the proxy-config.xml file. Replace the URL with the
URL of your IBM Sametime server. This code sets the proxy mapping to
pass cookies and headers and to maintain states.
<proxy:policy acf="none" basic-auth-support="true"

url="http://SametimeServer.yourCompany.com:9082*">
<proxy:actions>

<proxy:method>GET</proxy:method>
<proxy:method>HEAD</proxy:method>
<proxy:method>POST</proxy:method>

<proxy:method>PUT</proxy:method>
<proxy:method>DELETE</proxy:method>

</proxy:actions>
<proxy:cookies>

<proxy:cookie>LtpaToken</proxy:cookie>
<proxy:cookie>LtpaToken2</proxy:cookie>
<proxy:cookie>loginName</proxy:cookie>
<proxy:cookie>sid</proxy:cookie>
<proxy:cookie>selectorMap</proxy:cookie>
<proxy:cookie>headUpdaterWindowName</proxy:cookie>
<proxy:cookie>UnicaNIODID</proxy:cookie>
<proxy:cookie>x-Q-App-Context</proxy:cookie>
<proxy:cookie>flushedId</proxy:cookie>
<proxy:cookie>JSESSIONID</proxy:cookie>

</proxy:cookies>
<proxy:headers>

<proxy:header>User-Agent</proxy:header>
<proxy:header>Accept*</proxy:header>
<proxy:header>Content*</proxy:header>
<proxy:header>Authorization*</proxy:header>
<proxy:header>X-Method-Override</proxy:header>
<proxy:header>Set-Cookie</proxy:header>
<proxy:header>If-Modified-Since</proxy:header>
<proxy:header>If-None-Match</proxy:header>
<proxy:header>Rtc4web-Nonce</proxy:header>
<proxy:header>Host</proxy:header>
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<proxy:header>Accept</proxy:header>
<proxy:header>Keep-Alive</proxy:header>
<proxy:header>Connection</proxy:header>
<proxy:header>X-Requested-With</proxy:header>
<proxy:header>Referer</proxy:header>
<proxy:header>Cookie</proxy:header>

</proxy:headers>
</proxy:policy>

v If IP address of the IBM Sametime server is required, add another copy of
the preceding code and replace SametimeServer.yourCompany.com:9082
with the IP address of your Sametime server and its port number.

4. Register and configure the IBM Connections Plug-in for IBM Sametime in IBM
Content Navigator:
a. Log in to the IBM Content Navigator administrator desktop. Click the Open

Administration View icon in Case Manager Client.
b. Click Plug-ins and then click New Plug-in.
c. Select the Jar file path radio button, and then enter the path to the

ProfilePlugin.jar file. Typically, this file is in the IBM/ECMClient/plugins
folder.

d. Click Load.
e. Set the IBM Sametime proxy server URL to your IBM Sametime server URL
f. Set the context root for the Ajax proxy server to the IBM Ajax proxy service

URL.
g. Verify that the proxy-config.xml file is correctly configured in the IBM

Sametime configuration setting in the profile plug-in by clicking the Test
button in the configuration. The profile plug-in tests the configuration by
fetching a JavaScript source on the IBM Sametime server through the Ajax
proxy.

Important: You must use a fully qualified URL to access the IBM Case
Manager server. The test will fail if you are using an IP address or a
non-qualified URL for your IBM Case Manager server. If the test is
successful, this means that the proxy server is set up correctly.

h. Select the IBM Sametime proxy server polling to one of the following
values:
v Disabled
v Display Sametime status automatically
v Display Sametime status after a click action

If you choose to display IBM Sametime status after a click action, the IBM
Sametime status f the user is displayed only when you click on the user
name.

i. Select the Display Name check box to show the display name instead of the
login name.

What to do next

After you install and configure the IBM Sametime server and Sametime proxy
server, you must enable IBM Sametime integration in the IBM Case Manager
administration client.

158 Planning, Installation, and Upgrade Guide



Integrating with Operational Decision Manager
You can integrate Operational Decision Manager with IBM Case Manager to
manage your IBM Case Manager rules and rules from other parts of your business
in a single application. If you plan to use this integration, you must first install the
Operational Decision Manager licensed program on a server in your IBM Case
Manager environment.

About this task

As an alternative to creating business rules in Case Manager Builder, you can
create and deploy rules in Operational Decision Manager to allow more
sophisticated decisions and a full range of management capabilities. You can also
export rules that you created in Case Manager Builder and deploy them in
Operational Decision Manager.

The following diagram shows a sample configuration in which Operational
Decision Manager is deployed to a dedicated server cluster. Alternatively, you can
collocate Operational Decision Manager on an existing server. Operational Decision
Manager is compatible with various application servers, including WebSphere
Application Server.

Operational Decision Manager allows rules to be independently managed and
exposed as web services. These decision services can be imported into IBM Case
Manager and called by Process Engine to allow workflow steps to be controlled by
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the rules without modifying the workflow definition.

Procedure

To install Operational Decision Manager:

Follow the installation and configuration instructions in the Operational Decision
Manager documentation.

“Exporting business rules to IBM Operational Decision Manager”
“Adding business rules from IBM Operational Decision Manager to a solution”
on page 161

Related concepts:
 

Business rules
 

Rules integration using web services

Exporting business rules to IBM Operational Decision
Manager

You can export business rules to IBM Operational Decision Manager by using the
IBM Case Manager administration client. For example, you might want to export
to IBM Operational Decision Manager to manage your IBM Case Manager rules
along with rules from other parts of your business in a single application.

Procedure

To export business rules to IBM Operational Decision Manager:
1. Start the IBM Case Manager administration client. Enter the following URL in a

browser:
http://server:port/navigator/?desktop=icmadmin
server is the IBM Content Navigator IP address or fully qualified server name.
port is the IBM Content Navigator port number.

2. In the navigation tree in the left pane, select a design object store and click
Solutions.

3. On the Solutions page in the right pane, select the solution with business rules
that you want to export.

4. Click Actions > Export > Business Rules and complete the wizard steps.
5. After the rules are exported, download and save the exported rules archive file.

What to do next

The exported archive file contains individual archive files for each business rule
that is associated with the solution. The individual rule archive files are organized
according to the case type with which they are associated. Extract the exported
archive file, and then import the individual rule archive files into the IBM
Operational Decision Manager Rule Designer or Decision Center.

Tip: Centralized rule management, such as provided by the Decision Center
component of IBM Operational Decision Manager, requires the definition of a
persistence locale that is supported by all rule projects that are being managed.
This term refers to the locale that you choose for your environment to use for
creating rules. The locale choice is important because the rules persist in the locale
in which you create them. If you have users in more than one locale, and you want
your solutions for these users to include business rules, it is possible to create the

160 Planning, Installation, and Upgrade Guide

http://www.ibm.com/support/knowledgecenter/SSQP76_8.5.0
http://www.ibm.com/support/knowledgecenter/SSQP76_8.5.0
http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.3.3/com.ibm.casemgmt.help.doc/acmsdh48.htm
http://www.ibm.com/support/knowledgecenter/SSNW2F_5.5.0/com.ibm.p8.pe.user.doc/bpfwd060.htm


solutions in a single instance of IBM Case Manager. However, you cannot import
rules from IBM Case Manager into Decision Center component of IBM Operational
Decision Manager if the locale of your solution does not match the locale of your
Decision Center instance.

If you export rules from solutions that are from a different persistence locale, you
must import the rules into Rule Designer and refactor them to provide a
vocabulary and parameters that can be associated with the persistence locale. After
the rules are refactored, use Rule Designer synchronization commands to publish
the project to Decision Center. If your exported rule projects already support the
IBM Operational Decision Manager persistence locale, you can import them
directly into Decision Center. For more information, see the IBM Operational
Decision Manager documentation.
Related tasks:
“Adding business rules from IBM Operational Decision Manager to a solution”
 

Tuturial: Importing and managing rules with IBM Operational Decision
Manager
 

Importing business rules into IBM Operational Decision Manager Decision
Center
 

Importing into Rule Designer

Adding business rules from IBM Operational Decision
Manager to a solution

You can add business rules from IBM Operational Decision Manager to the steps of
the workflow definition for a task, and then modify the business rules without
modifying the workflow definition.

Before you begin

Before you can add business rules from IBM Operational Decision Manager to a
solution, you must install and configure IBM Operational Decision Manager to use
web services to generate a Web Service Definition Language (WSDL) file that
describes the interface for invoking the business rule.

Before you add a business rule to a solution, review the rule and verify that the
rule was deployed in IBM Operational Decision Manager.

About this task

A business rule captures and implements business policies and practices, such as
enforcing a business policy or making a decision that is based on specific data. For
example, a business rule can update a particular case property to indicate that a
fraud investigation task is required if an automobile insurance claim is filed by the
driver of a sports car.

You can use rules software, such as IBM Operational Decision Manager, to separate
the business rules from the process, which makes it easier for a business analyst to
independently manage the process and the rules for the process, rather than
modifying a workflow definition.

Procedure

To add business rules from IBM Operational Decision Manager to a solution:
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1. Open the solution in Case Manager Builder and add case properties, case
types, tasks, steps, and roles as necessary. Include properties that can be
parameters for the Operational Decision Manager rule in this solution. For
example, an automobile insurance claims solution might have case properties
that include Vehicle Year (integer), Vehicle Make (string), Policy Number
(string), Claimant Age (integer), and Potential Fraud (Boolean).

2. Deploy and test the solution.
3. In the Operational Decision Manager Rule Execution Server console, select the

ruleset that contains the rules that are related to your solution to verify that
the rules are deployed in Operational Decision Manager.

4. Obtain the URL for the Web Service Definition Language (WSDL) file.
a. In the Rule Execution Server console, click Explorer and click the RuleApp

that contains your ruleset.
b. In the RuleApp view, click the ruleset and click Retrieve HTDS

Description File.
c. Select the Latest ruleset version and Latest RuleApp version options.
d. Click View to open the file in a web browser.
e. Copy the URL from the address bar of the browser and paste it into a text

document so that you can refer to the URL in the next step. For example,
the URL might be http://localhost:9082/DecisionService/ws/
AutomobileFraudCheckRuleApp/1.0/AutomobileFraudCheck/1.0?WSDL

5. Define the partner link to the web service. A partner link consists of a name
and the WSDL URL for Invoke functions.
a. Open the solution in Process Designer. On the Manage Solutions page in

Case Manager Builder, click Open Process Designer from the More
Actions option for your solution.

b. Select a case type and a task.
c. Click Workflow Properties > Web Services > Partner Links.
d. Specify a name for the partner link.
e. Select Invoke and paste the WSDL URL into the WSDL URL field.
f. Click the Browse icon (...), which populates the available port types and

select the port type from the menu.
6. Add the following parameters to the workflow definition on the Workflow

Properties > Data Fields tab in Process Designer.

ODMDecisionID
String

ODMOutput
String

ODMRulesCount
Integer

The parameters are specific to Operational Decision Manager and therefore are
not included in your solution.

7. Complete this step for business rules that you created in Case Manager
Builder and exported to Operational Decision Manager, and any other rules
that use a case object to represent the set of case properties in a single object:
Create an XML data field to store the execution results that are returned from
the IBM Operational Decision Manager web services. In Process Designer,
click Workflow Properties > Web Services > XML Data Fields and add a
field with the name ODMOutputXML.
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8. Create a system step to implement the rules:
a. Add a system step to your solution workflow in Process Designer. You

might have created a stub step for this purpose in Case Manager Builder.
b. Connect the final workflow step to the new system step.
c. Specify a name for the step.
d. Select the Invoke function from the Available Functions list and move it

to the Selected Functions list.
e. In the Selected Functions list, double-click Invoke.
f. Click Messages. Then, select the partner link and the operation. The

incoming and outgoing parameters are automatically populated with the
Operational Decision Manager rules parameters

g. Define the outgoing and incoming values.
v For typical business rules that you created in Operational Decision

Manager:
1) In the Outgoing Parameters list, select the matching case property

for each parameter from the Expression menu.
2) In the Incoming Parameters list, select the matching data field for

each parameter from the Field Name menu. You created the data
fields in a previous step. You can also use a field assignment to
assign values.

v For business rules that you created in Case Manager Builder and
exported to Operational Decision Manager, and any other rules that use
a case object to represent the set of case properties in a single object:
1) For the Message Type option, select XML.
2) In the Outgoing Message field, replace the place holder values in

the <caseObject> XML element with expressions that represent the
case properties and data fields that are mapped to custom rule
parameters. Use the format F_CaseFolder.attribute_name. For
example, change the value "<Creator>" + "Creator" +"</Creator>"
to "<Creator>" + F_CaseFolder.Creator +"</Creator>". For the
CmAcmCaseState property, set the value to <CmAcmCaseState>"+
"Working" +"</CmAcmCaseState>.

Tip: All parameter values in the <caseObject> XML element must be
strings. To avoid validation errors, use Expression builder to change
time and date values to timetostring functions and numbertostring
functions.

3) In the Incoming XML Data Field field, specify ODMOutputXML.
4) Select the Assign function from the Available Functions list and

move it to the Selected Functions list.
5) In the Selected Functions list, double-click Assign to view the

assignment parameters that correspond to case properties and data
fields that are mapped to custom rule parameters.

6) For the ODMOutputXML parameter, specify the following
expression:
substitute(ODMOutputXML, "xsi:type=""ns0:caseType""", "")

7) For each case property or data field whose value is set by the
business rule, specify an XPath expression that returns the
corresponding value from the ODMOutputXML data field. For
example, specify the following XPath expression to the value of a
case property:
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xmlstringexpr(ODMOutputXML, "/", "/*[local-
name()=""CSR1_CT1_RuleName""]/*[local-name()=""caseObject""]/
*[local-name()=""caseObject""]/*[local-
name()=""F_CaseFolder.CSR1_StringProperty""]")

9. Validate, transfer, and check the workflow.
10. In Case Manager Builder, click Manage Solutions and deploy the solution to

the development environment for testing.
Related tasks:
“Exporting business rules to IBM Operational Decision Manager” on page 160
 

Using web services: XML message example
 

Web services integration using XML data mapping

Integrating with a version control system (VCS)
You can integrate IBM Case Manager with a version control system (VCS) such as
IBM Rational Team Concert or PTC Integrity. You can then keep a record in the
VCS of the changes made to a solution over time.

About this task

Whenever you click Commit on the Manage Solutions page in Case Manager
Builder, the server saves new and updated solution assets to the design object
store. If you integrate with a VCS, the server also copies the changed solution files
to the directory that you designated to act as the sandbox. This sandbox provides a
staging area for the solution files that are to be stored in the VCS. Solution files are
copied to the appropriate sandbox subdirectory according to the solution and the
user. The server then runs your commit script to check in the changes from the
sandbox to the VCS. The commit script creates a change set that contains all new
or modified solution assets, associates comments with each asset, and checks the
change set into the VCS.

After a solution is committed, you can click Deliver to check in the solution as a
whole to the VCS. After the server copies all solution files and a solution manifest
file to the sandbox, the server runs your deliver script to check in the files from the
sandbox to the VCS. The script then creates and labels a baseline or snapshot of
the solution and delivers it to the VCS.

Case Manager

Builder
Sandbox

Copy assets Run commit script
Version control

system

Design object

store

Development environment

Save asets

Figure 4. Committing new and changed solution assets
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After you deliver the files, you can deploy an IBM Case Manager solution from the
VCS into another environment, such as a production environment or a different
development environment. You first extract the solution assets and solution
manifest from the VCS according to a specific delivery label. You then use the
solution manifest file to import the solution into the design object store in the new
environment before you deploy the solution.

You can use the graphical user interface of your VCS to export the solution assets
and solution manifest from the VCS according to a delivery label and then use the
IBM Case Manager administration client to import and deploy the solution to the
new environment. Alternatively, you can create a custom script to automatically
extract, import, and deploy the solution.

“Setting up and configuring VCS integration”
“Commit and deliver scripts” on page 167
“Disabling VCS integration” on page 169
“Adding an existing or a copied solution to a VCS” on page 169
“Deleting a solution from a VCS” on page 170

Related tasks:
 

Importing IBM Case Manager assets by using a solution manifest
 

Exporting IBM Case Manager assets from a VCS

Setting up and configuring VCS integration
To integrate IBM Case Manager with a version control system (VCS), you must
first designate a directory to act as a sandbox. You then create scripts to check in
and deliver solution files to the VCS, and use the IBM Case Manager configuration
tool to enable and configure the VCS integration.

Procedure

To set up and configure VCS integration:

Case Manager

Builder
Sandbox

Copy solution files

and manifest Run deliver script Version control

system

Figure 5. Delivering the entire solution

Version control

system

Temporary

directory

Extract solution assets

and manifest
Import solution Design object

store

Target object

store

Production environment

Deploy solution

Figure 6. Deploying the solution into another environment
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1. Create a directory on a network shared directory to serve as a sandbox for the
VCS integration. This sandbox provides a staging area for the solution files that
are to be stored in the VCS.
v In a cluster environment, the network shared directory must be available to

all nodes. You can make the directory available to all nodes by mapping the
file system on one server so that the file system is available to other nodes in
the cluster. Alternatively, you can use a file storage device to make the
network shared directory available to all nodes.

v In a standalone environment, the network shared directory can be the local
file system.

2. Create the scripts that Case Manager Builder runs to commit and deliver to the
VCS the changes that are made to a solution in Case Manager Builder. For
more information about creating the scripts, see “Commit and deliver scripts”
on page 167.

3. Optional: Create custom scripts to automate the deployment of solutions to
other environments, such as staging or production environments. You can
create a single script to do the following tasks:
a. Extract solution assets that are associated with a specific label from the VCS.
b. Call the IBM Case Manager configuration tool to import the solution assets

to the target environment.
c. Call the IBM Case Manager configuration tool to deploy the solution to the

target environment.

Tip: Instead of using a custom script to extract the solution assets, you can use
the user interface for your VCS to download the solution assets.

4. If the VCS requires additional credentials, configure a keystore or other solution
for handling sensitive parameters, such as the credentials for the VCS user.
Case Manager Builder does not pass sensitive parameters, such as passwords,
to the VCS scripts. Therefore, the scripts must look up the credentials based on
the FileNet P8 user that does a commit or deliver, or on nonsensitive
parameters that are collected from the user.

5. In the IBM Case Manager configuration tool, edit and run the Create Case
Manager Applications task to enable and configure VCS integration.
a. Select the Enable VCS integration check box.
b. Specify the path to the directory that you designated to serve as a sandbox

for the VCS integration.
c. Optional: To prompt users for custom parameters that Case Manager

Builder passes to your commit or deliver script, enter a label for each
parameter. Enter the values in a comma-separated list, as shown in the
following example:
VCS ID,Project Name,Approving Manager

Tip: You do not need to specify custom parameters for comments or labels.
Case Manager Builder automatically prompts the user for comments for a
commit or a delivery. For a delivery, Case Manager Builder also prompts the
user for a label.

d. Optional: Specify a heartbeat interval that indicates the time in seconds that
must elapse between periodic updates from your commit and deliver scripts
before a commit or deliver operation fails.
The heartbeat interval measures the activity of your commit script or
deliver scripts. You specify this interval to detect problems in script
execution before the script times out. For example, the heartbeat can alert
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you to problems such as the script hanging or Case Manager Builder
terminating unexpectedly. The heartbeat is determined by the time that the
output.txt file was last modified. Therefore, your scripts must periodically
check the status of its own threads and update output.txt.
If you do not want to check for a heartbeat, leave this field blank.

e. Specify the maximum time in seconds that must elapse before the commit
and deliver scripts time out.

f. Run the Create Case Manager Applications task.
6. In the configuration tool, run the Deploy Case Manager Builder task.

Results

In Case Manager Builder, your commit script is run automatically when a user
clicks Commit on the Manage Solutions page. A Deliver action that runs your
deliver script appears in the More Actions menu on the Manage Solutions page.

Commit and deliver scripts
To integrate with a version control system (VCS), you must create two scripts to
deliver change sets that contain new and modified solution assets the VCS. These
scripts work with the Commit and Deliver actions in Case Manager Builder.

Commit script

When a user clicks the Commit action on the Manager Solutions page, Case
Manager Builder takes the following actions:
v Commits the changes to the IBM Case Manager repository
v Copies the changed solution files to the sandbox
v Runs a commit script that you provided to check the set of changes from the

sandbox into the VCS

The commit script, which you must call commitSandBoxChanges, does the
following tasks:
v Reads the input parameters supplied in the input.properties file
v Handles deleted solution assets
v Creates a change set that contains any new or modified solution assets
v Associates the comments that the user entered for the Commit action with each

asset
v Checks the change set into the VCS

Deliver script

After a solution is committed, the user clicks the Deliver action on the Manager
Solutions page. Case Manager Builder then runs the deliver script that you
provided. This script checks the modified solution as a whole into the VCS.

The deliver script, which you must call deliverSolutionChanges, does the
following tasks:
v Reads the input parameters supplied in the input.properties file
v Checks all of the solution assets and the solution manifest into the VCS
v Associates the comments that the user entered for the Deliver action with each

asset
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v Creates a baseline or snapshot of the solution
v Labels the baseline and delivers it to the VCS

Script requirements

The scripts can be either .sh files for Linux or AIX systems or .bat files for
Windows systems.

The scripts must be in the scripts subdirectory of the sandbox. You can edit the
stub scripts that the IBM Case Manager configuration tool creates in the scripts
subdirectory. Alternatively, you can create your own scripts to replace the stub
script files. If you create the scripts, you must give them the same names as the
stub script files.

Important: On a Linux system, you must manually give the scripts execute
permissions before the commit is run.

Case Manager Builder passes to the scripts the path to the user's sandbox. This
path takes the following form:sandbox\solution prefix\user name. For example,
the path might be C:\sandbox_CreditCard\DISP\ajones where
C:\sandbox_CreditCard is the sandbox, DISP is the solution prefix, and ajones is
the name of the user who is committing or delivering the solution.

The scripts must read and process the input.properties file that is located in the
user's sandbox. This file contains the following information:

deliverLabel
For a delivery, a label that is used to identify the new baseline that is being
created in the VCS.

Tip: You can use the label that is assigned to the baseline to later extract a
solution from the VCS.

comment
The comment that the user entered during the Commit or Deliver action.

Custom parameters
The additional parameters that were specified when you configured VCS
integration. The user provides values for these parameters as part of the
Commit or Deliver action.

deletedFiles
A list of assets that were deleted from the solution. If no assets were deleted,
this parameter is empty.

newAndModifiedFiles
A list of solution assets that the user created or modified assets. This list also
includes the name of the manifest file for the delivery.

userName
The name of the user who committed or delivered the solution.

solutionPrefix
The prefix of the solution that is being committed or delivered.

These scripts must return an integer code. Use the return code 0 to indicate
successful execution of the script.
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If you specify a heartbeat interval when you configure VCS integration, the scripts
must modify the output.txt file in the sandbox to serve as the heartbeat. The
scripts can output error messages and other information messages to either the
output.txt file or to standard output. IBM Case Manager captures and logs the
content of the output.txt file.

Disabling VCS integration
You can disable integration with a version control system (VCS).

About this task

Disabling VCS integration stops IBM Case Manager from running the commit and
deliver scripts that are used to copy solution information to the VCS.

Tip: If you later re-enable VCS integration, any commits that occurred while the
feature was disabled are not tracked. To ensure that the VCS contains the latest
versions of a solution after you re-enable VCS integration, deliver that solution to
establish a baseline.

Procedure

To disable VCS integration:
1. In the IBM Case Manager configuration tool, clear the Enable VCS integration

check box in the Create Case Manager Applications task. Then, run the task.
You do not need to clear any of the other VCS integration fields.

2. Run the Deploy Case Manager Builder task.
3. Optional: Remove the files from the sandbox. IBM Case Manager does not

remove the files from the sandbox when you disable VCS integration.

Results

After you disable VCS integration, the Deliver option is no longer available in
Case Manager Builder. The Commit action is available, but does not run the
commit script.

Adding an existing or a copied solution to a VCS
For a solution that existed before you integrated with a version control system
(VCS), you should establish an initial baseline version in the VCS before you make
additional changes to that solution. You should also establish an initial baseline
version for a copied solution.

Procedure

To create a baseline in the VCS for an existing or a copied solution:
1. Open Case Manager Builder.
2. On the Manage Solutions page, click More actions > Deliver for the solution.

Results

Case Manager Builder runs your deliver script to create a baseline for the solution
in the VCS. You can now edit the solution.
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Deleting a solution from a VCS
If you delete a solution in IBM Case Manager, the solution is not deleted from the
version control system (VCS). If your company's established procedure requires a
solution to be deleted, you must delete the solution separately from the VCS.

About this task

Procedure

To delete a solution:
1. In Case Manager Builder, find the solution on the Manage Solutions page and

click Remove. The solution and the solution artifacts are removed from the
design object store.

2. In the VCS, follow your company's established procedure to decommission the
solution and to remove the solution artifacts from the VCS.

Integrating with Box
You can integrate with Box so case workers can collaborate with external users.
You can use Box as an external repository for IBM Case Manager and for sharing
case documents or attachments with other users.

About this task

If you enable Box collaboration, case workers can associate a case with a Box folder
so that internal and external users can exchange content. For example, a customer
service representative at an automobile insurance company receives a new claim
request. The customer service representative creates a Box collaboration folder for
the case, and invites the claimant to be a collaborator on the folder. The customer
service representative copies a claims form to the Box folder and then assigns a
task to the claimant to complete and return the claims form. The claimant receives
an email notification about the task, and clicks a link in the email to open the Box
folder. The claimant downloads the form, completes the relevant information, and
uploads the completed form and the police report about the accident. The
customer service representative can then copy the completed form and the police
report from the Box folder to the case folder.

If you configure Box as an external repository, case workers can add Box
documents as case documents and task attachments. Case workers can also add
local documents to a case or work item and save the documents in Box.

By default, when case workers add Box documents to a case, a reference to the
latest version of the document in Box is added to the case. If the document is
deleted from Box, the reference from the case becomes invalid. You can allow case
workers to add a copy of the current version of a document to the case
management repository instead of referencing the document in Box. The copy
remains in the case even if the document is deleted from Box. However, any
changes that are made to the document in Box are not reflected in the case. To
allow case workers to add a copy of a Box document to the current case, enable
the Box copy feature for the case management repository in IBM Content
Navigator.

Restriction: The Box copy feature is available only if the case management
repository is an IBM FileNet Content Manager object store.
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IBM Case Manager uses the Box share feature of IBM Content Navigator to enable
case workers to share case documents and task attachments that are in an IBM
FileNet Content Manager or IBM Content Manager repository. When a case worker
selects a document to share, IBM Content Navigator saves the document to Box
and creates a link to the specific version of the document. If the case worker later
deletes the share, the document is removed from Box.

Important: By default, no security constraints are applied to a shared document.
Anyone who receives the link can view the document.

“Setting up Box collaboration”
“Setting up Box as an external repository and for sharing” on page 178

Setting up Box collaboration
You can integrate with Box so case workers and external users can use Box to
exchange documents.

Procedure

To set up Box collaboration:
1. Create a Box application for the IBM Case Manager environment. Alternatively,

you can modify an existing application that was created for IBM Content
Navigator.
a. Go to https://developer.box.com/ and log in.
b. In the My Applications window, click Create a Box Application.
c. Select Enterprise Application as an application type.
d. Select OAuth 2.0 with JWT (Server Authentication) as an authentication

method.
e. In the Application Name field, enter the name of your IBM Case Manager

server and then click Create Application.
f. Click View Application and configure the following settings:

Setting Value

Application Access Enterprise

Application Scope Leave the default settings

Advance Features Generate User Access Token

g. Click Save Application to save your changes.
2. Authorize the Box application for IBM Case Manager to access your Box

enterprise account.
a. Log in to your Box application as an administrative user.
b. Click Admin Console, click the gear icon, and select Elite Settings.
c. From the Account Info tab, record the value of the Enterprise ID field. You

must specify this value later when you run the IBM Case Manager
configuration tool.

d. Select the Apps tab, go to the Custom Applications section, and click
Authorize New App. In the Api Key field, specify the client_id value that
was displayed when you created the application and click Next. Click
Authorize.

3. Generate a JSON web token and Box server token. For more information, see
the Box documentation at https://docs.box.com/docs.
a. Generate an RSA key pair.

Extending your case management system 171

https://developer.box.com/
https://docs.box.com/docs


1) To generate the RSA key pair on a Windows system, download the
Cygwin application and run the following OpenSSL commands on the
Cygwin terminal. Otherwise, enter the commands on a Linux system.

2) Generate a private key by running the following command at the
command prompt: openssl genrsa -aes256 -out private_key.pem 2048.
After you enter a passphrase, record the value for use in the next step.

3) Generate a private key in PKCS8 format by running the following
command: openssl pkcs8 -topk8 -inform pem -in private_key.pem
-outform der -nocrypt -out private_pkcs8.der. Specify the passphrase
that you used in the previous step.

4) Generate a public key by running the following command: openssl rsa
-pubout -in private_key.pem -out public_key.pem

5) Locate the generated key files. For example, look for the key files under
your Cygwin installation directory, such as in the c:\cygwin64\home\
LoginName directory.

b. Submit the public key:
1) Go to https://developer.box.com/ and log in.
2) Click the Edit Application button for your application.
3) In the Public Key Management section, click Add Public Key. You

might be prompted to enable two-factor authentication and be asked to
give your mobile phone number to receive a verification code. You can
disable this two-factor authentication feature after you submit the public
key.

4) Copy your public key from your key file and paste it in the Public Key
field. Then, click Verify. After the key is verified, click Save. Your public
key and key ID are now displayed in the Public Key Management
section. Record the Key ID value. You must specify this value later
when you run the IBM Case Manager configuration tool.

5) Scroll to the bottom of the page and click Save Application.
6) Disable two-factor authentication. At the top of the page, click the gear

icon and select Account Settings. Click the Security tab and clear the
Login verification check box.

4. Configure a connection to the Box server in your development and productions
environments by using the IBM Case Manager configuration tool or
administration client.
v In the configuration tool, run the Configure Box Collaboration task and then

run the Register Project Area or Register Target Environment task.

Tip: For new profiles, select the Configure Box collaboration option in the
new profile wizard. For existing profiles, add the Configure Box
Collaboration task after the Register the IBM Case Manager Administration
Client Plug-in task but before the Register Project Area or Register Target
Environment task.

v In the administration client, open a target object store and click New Box
Connection.

5. Enable case types to support Box collaboration. In Case Manager Builder, edit
each case type for which you want case workers to be able to collaborate with
external users in Box and select Case workers can use Box to collaborate with
external users.

6. To use Box collaboration in existing solutions that were created before Box
collaboration was enabled, manually add the Add Box Collaboration Folder,
Manage Collaborators, Assign Box Task, and Box Copy actions by editing the
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solution in Case Manager Builder. For solutions that are created after Box
collaboration was enabled, the Box collaboration actions are displayed by
default in the Documents view.

7. Optional: Enable additional Box integration features that you want to use.

Feature Procedure

Box as an external repository Enable case types to support external
documents. In Case Manager Builder, edit
each case type for which you want users to
be able to add documents or attachments
from Box to the case and select Allow
documents and attachments from
repositories other than the case
management object stores. This option is
not required if you use Box only to share
case documents and task attachments that
are in an IBM FileNet Content Manager or
IBM Content Manager repository.

Extending your case management system 173



Feature Procedure

Sharing case documents and attachments 1. Manually set the Share administrator
field for the Box repository. In the IBM
Content Navigator administration tool of
the web client, click Repositories, select
your Box repository, and set the Share
administrator field.

2. Enable the Box share option for your
IBM Case Manager desktop and for each
IBM FileNet Content Manager or IBM
Content Manager repository that you
want to share documents from:

IBM Case Manager desktop

a. In the IBM Content
Navigator administration
tool, click Desktops and
open your IBM Case
Manager desktop.

b. On the General tab, enable
the Box share services
option and select the Box
repository for shared files.

IBM FileNet Content Manager or IBM
Content Manager repository

a. In the IBM Content
Navigator administration
tool, click Repositories and
open each IBM FileNet
Content Manager or IBM
Content Manager repository.

b. On the Configuration
Parameters tab, enable the
Optional Features > Box
share option.

3. If you want to share documents in
existing solutions that were created
before IBM Case Manager V5.2.1 Fix
Pack 3, manually add the Box Share and
Delete Box Share menu actions by
editing the solution in Case Manager
Builder. The Box Share and Delete Box
Share menu actions are displayed by
default in the Documents view.

8. Deploy your solution.
9. Configure SSL on the application server for your solution to access Box. For

more information, see Configuring SSL for Box.

Adding Box collaboration actions for existing solutions
You can enable Box collaboration. For solutions that are created after Box
collaboration is enabled, the Box collaboration actions are displayed by default in
the Documents view. For solutions that were created before Box collaboration was
enabled, you must manually add these actions by editing the solution in Case
Manager Builder.
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Before you begin

Install IBM Case Manager and enable Box collaboration.

Procedure

To add the Box collaboration actions to an existing solution:
1. Open the solution in Case Manager Builder.
2. On the Pages tab, edit all solution pages that contain the Case Information

widget or any other custom widget that has a Documents view menu. By
default, the Case Information widget is included on the Case Details page.

3. In Page Designer, click the Edit Settings icon for each widget that has a
Documents view to configure the Box actions.
a. On the Toolbars tab, add the Add Box Collaboration Folder action to the

Documents view toolbar.
b. On the Menus tab, add the Manage Collaborators and Assign Box Task

actions to the Documents view (Folder) menu/
c. On the Menus tab, add the Box Copy and Assign Box Task actions to the

Documents view (Documents) menu.
4. After you update the relevant pages, save and redeploy the solution.

Access levels for Box collaborators
IBM Case Manager supports the access levels that Box defines for collaborators
folders. To ensure the security and privacy of documents in a Box folder, ensure
that case workers assign the correct access levels when they invite collaborators
into folders.
Related information:
 

What Are The Different Access Levels For Collaborators?

Monitoring events for a Box collaboration folder
You can use the IBM Case Manager Box Event Listener to monitor events in a Box
collaboration folder. You can then implement event handlers to perform actions
such as creating cases and launching workflows or tasks in response to these
events.

About this task

The IBM Case Manager Box Event Listener uses Java event handlers to define the
actions that are to be performed for events. You can use the Box document copy
event handler that is provided by IBM Case Manager Box Event Listener. The
event handler copies a Box document and file that document in a case. You can
then configure a case task to launch automatically when the Box document is filed
in the case. This event handler displays a dialog box from which a user selects the
document class that is used to copy the Box document to the FileNet P8 object
store. The user also can choose whether to file the document in the case as part of
the copy.

Alternatively, you can define a custom event handler plug-in that is a subclass of
the com.ibm.casemgmt.api.handlers.BaseHandler class.

Configuring the IBM Case Manager Box Event Listener:

To use the IBM Case Manager Box Event Listener, you must enable the plug-in in
the IBM Case Manager administration desktop.
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About this task

You run the IBM Case Manager Box Event Listener as a task. Therefore, the task
manager component must be available in IBM Content Navigator.

Procedure

To configure the IBM Case Manager Box Event Listener:
1. If the optional task manager component is not available in IBM Content

Navigator, configure and deploy the component. For more information, see
Configuring and deploying the task manager component.
The event listener requires the task manager URL to the HTTPS protocol:
https://server_host_name:port_number/taskManagerWeb/api/v1/tasks/ping. If
the task manager service uses the HTTP protocol, the event listener encounters
errors.
a. Log in to IBM Content Navigator administration tool and click Settings.
b. In the Task Manager Configuration section, ensure that the URL in the

Task manager service URL field has the following format:
https://server_host_name:port_number/taskManagerWeb/api/v1/tasks/ping

2. Assign the user who will run the event listener to the task manager
administrator role For information on assigning the user on the WebSphere
Application Server, see Associating users with task manager roles (WebSphere
Application Server).

3. In the IBM Case Manager configuration tool, register the event listener to make
the plug-in available to a desktop.
a. Run the Register the IBM Case Manager Box Event Listener Plug-in task to

register the event listener.
b. Run the Register Project Area task or Register Target Environment task to

make the event listener plug-in available to the desktop. This step adds the
event listener to the Case Manager administration desktop.

4. To run the event listener from a custom desktop, enable the event listener
plug-in in that desktop:
a. Log in to IBM Content Navigator administration tool, click Desktops, and

double-click the desktop to which you want to add the event listener.
b. In the Plug-ins section on the General tab, select the IBM Case Manager

API plug-in check box and the IBM Case Manager Box Event Listener
plug-in check box. The event listener requires the IBM Case Manager API
plug-in.

c. On the Layout tab, select the Asynchronous tasks check box to add the task
manager feature to the custom desktop.

Creating a custom event handler for the IBM Case Manager Box Event Listener:

You can create a custom event handler to process events that are detected by the
IBM Case Manager Box Event Listener.

Before you begin

Ensure that you have the following files that are required to compile and build a
custom event handler:
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File Description

ICNTasks.jar This file contains the
com.ibm.ecm.icm.boxeventhandlers.BaseHandler that
you must extend to create a custom event handler.

You can find this file in Installation_directory\
configure\explodedformat\taskManager\
taskManagerWeb\WEB-INF\dropins, where
Installation_directory is the directory in which IBM
Content Navigator is installed.

acmapi.jar This file contains the IBM Case Manager Java API.

You can find this file in Installation_directory\
CaseAPI\lib, where Installation_directory is the directory
in which IBM Case Manager is installed.

Box-java-sdk-1.0.0.jar This file contains the Box API.

You can find this file in Installation_directory\
configure\explodedformat\taskManager\
taskManagerWeb\WEB-INF\lib, where Installation_directory
is the directory in which IBM Content Navigator is
installed.

Minimal-json-0.9.2-SNAPSHOT.jar This file contains the minimal JSON parser and writer
that the Box API uses.

You can find this file in Installation_directory\
configure\explodedformat\taskManager\
taskManagerWeb\WEB-INF\lib, where Installation_directory
is the directory in which IBM Content Navigator is
installed.

About this task

You can find sample custom event handler plug-ins in the following location:
https://github.com/ibm-ecm/ibm-casemanager-samples

.

Procedure

1. Create a Java class that extends the
com.ibm.ecm.icm.boxeventhandlers.BaseHandler class that is provided by the
IBM Case Manager Box Event Listener.
This new class must implement the following methods:

processBoxEvent
This method is called by the event listener to process an event.

The processBoxEventmethod takes the following parameters:

boxEvent
A Box object that contains detailed information about the event.

caseID
A string that contains the identifier of the case in which the event
occurred.
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eventSupported
This method is called by the event listener to determine whether the event
handler supports a specific event. If the event is supported, the method
returns true.

The eventSupportedmethod takes the following parameter:

boxEvent
A Box object that contains detailed information about the event.

2. If your custom class requires any input or configuration from the user, create a
Dojo JavaScript class that inherits from the boxeventlistener/eventhandler/
configuration/BaseConfigurationPane class that is provided by the event
listener.
The new class must implement the following methods:

getInput
This method returns a JSON object that contains the configuration
information that the user enters.

setInput
This method populates and initializes the user interface that is used to
collect the user input.

The setInput method takes the following parameter:

inputParam
A JSON object that contains the information that is used to populate
the user interface.

3. Create an IBM Content Navigator plug-in that includes your compiled Java
event handler class and, if applicable, your JavaScript configuration class in the
plug-in JAR file. For more information, see Creating plug-ins to IBM Content
Navigator,

4. Deploy your plug-in JAR file into the Task Manager Web-INF/Dropins directory.
The location of this directory depends on your application server settings. For
example, if you use IBM WebSphere Application Server, the directory location
might be C:\IBM\WebSphere\AppServer\profiles\AppSrv02\installedApps\
oclv0288Node02Cell\navigator.ear\taskManagerWeb.war\WEB-INF \ dropins.

5. In the IBM Content Navigator administration desktop, add the new plug-in to
the IBM Case Manager administration desktop.

6. Register your custom event handler with the IBM Case Manager Box Event
Listener plug-in.
a. On the Configuration tab for the event listener, click Register.
b. Complete the Custom Event Handler Registration dialog box, and click OK.

7. In task manager, configure the IBM Case Manager Box Event Listener and
select your custom event handler.

Setting up Box as an external repository and for sharing
You can set up Box as an external repository for IBM Case Manager. You can also
use Box to share case documents or attachments with other users.

About this task

For detailed information about configuring IBM Content Navigator to connect to
Box and enabling document sharing, see Integrating IBM Content Navigator with
Box.
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Procedure

To integrate IBM Case Manager with Box:
1. Create a Box application for the IBM Content Navigator server.
2. Configure a connection to Box. In the IBM Content Navigator administration

tool of the web client, click Repositories > New Repository to create a Box
repository. If you plan to use Box to share documents, ensure that you set the
share administrator.

3. Add the Box repository to the IBM Case Manager desktop.
a. In the IBM Content Navigator administration tool, click Desktops and open

your IBM Case Manager desktop.
b. On the Repositories tab, add the Box repository to the Selected

Repositories list and save your changes.
4. Enable the Box integration features that you want to use.

Feature Procedure

Box as an external repository Enable case types to support external
documents. In Case Manager Builder, edit
each case type for which you want users to
be able to add documents or attachments
from Box and select Allow documents and
attachments from repositories other than
the case management object stores. This
option is not required if you use Box only to
share documents.

If you want to enable case workers to add a
copy of a Box document to the current case
instead of referencing the document in Box,
enable the Box copy option for the case
management repository:

1. In the IBM Content Navigator
administration tool, click Repositories
and open the IBM FileNet Content
Manager target object store that is used
as the case management repository.

2. On the Configuration Parameters tab,
enable the Optional Features > Box copy
option.
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Feature Procedure

Document sharing Enable the Box share option for your IBM
Case Manager desktop and for each IBM
FileNet Content Manager or IBM Content
Manager repository that you want to share
documents from:

IBM Case Manager desktop

1. In the IBM Content Navigator
administration tool, click
Desktops and open your IBM
Case Manager desktop.

2. On the General tab, enable the
Box share services option and
select the Box repository for
shared files.

IBM FileNet Content Manager or IBM
Content Manager repository

1. In the IBM Content Navigator
administration tool, click
Repositories and open each
IBM FileNet Content Manager
or IBM Content Manager
repository.

2. On the Configuration
Parameters tab, enable the
Optional Features > Box share
option.

If you want to share documents in existing
solutions that were created before IBM Case
Manager V5.2.1 Fix Pack 3, manually add
the Box Share and Delete Box Share menu
actions by editing the solution in Case
Manager Builder. The Box Share and Delete
Box Share menu actions are displayed by
default in the Documents view.

5. Deploy your solution.

Adding Box Share menu actions for existing solutions
The Box Share and Delete Box Share menu actions are displayed by default in the
Documents view. However, for solutions that were created before V5.2.1 Fix Pack
3, you must manually add these menu actions by editing the solution in Case
Manager Builder.

Procedure

To add the Box Share and Delete Box Share menu actions to an existing solution:
1. Install IBM Case Manager.
2. Open the solution in Case Manager Builder.
3. On the Pages tab, edit all solution pages that contain the Case Information

widget, the Attachment widget, or any other custom widget that has a
Documents view menu. By default, the Case Information widget is included on
the Case Details page and the Attachments widget is included on the Work
Details page.
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a. In Page Designer, click the Edit Settings icon for each widget that has a
Documents view.

b. On the Menus tab, select the Documents view (Documents) menu.
c. Click the Add Menu Item icon and select the Box Share and Delete Box

Share actions.

Tip: By default, the menu actions are added at the end of the list of actions.
You can use the Move up and Move down icons to move the new actions
to a different location in the list.

4. After you update the relevant pages, save and redeploy the solution.
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Upgrading and configuring IBM Case Manager

The steps for upgrading IBM Case Manager are the same for a single-server
installation or a distributed installation. To prepare for an upgrade, you must
update the IBM Case Manager software and supporting software to a minimum
update version level.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

About this task

If you upgrade from an existing IBM Case Manager version on the same server,
the installation of V5.3.3 upgrades the installation of the existing version.

You can upgrade to IBM Case Manager V5.3.3 from any of the following existing
versions:
v V5.2.1
v V5.3.0
v V5.3.1
v V5.3.2

Upgrade and configure the development environment

After the supporting applications and IBM Case Manager V5.3.3 software
is installed, you use the IBM Case Manager configuration tool to configure
the development environment. You use the tool to create an upgrade
profile that contains tasks, where you enter properties for all aspects of
your development environment applications and connections.

When you run the configuration tool, you must specify connection
information for a new WebSphere Application Server profile if you
upgrade on a new server. If you upgrade on the existing server, the
existing WebSphere Application Server profile is used for IBM Case
Manager V5.3.3.

Before you export a solution to the test or production environment, ensure
that the solution works correctly in the new client framework.

Upgrade and configure the test or production environment

After the supporting applications and IBM Case Manager V5.3.3 software
is installed, you use the IBM Case Manager configuration tool to configure
the production environment. You use the tool to create an upgrade profile
that contains tasks, where you enter properties for all aspects of your
production environment applications and connections.

When you run the configuration tool, you must specify connection
information for a new WebSphere Application Server profile except if you
upgrade on a new server. If you upgrade on the existing server, the
existing WebSphere Application Server profile is used for IBM Case
Manager V5.3.3.
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The first time that you run the configuration tool, you must define at least
one target environment. For an existing target object store, the definition of
the target environment on V5.3.3 upgrades the underlying target object
store to V5.3.3. Later, as you upgrade solutions, you can upgrade
individual target environments as needed to support the upgraded
solutions.

After you convert and test an upgraded solution in the development
environment, you can import it into the staging object store. After you
deploy the imported solution, the solution becomes visible through the
Case Manager Client and your IBM Case Manager V5.3.3 system is ready
to use.

1. “Preparing the IBM Case Manager environment for upgrade”
2. “Upgrading IBM Case Manager” on page 186
3. “Configuring IBM Case Manager after you upgrade the software” on page 188

Preparing the IBM Case Manager environment for upgrade
To prepare for upgrade, ensure that your existing IBM Case Manager version is
upgraded to the latest fix pack level. You can install the IBM Case Manager V5.3.3
software the same server where you installed your existing system or on a separate
server. If you install on the same server, IBM Case Manager V5.3.3 installs to the
same location as the existing version was installed.

Before you begin

For details about the hardware and software requirements, see “System
requirements” on page 10.

You must ensure that supported versions of IBM Case Foundation and IBM
Content Navigator are installed on the server or servers where you plan to install
IBM Case Manager V5.3.3.

Upgrade Content Platform Engine to the latest fix pack.

AIX and Linux guidelines: AIX and Linux servers might require the installation
of additional libraries.

For an AIX server or a Linux server that does not use Domain Name Service
(DNS) or Network Information Service (NIS), verify that the /etc/hosts file
contains the name and Internet Protocol (IP) address of all servers that the server
communicates with, including the local host. Verify that the etc/netsvc.conf file
contains the value hosts = local.

Application server guidelines: Ensure that your application server is updated to a
version that is supported by IBM Case Manager V5.3.3. IBM Case Manager and all
of the supporting products must use the same version of the application server. In
addition, the application server you use must support Java 7 or later.

About this task

You can upgrade to IBM Case Manager V5.3.3 from any of the following existing
versions:
v V5.2.1
v V5.3.0
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v V5.3.1
v V5.3.2

Procedure

To prepare the IBM Case Manager environment for upgrade:
1. Back up your existing IBM Case Manager system.
2. If your existing version is IBM Case Manager V5.2.1, upgrade to the latest fix

pack or iFix level. You can find the latest update on Fix Central.
3. If your existing version of IBM Case Manager s configured to integrate with

IBM Forms, ensure that you are using the version of IBM Forms that IBM Case
Manager V5.3.3 supports. If you are using an earlier version of IBM Forms,
remove the existing IBM Forms software, and then install the supported
version.
When you install IBM Forms, select the IBM Case Manager Integrator, which is
compatible with both the existing IBM Case Manager version and V5.3.3. To
configure support for forms for the IBM Case Manager in your existing profile,
run the Create Case Manager Applications task and Deploy the Forms
Application task in the IBM Case Manager configuration tool for your existing
version.
After you upgrade IBM Case Manager to V5.3.3, you do not need to run the
IBM Forms installation program again. To configure support for forms, run the
Create Case Manager Applications task and Deploy the Forms Application
task in the IBM Case Manager V5.3.3 configuration tool.

4. Upgrade IBM Case Foundation to the latest required version.
a. Plan your upgrade. For information, see Planning and preparing for FileNet

P8 upgrade.
b. Upgrade IBM Case Foundation. For instructions, see Upgrading and

configuring FileNet P8.
5. Verify that IBM Content Navigator meets the following requirements:
v IBM Content Navigator is installed to use the same WebSphere Application

Server profile that you created for your existing IBM Case Manager version.
v IBM Case Manager requires one IBM Content Navigator server for each IBM

Case Manager server. That is, you cannot share a IBM Content Navigator
server with multiple IBM Case Manager servers.

v If applicable, upgrade the Content Platform Engine client files on the IBM
Content Navigator server. The Content Platform Engine client files must
match the version of the Content Platform Engine server and the client files
that are installed on the IBM Case Manager server.

v On your development environment server, ensure that IBM Content
Navigator is configured to render forms. If the applications are not
configured to render forms, you can still open forms from the Form widget
but you cannot open forms from the Case Information and Attachments
widgets. For instructions, see the IBM Content Navigator documentation.

Related information:
 

WebSphere Application Server documentation
 

Case Manager upgrade and configuration issues for related components
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Upgrading IBM Case Manager
To install the IBM Case Manager software, you can run the installation program
interactively or you can enter a command that applies values from an installation
setup file.

“Upgrading IBM Case Manager interactively”
“Upgrading IBM Case Manager silently” on page 187

Upgrading IBM Case Manager interactively
To upgrade IBM Case Manager interactively, provide the values for your
environment to the installation program.

About this task

If you upgrade from an existing IBM Case Manager version on the same server,
the installation of V5.3.3 upgrades the installation of the existing version.

The installation program detects whether the prerequisite components are installed.

If you use IBM Forms and you are upgrading in a WebSphere Application Server
cluster, you must repeat this procedure on the deployment manager server and on
each node in the cluster.

Procedure

To upgrade IBM Case Manager interactively:
1. Log on to the IBM Case Manager server as a user with write access to the

installation directory.
2. Locate the IBM Case Manager software package in the installation media.
3. Run the installation program:

Operating system Command

AIX 5.3.3.0-ICM-AIX.BIN

Linux 5.3.3.0-ICM-LINUX.BIN

Linux for System z 5.3.3.0-ICM-ZLINUX.BIN

Windows 5.3.3.0-ICM-WIN.EXE

4. Complete the program by entering the values for your environment.

Important: Set the license type to the IBM Case Manager.
5. Review the preinstallation summary, and click Install.
6. When the installation completes, click Next.
7. When the program completes, check for errors in the IBM Case Manager

installation log. The log file is created in the installation directory. For example,
review the /opt/IBM/CaseManagement/logs/
IBM_Case_Manager_5.3.3.0_2018.03_InstallLog.txt file.

What to do next

Configure your new installation of IBM Case Manager by using the configuration
tool.

186 Planning, Installation, and Upgrade Guide

|



Upgrading IBM Case Manager silently
When you upgrade IBM Case Manager silently, you run a command in the IBM
Case Manager software package that refers to parameters in an installation text file.

About this task

If you upgrade from an existing IBM Case Manager version on the same server,
the installation of V5.3.3 upgrades the installation of the existing version.

The installation program detects whether the prerequisite components are installed.

If you use IBM Forms and you are upgrading in a WebSphere Application Server
cluster, you must repeat this procedure on the deployment manager server and on
each node in the cluster.

Procedure

To upgrade IBM Case Manager silently:
1. Log on to the IBM Case Manager server as a user with write access to the

installation directory.
2. Locate the IBM Case Manager software package in the installation media.
3. Edit the cm_silent_install.txt file to reflect the installation choices for your

environment.

Important: Set the license type to the IBM Case Manager.
4. Run the installation program:

Operating system Command

AIX 5.3.3.0-ICM-AIX.BIN -i silent -f
cm_silent_install.txt

Linux 5.3.3.0-ICM-LINUX.BIN -i silent -f
cm_silent_install.txt

Linux for System z 5.3.3.0-ICM-ZLINUX.BIN -i silent -f
cm_silent_install.txt

Windows 5.3.3.0-ICM-WIN.EXE -i silent -f
cm_silent_install.txt

5. When the program completes, check for errors in the IBM Case Manager
installation log. The log file is created in the installation directory. For example,
review the /opt/IBM/CaseManagement/logs/
IBM_Case_Manager_5.3.3.0_2018.03_InstallLog.txt file.

What to do next

Configure your new installation of IBM Case Manager by using the configuration
tool.
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Configuring IBM Case Manager after you upgrade the software
You must configure IBM Case Manager before you can use the application in a
development, test, or production environment. Configuring your system prepares
the Case Manager Builder application and the Case Manager Client application for
deployment on the application server. After you deploy these applications, you can
create, test, manage, deploy, and work with your business solutions.

About this task

Your case management system consists of a development environment for creating
and initially testing solutions, a test environment for fully testing the solutions,
and a production environment for working with running case management
solutions. You must configure all environments.

Configuring the development environment includes configuring Case Manager
Builder and Case Manager Client. Configuring the test and production
environments includes configuring Case Manager Client.

You use the IBM Case Manager configuration tool to create an upgrade profile for
each development environment instance and a profile for each test or production
environment instance. You can create an upgrade profile in one of the following
ways:

Table 17. Ways to create a profile

Upgrade method Description

Copy properties from an existing profile The IBM Case Manager configuration tool
can convert existing profiles to upgrade
profiles. The conversion process retains
properties from the existing configuration
profile.

The configuration tool removes tasks that are
not needed for the upgrade. Check the
values to ensure that they still apply for your
environment. You must also provide values
for the new IBM Case Manager V5.3.3 tasks.

Create a new upgrade profile When you use the configuration tool to
create a new profile, you provide all the
values for your environment. You can
provide these values from your own checklist
or records. You can also import profile
properties from an existing configuration
profile.

The information for a profile is collected in XML files in the form of properties and
values that describe the associated configuration and deployment tasks. Three
XML files contain information about IBM Content Navigator, WebSphere
Application Server, Content Platform Engine. Each configuration task in a profile
has one configuration XML file. You must provide values for the profile properties
that are specific to each configuration at your site, such as the application server
name.

The XML files are stored in a directory that is unique to a profile. Because the
profile name is used for the directory name and for the configuration profile file
name, you must provide a profile name that is a valid directory name for your
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operating system. By default, the profiles are stored in the install_path/
configure/profiles directory where install_path is the location where IBM Case
Manager is installed. The following table shows the default path:

Table 18. Default profile directory location

Operating system Default file path

AIX
Linux
Linux for System z

/opt/IBM/CaseManagement/configure/profiles

Windows C:\Program Files\IBM\CaseManagement\configure\profiles

After you create the profile, you must specify values about your environment and
then apply the settings by running configuration tasks.

“Configuring the upgraded development environment”
“Configuring the upgraded test or production environment” on page 197

Configuring the upgraded development environment
You must configure the development environment before you use IBM Case
Manager to create and deploy solutions. You use the development environment to
create, modify, and test solutions before moving them into a production
environment.

Before you begin

Be sure to have your completed configuration checklist available.

Make sure that your profile files can be accessed from this server. If necessary, you
can copy the files to a directory on the server where you are running the
configuration tool.

About this task

Configuring the development environment prepares Case Manager Builder and
Case Manager Client for use. You use the IBM Case Manager configuration tool to
create a profile, which is a collection of configuration and deployment tasks. When
you provide the required values for the tasks and run the tasks, you configure all
the required settings and deployments for your development environment.

The first time that you configure the development environment after you upgrade
to IBM Case Manager V5.3.3, use the configuration tool to run the configuration
tasks. Later, you can rerun many of these tasks by using the administration client.
For example, you can use either the administration client or configuration tool to
define additional project areas or configure object stores as needed. Each object
store that is to be used with V5.3.3 must be configured with the V5.3.3
configuration tool or administration client to ensure that the object store is
upgraded.

The following configuration tasks are not available in the administration client:
v Configure IBM Content Manager Host Properties
v Configure IBM Business Process Manager
v Configure Business Rules
v Register the External Data Service
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Procedure

To configure the development environment after you install IBM Case Manager
V5.3.3:
1. Log in to the IBM Case Manager server. In a network deployment or cluster

environment, you can run the configuration tasks from one of the managed
nodes.

2. Start the configuration tool by running one of the following commands:

Operating system Command

AIX 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux for System z 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Windows Perform one of the following actions:

v Click Start > All Programs > IBM Case Manager > Case
Manager Configuration Tool.

v Run the following command:

_install_path\configure\configmgr.exe

_install_path is the location where IBM Case Manager is
installed, for example, one of the following directories:

– C:\Program Files\IBM\CaseManagement

– C:\Program Files (x86)\IBM\CaseManagement

Tip: The installation path in your environment might be different. If the
installation program detects that a previous version of IBM Case Manager is
installed, you must specify a different location.
3. Click Create Upgrade Profile.
4. Select the type of profile that you want to use for upgrading:

Option Description

Create a new upgrade profile When you create a profile, you specify all
values that are required for your
development environment.
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Option Description

Copy properties from an existing profile Browse to the existing IBM Case Manager
development profile that you want to
convert to an upgrade profile. The profile
contains the values that you specified
previously for your development
environment.

5. Complete the wizard steps:
a. Specify that the profile is a development environment profile and enter a

unique profile name. If your existing system integrates with IBM Content
Manager, select the check box to upgrade the integration information.

b. If your existing system integrates with IBM Business Process Manager and
you create new object stores for V5.3.3, select the check box to upgrade the
integration information.

c. Specify server and connection information for WebSphere Application
Server.

d. Specify server and connection information for IBM Content Navigator.
e. Specify or verify the Content Platform Engine connection information.

Select or review the design object store settings, depending on whether
you are creating or reusing object stores. Ensure that you are pointing to a
single Content Platform Engine node.

The profile files are created. The profile opens with a list of tasks that must be
run to complete the upgrade configuration.

6. Optional: If you created a new upgrade profile, you can import profile
properties from an existing profile:
a. Save any edits that you made to the profile properties.
b. In the configuration tool, click File > Import Profile Properties to run the

Import Profile Properties wizard. The properties in the target profile are
updated by the imported values.

7. Edit, save, and run the following required tasks. You must run the tasks in the
order listed.

Table 19. Task requirements for a development environment

Task Required

Update the Content Platform Engine Client
Connector Files

Required if you did not run the Content
Platform Engine installation program to
upgrade the client files.

If you run this task, you must restart the IBM
Case Manager configuration tool.

Configure the Case Management Object
Stores

Always

Define the Default Project Area Required if you create new object stores for
the development environment.

Configure the IBM Content Manager Host
Properties

Required if IBM Case Manager integrates
with IBM Content Manager.

This task is applicable only if you use
WebSphere Application Server.
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Table 19. Task requirements for a development environment (continued)

Task Required

Configure IBM Business Process Manager Required if IBM Case Manager integrates
with IBM Business Process Manager and you
create new object stores for the development
environment.

This task is applicable only if you use
WebSphere Application Server.

Deploy the IBM Business Process Manager
Integration Service

Required if IBM Case Manager integrates
with IBM Business Process Manager.

Register the IBM Business Automation
Workflow Plug-in

Required if you want to use the plug-in for
IBM Business Process Manager that provides
a access to your IBM Process Portal Work
dashboard from your IBM Case Manager
desktop. Save your changes and then run the
task to apply your settings.

This plug-in adds the Workflow > Launch
Process action to the Action menu and
pop-up menu in the Browse view of the IBM
Case Manager desktop. You can use this
action to launch an IBM BPM process from a
document. You can also add the Launch
Process action to the menu in the Documents
view for the Case Information widget.
Important: To use the IBM Business
Automation Workflow plug-in, you must use
the Hypertext Transfer Protocol Secure
(HTTPS) in your IBM Content Navigator
URL.

Create Case Manager Applications Always

Deploy the Case Manager API Always.

Register the IBM Case Manager Services
Plug-in

Always

Register the IBM Content Platform Engine
Applets Support Plug-in

Always

Deploy Case Manager Builder Always

Deploy and Register Widgets Package Always
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.

192 Planning, Installation, and Upgrade Guide

|
|
|
|
|
|
|
|

|
|
|
|
|
|
|
|
|
|
|
|
|



Table 19. Task requirements for a development environment (continued)

Task Required

Deploy the Forms Application Required if IBM Case Manager integrates
with IBM Forms or IBM FileNet P8 eForms.

If you configure IBM Forms or IBM FileNet
P8 eForms on a network deployment or
cluster environment, run this task in the
profile that contains the other tasks. Select
Network Deployment or Cluster for the
deployment type, eForms and IBM Forms
for the forms type, and Deployment
Manager Profile for the environment type.

If you integrate with IBM Forms 8.1 or
earlier on a network deployment or cluster
environment, the following additional steps
are required. These additional steps are not
required if you integrate with IBM Forms 8.2
or later or with only IBM FileNet P8 eForms.

1. For the managed nodes, create a profile
on each managed node that includes only
this task and run this task. Select
Network Deployment or Cluster for the
deployment type, eForms and IBM
Forms for the forms type, and Managed
Profile for the environment type.

2. After all nodes are configured, the
managed node or cluster must be
restarted to complete the forms
integration. You can restart the managed
node or cluster now, or after you run all
other configuration tasks.

Register the IBM Case Manager
Administration Client Plug-in

Always

Configure Box Collaboration Required if you want to enable case workers
to use Box to collaborate with external users.
This task configures the connection to the
Box server.

Register the IBM Case Manager Box Event
Listener Plug-in

Required if you want the IBM Case Manager
Box event listener to monitor activity in Box
collaboration folders. This task is required if
you want Box events to trigger the creation
of cases or work items.

Register Project Area Always
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Table 19. Task requirements for a development environment (continued)

Task Required

Configure Business Rules Required if you use business rules in your
solution.
Tips:

v You can select only one locale in which to
write the business rules for your solutions.
If you need to create solutions with
business rules in other locales, rerun this
task to change the rule persistence locale
before you create the solution. After the
first rule for a solution is saved, the rule
persistence locale cannot be changed.

v If you rerun this task to change the
location of the rules repository directory
after you deploy any solutions, complete
the following steps after you run the task:

1. Stop Content Platform Engine.

2. From the previous rules repository
directory, move the res_data directory
to the new location of the rules
repository directory. In a cluster
environment, the rules directory must
be a shared directory that can be
accessed by all Content Platform
Engine cluster servers.

3. Restart Content Platform Engine.

Register the Case Monitor Widgets Package Required if you want to use the IBM Case
Monitor Dashboard to view of business
activity data that is specific to case
management systems.

Register the External Data Service Required for solutions that use the external
data service. Rerun this task after you
upgrade the solution.

Deploy and Register Extensions Package Required only when you add an extensions
package for a custom property editor or
controller.
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.

8. On a stand-alone server, restart the application server.
9. Restart the deployment manager, node agents, and application server

instances. If you did not restart the application server as part of the previous
task, you must restart the agents and server instances.

10. After the deployment tasks complete successfully, use the WebSphere
Application Server console to bind the following deployed applications to the
web server:
v CaseClient
v CaseBuilder
v CaseForms, if used

194 Planning, Installation, and Upgrade Guide



v CaseManager
v ICMClient
v Any custom widgets packages and applications

“Importing profile properties”
“Verifying the IBM Case Manager applications in the development
environment” on page 196

Related reference:
“Configuration checklist” on page 31

Importing profile properties
You can import property values from an existing configuration profile into a profile
that is open in the IBM Case Manager configuration tool. Importing values saves
time when you are reusing information across profiles.

About this task

By importing property values, you can also reuse values from an existing IBM
Case Manager configuration profile. For example, you can import an existing
profile into a new development or production environment profile for V5.3.3.

As an alternative to importing profile properties through the configuration tool,
you can use the Create Upgrade Profile wizard to copy properties from an existing
profile into an upgrade profile that you create for V5.3.3. If you use this approach,
ensure that the target profile is an upgrade profile.

When you select a profile to import from, the values in the profile are compared
with the currently open profile. If the source profile contains all default values for
a specific task, then nothing is imported for that task. You can choose the
customized tasks and profile settings that you want to import.

If your configuration profile was created on another server, you must have access
to the directory on that server that contains the configuration profile files. If you
cannot access the server, copy the files over to your current IBM Case Manager
server before you import the properties.

After you import profile properties, always check the values to ensure that they are
still valid for your environment. For example, if your profile was created on
another server, you might need to change server and connection values after you
import the properties.

Procedure

To import profile properties:
1. Start the configuration tool by running one of the following commands:

Operating system Command

AIX 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Upgrading and configuring IBM Case Manager 195



Operating system Command

Linux 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux for System z 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Windows Perform one of the following actions:

v Click Start > All Programs > IBM Case Manager > Case
Manager Configuration Tool.

v Run the following command:

_install_path\configure\configmgr.exe

_install_path is the location where IBM Case Manager is
installed, for example, one of the following directories:

– C:\Program Files\IBM\CaseManagement

– C:\Program Files (x86)\IBM\CaseManagement

2. Create or open the profile that you want to import the values to. The currently
opened profile is the target profile.

3. If you edit the profile settings or any tasks in the open profile, save your
changes.

4. Click File > Import Profile Properties to import the properties by using the
wizard.
a. Select the existing source profile from which you want to import the profile

properties.
b. Select the source profile settings and tasks to import. The options include

settings for WebSphere Application Server, IBM Content Navigator, Content
Platform Engine server, and any tasks from the source profile.

c. Select the target profile settings and tasks that you want to map the source
profile settings and tasks to, including existing tasks or settings and new
tasks.

The properties in the target profile are updated.

Verifying the IBM Case Manager applications in the development
environment
After you install your IBM Case Manager software, configure your environment,
and deploy the applications, you can start and verify the IBM Case Manager
applications in the development environment.

Procedure

To verify the IBM Case Manager applications:
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1. Verify the IBM Case Manager API deployment by accessing the following link
from a browser:

Environment Application URL

High availability http://virtual_server_name/CaseManager/
CASEREST/v1/info

Stand-alone or network deployment http://server_name:port/CaseManager/
CASEREST/v1/info

2. Log in to the IBM Case Manager administration client by accessing the
following link from a browser:

Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icmadmin

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icmadmin

3. Log in to the Case Manager Client by accessing the default IBM Case Manager
desktop from a browser:

Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icm

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icm

Verify that your specified Lightweight Directory Access Protocol (LDAP) users
can log in to the Case Manager Client.

4. Click the help icon to test whether the Case Manager Client help system
displays content.

5. Log in to the Case Manager Builder by accessing the following link from a
browser:

Environment Application URL

High availability http://virtual_server_name/CaseBuilder

Stand-alone or network deployment http://server_name:port/CaseBuilder

Verify that your specified LDAP users can log in to the Case Manager Builder.
6. Click the help icon to test whether the Case Manager Builder help system

displays content.

Configuring the upgraded test or production environment
You must configure the production environment before you migrate upgraded
solutions and deploy them to production. You configure the test and production
environments after you configure the development environment.

Before you begin

Be sure to have your completed configuration checklist available.

If you want to import profile properties from an existing profile, make sure that
your profile files can be accessed from this server. If necessary, you can copy the
files to a directory on the server where you are running the configuration tool.
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About this task

Configuring the production environment prepares Case Manager Client and the
production object stores for use. You use the IBM Case Manager configuration tool
to create a profile, which is a collection of configuration and deployment tasks.
When you provide the required values for the tasks and run the tasks, you
configure all the required settings and deployments for your production
environment.

The first time that you configure the test or production environment after you
upgrade to IBM Case Manager V5.3.3, use the configuration tool to run the
configuration tasks. Later, you can rerun many these tasks by using the
administration client. For example, you can use either the administration client or
configuration tool to define additional target environments or configure object
stores as needed. Each object store that is to be used with V5.3.3 must be
configured with the V5.3.3 configuration tool or administration client to ensure that
the object store is upgraded. If you reuse object stores, you must configure the
target object stores and register the target environments before they can be used
with V5.3.3.

The following tasks are not available in the administration client:
v Configure IBM Content Manager Host Properties
v Configure IBM Business Process Manager
v Configure Business Rules
v Register the External Data Service

Procedure

To configure the test or production environment after you install IBM Case
Manager V5.3.3:
1. Log in to the IBM Case Manager server. In a network deployment or cluster

environment, you can run the configuration tasks from one of the managed
nodes.

2. Start the configuration tool by running one of the following commands:

Operating system Command

AIX 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr
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Operating system Command

Linux for System z 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Windows Perform one of the following actions:

v Click Start > All Programs > IBM Case Manager > Case
Manager Configuration Tool.

v Run the following command:

_install_path\configure\configmgr.exe

_install_path is the location where IBM Case Manager is
installed, for example, one of the following directories:

– C:\Program Files\IBM\CaseManagement

– C:\Program Files (x86)\IBM\CaseManagement

Tip: The installation path in your environment might be different. If the
installation program detects that a previous version of IBM Case Manager is
installed, you must specify a different location.
3. Click Create Upgrade Profile.
4. Select the type of profile that you want to use for upgrading:

Option Description

Create a new upgrade profile When you create a profile, you specify all
values that are required for your test or
production environment.

Copy properties from an existing profile Browse to the existing production profile
that you want to convert to an upgrade
profile. The profile contains the values that
you specified previously for your production
environment.

5. Complete the wizard steps:
a. Specify that the profile is a production environment profile and enter a

unique profile name. If your existing system integrates with IBM Content
Manager, select the check box to upgrade the integration information.

b. Specify server and connection information for WebSphere Application
Server.

c. Specify server and connection information for IBM Content Navigator.
d. Specify or verify the Content Platform Engine connection information.

Ensure that you are pointing to a single Content Platform Engine node.

The profile files are created. The profile opens with a list of tasks that must be
run to complete the upgrade configuration.

6. Optional: If you created a new upgrade profile, you can import profile
properties from an existing profile:
a. Save any edits that you made to the profile properties.
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b. In the configuration tool, click File > Import Profile Properties to run the
Import Profile Properties wizard. The properties in the target profile are
updated by the imported values.

7. Edit, save, and run the following required tasks. You must run the tasks in the
order listed.

Table 20. Task requirements for a production environment

Task Required

Update the Content Platform Engine Client
Connector Files

Required if you did not run the Content
Platform Engine installation program to
install the client files.

If you run this task, you must restart the IBM
Case Manager configuration tool.

Configure the Case Management Object
Stores

You must run the Deploy and Register
Widgets Package task and the Register the
IBM Case Manager Administration Client
Plug-in task before you run this task. This
task registers a target environment with an
IBM Content Navigator desktop, creates
default IBM Case Manager desktops,
configures repositories for the case
management design and target object stores,
and adds IBM Case Manager features to the
desktop. Also, this task configures the Case
Operations component queue and configures
the target environment's isolated region to
work with solution workflows. This task is
required and must be run for every target
environment. Save your changes and run the
task to apply your settings.

Configure the IBM Content Manager Host
Properties

Required if IBM Case Manager integrates
with IBM Content Manager.

Configure IBM Business Process Manager Required if IBM Case Manager integrates
with IBM Business Process Manager.

Deploy the IBM Business Process Manager
Integration Service

Required if IBM Case Manager integrates
with IBM Business Process Manager.

Register the IBM Business Automation
Workflow Plug-in

Required if you want to use the plug-in for
IBM Business Process Manager that provides
a access to your IBM Process Portal Work
dashboard from your IBM Case Manager
desktop. Save your changes and then run the
task to apply your settings.

This plug-in adds the Workflow > Launch
Process action to the Action menu and
pop-up menu in the Browse view of the IBM
Case Manager desktop. You can use this
action to launch an IBM BPM process from a
document. You can also add the Launch
Process action to the menu in the Documents
view for the Case Information widget.
Important: To use the IBM Business
Automation Workflow plug-in, you must use
the Hypertext Transfer Protocol Secure
(HTTPS) in your IBM Content Navigator
URL.
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Table 20. Task requirements for a production environment (continued)

Task Required

Create Case Manager Applications Always

Deploy the Case Manager API Always.

Register the IBM Case Manager Services
Plug-in

Always

Register the IBM Content Platform Engine
Applets Support Plug-in

Always

Deploy and Register Widgets Package Always
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.

Deploy the Forms Application Required if IBM Case Manager integrates
with IBM Forms or IBM FileNet P8 eForms.

If you configure IBM Forms or IBM FileNet
P8 eForms on a network deployment or
cluster environment, run this task in the
profile that contains the other tasks. Select
Network Deployment or Cluster for the
deployment type, eForms and IBM Forms
for the forms type, and Deployment
Manager Profile for the environment type.

If you integrate with IBM Forms 8.1 or
earlier on a network deployment or cluster
environment, the following additional steps
are required. These additional steps are not
required if you integrate with IBM Forms 8.2
or later or with only IBM FileNet P8 eForms.

1. For the managed nodes, create a profile
on each managed node that includes only
this task and run this task. Select
Network Deployment or Cluster for the
deployment type, eForms and IBM
Forms for the forms type, and Managed
Profile for the environment type.

2. After all nodes are configured, the
managed node or cluster must be
restarted to complete the forms
integration. You can restart the managed
node or cluster now, or after you run all
other configuration tasks.

Register the IBM Case Manager
Administration Client Plug-in

Always

Configure Box Collaboration Required if you want to enable case workers
to use Box to collaborate with external users.
This task configures the connection to the
Box server.
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Table 20. Task requirements for a production environment (continued)

Task Required

Register the IBM Case Manager Box Event
Listener Plug-in

Required if you want the IBM Case Manager
Box event listener to monitor activity in Box
collaboration folders. This task is required if
you want Box events to trigger the creation
of cases or work items.

Register Target Environment Required to configure each target
environment. After you run this task for the
initial configuration, you can defer running
the task again until you are ready to migrate
your upgraded solutions to the target
environment.

Configure Business Rules Required if you use business rules in your
solution.
Tips:

v You can select only one locale in which to
write the business rules for your solutions.
If you need to create solutions with
business rules in other locales, rerun this
task to change the rule persistence locale
before you create the solution. After the
first rule for a solution is saved, the rule
persistence locale cannot be changed.

v If you rerun this task to change the
location of the rules repository directory
after you deploy any solutions, complete
the following steps after you run the task:

1. Stop Content Platform Engine.

2. From the previous rules repository
directory, move the res_data directory
to the new location of the rules
repository directory. In a cluster
environment, the rules directory must
be a shared directory that can be
accessed by all Content Platform
Engine cluster servers.

3. Restart Content Platform Engine.

Register the Case Monitor Widgets Package Required if you want to use the IBM Case
Monitor Dashboard to view of business
activity data that is specific to case
management systems.

Register the External Data Service Required for solutions that use the external
data service. Rerun this task after you
upgrade the solution.

Deploy and Register Extensions Package Required only when you add an extensions
package for a custom property editor or
controller.
Important: If you run this task in a cluster
environment, you must ensure that the
plug-in is loaded on each node of the cluster.
Either restart the cluster to force the plug-in
to be loaded on all nodes or manually load
the plug-in on each node by using the IBM
Content Navigator administration client.
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8. On a stand-alone server, restart the application server.
9. Restart the deployment manager, node agents, and application server

instances. If you did not restart the application server as part of the previous
task, you must restart the agents and server instances.

10. After the deployment tasks complete successfully, use the WebSphere
Application Server console to bind the following deployed applications to the
web server:
v CaseClient
v CaseManager
v Any custom widgets packages and applications

“Importing profile properties”
“Configuring additional target environments in an upgraded production
environment” on page 205
“Verifying the IBM Case Manager applications in the production environment”
on page 205
“Configuring the LTPA timeout for Case Manager Builder” on page 206

Related reference:
“Configuration checklist” on page 31

Importing profile properties
You can import property values from an existing configuration profile into a profile
that is open in the IBM Case Manager configuration tool. Importing values saves
time when you are reusing information across profiles.

About this task

By importing property values, you can also reuse values from an existing IBM
Case Manager configuration profile. For example, you can import an existing
profile into a new development or production environment profile for V5.3.3.

As an alternative to importing profile properties through the configuration tool,
you can use the Create Upgrade Profile wizard to copy properties from an existing
profile into an upgrade profile that you create for V5.3.3. If you use this approach,
ensure that the target profile is an upgrade profile.

When you select a profile to import from, the values in the profile are compared
with the currently open profile. If the source profile contains all default values for
a specific task, then nothing is imported for that task. You can choose the
customized tasks and profile settings that you want to import.

If your configuration profile was created on another server, you must have access
to the directory on that server that contains the configuration profile files. If you
cannot access the server, copy the files over to your current IBM Case Manager
server before you import the properties.

After you import profile properties, always check the values to ensure that they are
still valid for your environment. For example, if your profile was created on
another server, you might need to change server and connection values after you
import the properties.
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Procedure

To import profile properties:
1. Start the configuration tool by running one of the following commands:

Operating system Command

AIX 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Linux for System z 1. Change to the _install_path/configure directory.
_install_path is the location where IBM Case Manager is
installed, for example, /opt/IBM/CaseManagement.

2. Run the following command:

./configmgr

Windows Perform one of the following actions:

v Click Start > All Programs > IBM Case Manager > Case
Manager Configuration Tool.

v Run the following command:

_install_path\configure\configmgr.exe

_install_path is the location where IBM Case Manager is
installed, for example, one of the following directories:

– C:\Program Files\IBM\CaseManagement

– C:\Program Files (x86)\IBM\CaseManagement

2. Create or open the profile that you want to import the values to. The currently
opened profile is the target profile.

3. If you edit the profile settings or any tasks in the open profile, save your
changes.

4. Click File > Import Profile Properties to import the properties by using the
wizard.
a. Select the existing source profile from which you want to import the profile

properties.
b. Select the source profile settings and tasks to import. The options include

settings for WebSphere Application Server, IBM Content Navigator, Content
Platform Engine server, and any tasks from the source profile.

c. Select the target profile settings and tasks that you want to map the source
profile settings and tasks to, including existing tasks or settings and new
tasks.
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The properties in the target profile are updated.

Configuring additional target environments in an upgraded
production environment
If you want to add object stores to your production environment, you must
configure the target environment.

About this task

Configuring the target environment includes creating the target object store,
creating a worfklow system, defining and registering the target environment, and
running additional configuration tasks. For each additional object store that your
environment requires, complete the procedures for configuring a target
environment.

Procedure

To configure additional target environments:
1. Review the guidelines in Setting up target environments.
2. Follow the instructions in Creating or upgrading a target object store for test or

production environments. After you create the target object store, you must
define and register the target environment and configure the production target
object store indexes.

Verifying the IBM Case Manager applications in the production
environment
After you configure your environment and deploy the applications, you can start
and verify the IBM Case Manager applications in the production environment.

Procedure

To verify the IBM Case Manager applications:
1. Verify the IBM Case Manager API deployment by accessing the following link

from a browser:

Environment Application URL

High availability http://virtual_server_name/CaseManager/
CASEREST/v1/info

Stand-alone or network deployment http://server_name:port/CaseManager/
CASEREST/v1/info

2. Log in to the IBM Case Manager administration client by accessing the
following link from a browser:

Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icmadmin

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icmadmin

3. Log in to the Case Manager Client by accessing the default IBM Case Manager
desktop from a browser:
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Environment Application URL

High availability http://virtual_server_name.domain.com/
navigator/?desktop=icm

Stand-alone or network deployment http://server_name:port/navigator/
?desktop=icm

Verify that your specified Lightweight Directory Access Protocol (LDAP) users
can log in to the Case Manager Client.

4. Click the help icon to test whether the Case Manager Client help system
displays content.

Configuring the LTPA timeout for Case Manager Builder
You can set the Lightweight Third Party Authentication (LTPA) timeout value to
prevent timeout issues with Case Manager Builder.

About this task

Although the configuration tools set the LTPA timeout in most cases, there might
be instances where you need to configure or change the timeout for your case
management environment.

Procedure

To set the LTPA timeout for Case Manager Builder:
1. Start the administrative console.
2. Click Servers > Server types > WebSphere Application Servers >

my_server_name > Java Virtual Machine > Configuration tab.
3. In the Server Infrastructure section, click Java & Process Management >

Process Definition > Java Virtual Machine > Custom Properties.
4. Create the property com.ibm.ws.security.cacheCushionMax and provide a value

for it. For example, specify 60.
5. Set the LTPA timeout to five times the value of the

com.ibm.ws.security.cacheCushionMax property. For example, if you specified
60 for the com.ibm.ws.security.cacheCushionMax property, specify 300 for the
LTPA timeout (60 x 5 = 300).
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Upgrading and converting case management solutions

After you upgrade and configure the IBM Case Manager software, you upgrade
your solutions.

Before you begin

After you install IBM Case Manager V5.3.3, be sure to create any new solutions in
the V5.3.3 environment.

When you design and create a solution, you must decide what the solution locale
is. The solution locale refers to the locale of display names for case properties, case
types, tasks, and other solution artifacts that you create with Case Manager
Builder. When you deploy an upgraded solution to a target environment for the
first time, you must deploy the solution under the same locale to ensure that the
display names are preserved.

About this task

To upgrade solutions, you must install the IBM Case Manager V5.3.3 software, run
the configuration tool to configure application settings and connections, and then
open each solution in Case Manager Builder. After you click the icon to upgrade
the solution, Case Manager Builder enables V5.3.3 features in the solution.

If you configure the V5.3.3 development environment to reuse object stores, the
existing solutions are replaced when you upgrade them to V5.3.3.

For each solution that you upgrade, you must also specify security settings for the
solution folder. Ensure that only users who have permission to view the solution
folder can work with the solution in Case Manager Client.

“Upgrading solutions in Case Manager Builder”
“Setting permissions for upgraded solution folders” on page 208

Upgrading solutions in Case Manager Builder
Upgrading a solution in Case Manager Builder automatically updates the solution
definition files, enables new features, and generates a web application for the
solution.

About this task

Restriction: Only one user can upgrade the solution at a time. If two users
attempt to upgrade the solution at the same time, or if the same user attempts to
upgrade the solution in a different session before the upgrade is complete, a
message states that the upgrade is in progress. A message is also displayed if any
user attempts to edit the solution before the upgrade is complete.

Procedure

To upgrade a solution:
1. Start Case Manager Builder V5.3.3.
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2. When you are prompted to confirm whether you want to upgrade a previously
imported solution to a newer level, click the Upgrade button. The solution is
upgraded in the background. After the upgrade process completes, a
completion message is displayed in the status bar and the solution is opened in
edit mode.

3. Close the upgraded solution or continue with customizing the solution. To
customize the solution, you can edit the solution now or click Edit at another
time to edit the solution later.

4. After you edit the solution, click Commit to commit all of your changes.
5. Test the solution in the default IBM Case Manager web application.

What to do next

In IBM Case Manager V5.3.3, changes that you make to case property values are
synchronized in the in-basket. You might experience performance issues if all
property updates are set to synchronize automatically. To improve performance,
you might want to disable automatic synchronization for properties that are not
frequently updated.

After you upgrade a solution, you can use Process Designer in Case Manager
Builder to disable synchronization of case properties that you do not want to
automatically synchronize. For details, see Configuring the in-basket property
synchronization settings.
Related tasks:
 

Enhancing solution designs by using Process Designer
 

Adding and reusing properties
 

Designing views
 

Creating and distributing IBM Case Manager solution templates
Related information:
Cannot access Process Designer from Case Manager Builder with Google Chrome

Setting permissions for upgraded solution folders
In the Security settings for the solution folder, you can specify which users have
rights to the solution folder. Only users who have permission to view the solution
folder can work with the solution in Case Manager Client.

About this task

After you upgrade a solution in IBM Case Manager, verify or set the appropriate
security permissions on the security folder by using the IBM Case Manager
administration client.
Related information:
 

Configuring security by using the IBM Case Manager administration client
wizard
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Removing IBM Case Manager

IBM Case Manager provides a program that can remove all files and directories
that were created when you installed the application. You can use the application
server administrative console to remove the applications from the application
server. You can also use IBM Content Navigator to remove IBM Case Manager
desktops and repositories.

“Removing the IBM Case Manager applications”
“Removing the IBM Case Manager files” on page 210

Removing the IBM Case Manager applications
Before you remove the IBM Case Manager software files, remove and uninstall the
application files and components from your application server and from IBM
Content Navigator.

About this task

If you do not plan to continue to use the current installation of IBM Content
Navigator, you can undeploy IBM Content Navigator in the application server
administrative console. If you remove IBM Content Navigator, you do not need to
remove the desktops and repositories for IBM Case Manager as described in the
procedure.

Procedure

To remove IBM Case Manager applications:
1. Log in to IBM Content Navigator as an administrator.
2. In the Desktops window, delete the following desktops:
v Case Manager
v Case Manager administration

3. In the Repositories window, remove any repositories that are associated with
IBM Case Manager. This step removes the association between IBM Content
Navigator and the Content Platform Engine repositories, but it does not remove
the repositories from Content Platform Engine.

4. In the Plug-ins window, remove the following plug-ins:
v IBM Case Manager API plug-in
v IBM Case Manager administration plug-in
v IBM Case Manager client plug-in

5. For a development environment, uninstall the Case Manager Builder
application from the application server:
a. Log in to the WebSphere Application Server administrative console.
b. Navigate to Applications > Enterprise Applications, and select the

following applications:
v CaseBuilder
v CaseForms
v CaseManager
v ICMClient
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c. Click Stop.
d. With the applications still selected, click Uninstall.

Removing the IBM Case Manager files
IBM Case Manager provides a program that can remove all files and directories
that were created when you installed the application. You can run the program
interactively or silently.

Procedure

To remove IBM Case Manager:
1. Navigate to installation_path/_uninstaller.
2. Run the uninstallation program, either interactively or silently from the

command line:

Option Description

Interactive cm_uninstaller

Silent cm_uninstaller -i silent

Results

The uninstallation program removes the files and directories that were installed,
but does not remove any of your configuration profiles. When the uninstallation is
completed, the program displays the directories and files that remain.
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Notices

This information was developed for products and services that are offered in the
USA.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
United States of America

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
IBM Director of Licensing
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
USA

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
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programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

Portions of this code are derived from IBM Corp. Sample Programs.

© Copyright IBM Corp. 2010, 2017. All rights reserved.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Other company, product, and service names may be trademarks or service marks
of others.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use

You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display
or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
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publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

IBM Online Privacy Statement
IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use
cookies that collect each user’s user name for purposes of session management,
authentication, and enhanced user usability. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for
these purposes, see IBM’s Privacy Policy at www.ibm.com/privacy and IBM’s
Online Privacy Statement at www.ibm.com/privacy/details the section entitled
“Cookies, Web Beacons and Other Technologies” and the “IBM Software Products
and Software-as-a-Service Privacy Statement” at www.ibm.com/software/info/
product-privacy.
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